How to Disable the AJP Protocol in Tomcat
NOVEMBER 8, 2021
|IN TOMCAT
|BY ABBY MORELAND
Applies to: All versions of Ephesoft Transact.
The following steps describe how to disable the AJP Protocol in Tomcat to further secure your Tomcat web server.
You may need to do this with Transact 2020.1.06 or above if you are receiving the error as noted in the Knowledge Base article AJP Protocol Error – “Invalid Message Received.”
Disable the AJP Protocol
To disable the protocol:
1. Navigate to [Ephesoft_Directory]\JavaAppServer\conf\server.xml.
2. Comment out the line referencing AJP/1.3. This will be similar to the following:
<Connector port="8009" maxPostSize="4194304" redirectPort="8443" protocol="AJP/1.3" address="0.0.0.0" secretRequired="false"/>
3. Save and restart the Transact service.

How to Install the RecoStar Design Studio CE 20.4 Standalone Application on a Windows Workstation
NOVEMBER 8, 2021
|IN RECOSTAR DESIGN STUDIO
|BY ABBY MORELAND
Applies to: Transact for Linux 2020.1.06 and above.
Introduction
Important: RSP files generated with this application should not be used with Transact for Windows. RecoStar 20.4 is not supported for Transact for Windows.
With the introduction of RecoStar for Transact for Linux, RecoStar Design Studio allows you to modify RSP files for further customization into your batch class design. Use the designer to further customize OCR languages, barcode extraction, image pre-processing, fixed form extraction options, and more.
The following steps describe how to deploy the RecoStar Design Studio CE 20.4 Standalone Application on a Windows workstation. This version of RecoStar Design Studio is compatible with 64-bit Windows machines.
Prerequisites
Microsoft .NET 4.8 and Visual Studio Redistributables are needed for RecoStar Design Studio. Follow the instructions to install the prerequisites before proceeding to Deploying the RecoStar Design Studio CE 20.4 Standalone Application.
For Windows with 64-bit OS, you will need to install the following from Microsoft if not already installed on your workstation:
1. Visual Studio 2015, 2017, 2019, and 2022 (X64)
2. Visual Studio 2013 (VC++ 12.0) (X64)
3. .NET Framework 4.8 (Runtime)
[bookmark: _Deploying_the_RecoStar]Deploying the RecoStar Design Studio CE 20.4 Standalone Application
1. Download the RecoStar Design Studio CE 20.4 Standalone application from the Customer Support portal.
2. Right-click the RecoStarDesignStudio_CE_20.4_x64.zip file and select Properties to open the dialog box.
[image: A screenshot of a computer

Description automatically generated]
3. Under the General tab in the Security section, check the Unblock option.
4. Click Apply > OK.
5. Extract the ZIP file to a folder destination of your choosing.
6. In the destination folder, open the RecoStarDesignStudio folder and launch the RecoStarDesignStudio.exe file.
Note: If the RecoStarDesignStudio.exe file fails to launch or an error message appears, ensure Microsoft VC Redistributables and .Net 4.8 are installed correctly.

Configuring Canadian Support for the Cloud HyperExtender Plugin
MARCH 2, 2021
|IN PLUGINS
|BY ABBY MORELAND
Applies to: Transact 2020.1.02, 2020.1.03
This document describes how to enable the Canada region in the Cloud HyperExtender plugin for Transact 2020.1.02 and 2020.1.03. Canada is available by default in 2020.1.04 and above and does not require additional configuration.
The below sections detail configurations in two different files. You will need to update entries in both the applications.properties and plugin.properties files. Refer to the steps below.
Configuring application.properties
1. Go to the Transact application.properties file, located here:
[Ephesoft_Directory]\JavaAppServer\webapps\ephesoft-cloud-client\WEB-INF\classes\
2. Once you’ve opened the file, scroll down to ## Country URL configurations.
[image: A black text with black lines

Description automatically generated]
Figure 1. Country URL configurations Section of the JSON
3. Copy the following file property:
cloud.country.url.country-url.CANADA=https://api.ca.ephesoftcloud.com
4. Paste the copied property on a new line within the ## Country URL configurations section.
This is an example of the added properties:
[image: A black text with black lines

Description automatically generated with medium confidence]
Figure 2. Paste the Canada Property beneath ## Country URL configurations
After updating the ## Country URL configurations section, the notification property also needs to be updated.
5. Scroll to ## Cloud Notification Properties.
[image: A close up of a computer screen
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Figure 3. Cloud Notification Properties
6. Copy the following property:
cloud.notification.country-region-map.CANADA=ca-central-1
7. Paste the property within the ## Cloud Notification Propertiessection, beneath cloud.notification.country-region-map.SINGAPORE=ap-central-1.
[image: A computer code with text
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Figure 4. Paste the Canada Property beneath ## Cloud Notification Properties
8. Save the file.
Configuring cloud-plugin.properties
1. Go to the cloud-plugin.properties file, located here:
[Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\cloud-plugin\
2. Replace the cloud.registration.url property, which is https://transact.us.ephesoftcloud.com/#/register?multiCountry=true, with the new URL: https://transact.ca.ephesoftcloud.com/#/register?multiCountry=true
[image: A screenshot of a computer
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Figure 5. The Updated Cloud-Plugin Properties File
3. Save the file.
To confirm that you have successfully enabled Canada as a region, restart the Transact instance. If you have multiple instances of Transact, all in the cluster will need to be restarted as well. After restarting the instance, go to the Cloud Connection Details page within Transact. Before you added Canada, the following screen would display:
[image: A long line of lines

Description automatically generated with medium confidence]
Figure 6. The Cloud Connection Details Region List Before Adding Canada
After adding Canada as a region, the following screen will display:
[image: ]
Figure 7. The Cloud Connection Details Region List After Adding Canada
You have successfully configured Canada as a region.

How to Enable a Proxy Server with Email Import
NOVEMBER 19, 2020
|IN EMAIL IMPORT
|BY BREANNA FITZGERALD
Applies to: Ephesoft Transact 2020.1.03 and above
This page describes how to configure exchange email proxy server integrations with Email Import. By default, proxy configurations are disabled for email import.
Edit Properties File
Email import properties are controlled in the mail-import.properties file, located at [Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\dcma-mail-import.
1. Stop Ephesoft Transact.
2. Open the mail-import.properties file.
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Figure 1. Open Properties File
3. Locate the following lines:
#Is proxy configuration required for exchange server?
#false: Mail should NOT use proxy for exchange server (Default)
#true: Mail should use proxy for exchange server
dcma.mail.import.is_proxy_required=false
#proxy server ip-address
dcma.mail.import.proxy_host=127.0.0.1
#proxy server port
dcma.mail.import.proxy_port=80
#Does proxy require authentication?
dcma.mail.import.proxy_credential_required=false
#Proxy server username
dcma.mail.import.proxy_server_username=ephesoft
#Proxy server password
dcma.mail.import.proxy_server_password=ephesoft
#Proxy server domain
dcma.mail.import.proxy_server_domain=ephesoft
4. Configure the above properties with your proxy server details.
Note: Ensure the dcma.mail.import.is_proxy_required property is set to true to enable proxy configurations.
5. Save and close the file.
6. Start Ephesoft Transact.

How to Disable the IPv6 Network Protocol
NOVEMBER 16, 2020
|IN SYSTEM
|BY BREANNA FITZGERALD
The following steps describe how to disable the IPv6 network protocol on Windows. Disabling IPv6 is only required for Ephesoft Transact versions prior to 2020.1.02.   
You may need to temporarily disable IPv6 in a multi-server environment of Ephesoft Transact if any of the following fails:
· Heartbeat monitoring
· Failover (nodes picking up batches)
· Licensing
Note: Transact versions that are 2020.1.03 and newer are not affected by these IPv6 issues.
Instructions
Perform the following steps to disable the IPv6 network protocol on this server. This control is available in the Windows network settings.
1. Go to Control Panel > Network and Internet > Ethernet.
2. From the Ethernet screen, click Change adapter options. A new screen displays one or more networks.
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Figure 1. Network Connections Example
3. Right-click the network on which to disable the IPv6 and click Properties from the pop-up menu.
[image: A computer screen shot of a computer
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Figure 2. Click Properties to Change IPv6 Settings
The Ethernet Properties screen displays.
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Figure 3. Ethernet Properties Settings
4. Clear the Internet Protocol Version 6 (TCP/IPv6) check box.
[image: ]
Figure 4. Disable the Internet Protocol Version 6 (TCP/IPv6) Setting
5. Click OK to save changes. The system returns you to the Ethernet page.
6. Close the Windows Control Panel.

Migrating the Ephesoft SharedFolders Location
OCTOBER 28, 2020
|IN CONFIGURATION, SYSTEM
|BY BREANNA FITZGERALD
Applies to: Ephesoft Transact 4.x and above
This page provides instructions on how to migrate your Ephesoft SharedFolders location to a different path, either Network or Local.

Update Property Files
1. application.properties, located at [Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\
 Line 28: plugin_upload_folder_path=\\\\NEW_UNC_PATH\\SharedFolders/plugin-upload-folder
2. dcma-batch.properties, located at [Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\dcma-batch\
 Line 1: batch.base_folder=\\\\NEW_UNC_PATH\\SharedFolders
 Line 2: batch.local_folder=\\\\NEW_UNC_PATH\\SharedFolders/ephesoft-system-folder
 Line 4: batch.export_folder=\\\\NEW_UNC_PATH\\SharedFolders/final-drop-folder
 Line 17: batch.export_import_folder=\\\\NEW_UNC_PATH\\SharedFolders/export-batch-folder
 Line 24: batch.test_folder=\\\\NEW_UNC_PATH\\SharedFolders/ephesoft-test-data
3. dcma-db.properties, located at [Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\dcma-data-access\
 Line 17: upgradePatch.folder=\\\\NEW_UNC_PATH\\SharedFolders/database-update
4. dcma-backup-service.properties, located at [Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\dcma-util\
 Line 1: backup.local_folder=\\\\NEW_UNC_PATH\\SharedFolders/ephesoft-system-folder
 Line 8: backup.report_folder=\\\\NEW_UNC_PATH\\SharedFolders/report-data
5. dcma-workflows.properties, located at [Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\dcma-workflows\
 Line 15: newWorkflows.basePath=\\\\NEW_UNC_PATH\\SharedFolders/workflows
6. etl-variables.properties, located at [Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\dcma-reporting\
 Line 1: reportdata.path=\\\\NEW_UNC_PATH\\SharedFolders/report-data
7. server.xml, located at [Ephesoft_Directory]\JavaAppServer\conf\
 Line 156: <Context path="/dcma-batches" docBase="\\\\NEW_UNC_PATH\\SharedFolders" debug="10" privileged="false"/>
8. Analysis_Grid.Document_Correction_Analysis_Grid.lgx, located at [Ephesoft_Directory]\EphesoftReports\_Definitions\_Reports\
 Line 23: SavedAnalysisGridFolder="\\\\NEW_UNC_PATH\\SharedFolders\SavedAnalysisGrid"
 Line 65: DashboardSaveFile="\\\\NEW_UNC_PATH\\SharedFolders\SavedDashboards\Dashboard_User_@Session.userName~.xml"
9. Analysis_Grid.Field_Correction_Analysis_Grid.lgx, located at [Ephesoft_Directory]\EphesoftReports\_Definitions\_Reports\
 Line 23: SavedAnalysisGridFolder="\\\\NEW_UNC_PATH\\SharedFolders\SavedAnalysisGrid"
 Line 62: DashboardSaveFile="\\\\NEW_UNC_PATH\\SharedFolders\SavedDashboards\Dashboard_User_@Session.userName~.xml"
10. Dashboard.Dashboard.lgx, located at [Ephesoft_Directory]\EphesoftReports\_Definitions\_Reports\
 Line 19: SaveFile="\\\\NEW_UNC_PATH\\SharedFolders\SavedDashboards\Dashboard_User_@Session.userName~.xml"
11. Dashboard.serverStatus.lgx, located at [Ephesoft_Directory]\EphesoftReports\_Definitions\_Reports\
 Line 140: XMLFile="\\\\NEW_UNC_PATH\\SharedFolders\SavedDashboards\Dashboard_User_@Session.userName~.xml" />

Update the Ephesoft Application Database
Update all batch classes listed in the “batch_class” Table. Use a similar SQL Statement as the one below to update each batch class record:
 UPDATE batch_class SET unc_folder = Replace(unc_folder, '\\\\OLD_UNC_PATH\\SharedFolders', '\\\\NEW_UNC_PATH\\SharedFolders')WHERE  local_folder LIKE '%SharedFolders%';
Note: You will need to update each record.

Update the batch_instance table with the New SharedFolders Location.
Use similar SQL Statements to the ones below to update each Batch Instance record:
 UPDATE batch_instance SET local_folder='\\\\NEW_UNC_PATH\\SharedFolders\\ephesoft-system-folder';
 UPDATE batch_instance SET unc_subfolder = Replace(unc_subfolder, '\\\\OLD_UNC_PATH\\SharedFolders', '\\\\NEW_UNC_PATH\\SharedFolders' WHERE  local_folder LIKE '%SharedFolders%');
Note: We have to run this query for all the UNC subfolders present inside the UNC folder. If you do not update this table, you must make sure that all batch instances are in the FINISHED or DELETED State.

Update Windows Registry Information
Update HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Temp\Ephesoft Windows registry information with the new SharedFolders location. This will ensure future upgrades will be performed correctly.

Additional Configurations
Depending on your database application, you may also need to update the default DB property files, located at [Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\dcma-data-access. This includes either the MSSQL or MYSQL folder.
1. MSSQL: dcma-db.properties, located at [Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\dcma-data-access\MSSQL\
 Line 16: upgradePatch.folder=\\\\NEW_UNC_PATH\\SharedFolders/database-update
2. MYSQL: dcma-db.properties, located at [Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\dcma-data-access\MYSQL\
 Line 26: upgradePatch.folder=\\\\NEW_UNC_PATH\\SharedFolders/database-update
3. MYSQL: post-schema.sql, located at [Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\dcma-data-access\MYSQL\
 Line 150: update batch_class set unc_folder='\\\\NEW_UNC_PATH\\SharedFolders\\mailroom-import' where batch_class_name='MailroomAutomationTemplate';
 Line 151: update batch_class set unc_folder='\\\\NEW_UNC_PATH\\SharedFolders\\searchablepdf-import' where batch_class_name='SearchablePDFTemplate';
 Line 152: update batch_class set unc_folder='\\\\NEW_UNC_PATH\\SharedFolders\\grid-computing-import' where batch_class_name='GridComputingTemplate';
 Line 156: update batch_class_plugin_config set batch_class_plugin_config.plugin_config_value='\\\\NEW_UNC_PATH\\SharedFolders\\final-drop-folder' 
 Line 164: update batch_class_plugin_config set batch_class_plugin_config.plugin_config_value='\\\\NEW_UNC_PATH\\SharedFolders\\csv-export-folder' 
 Line 172: update batch_class_plugin_config set batch_class_plugin_config.plugin_config_value='\\\\NEW_UNC_PATH\\SharedFolders\\ibm-cm-export-folder' 
 Line 180: update batch_class_plugin_config set batch_class_plugin_config.plugin_config_value='\\\\NEW_UNC_PATH\\SharedFolders\\export-script.properties' 
 Line 188: update batch_class_plugin_config set batch_class_plugin_config.plugin_config_value='\\\\NEW_UNC_PATH\\SharedFolders\\tabbed-pdf-export-folder' 
 Line 196: update batch_class_plugin_config set batch_class_plugin_config.plugin_config_value='\\\\NEW_UNC_PATH\\SharedFolders\\NSI-export-folder' 
For a local disk, you can use something like “C:\\Folder\\Path”
Note: Mapped network drives will not work with Ephesoft. For drive letter format, only local disks are supported.
You may also need to update the following settings and files:
4. EphesoftTransact.exe, located at [Ephesoft_Directory]\JavaAppServer\bin
a. Right-click EphesoftTransact.exe and select Run as administrator.
b. Select the Java tab
c. In the Java Options field, update the “-Dshared.folders” parameter.
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Figure 1. Ephesoft Transact Properties
5. startup.bat, located at [Ephesoft_Directory]\JavaAppServer\bin.
a. Open startup.bat using an editor.
b. Locate and update the SHARED_FOLDERS entry to point to the new SharedFolders path.
[image: A close up of a text
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Figure 2. startup.bat 
6. applicationContext.xml, located at [Ephesoft_Directory]\Application.
a. Open applicationContext.xml using an editor.
b. Locate and update the import resource parameter.
[image: ]
Figure 3. applicationContext.xml

Restart Batches
After you’ve completed the above updates, restart your batch instances from the first module.

How to Install Checkinstall on RHEL
AUGUST 28, 2020
|IN INSTALL AND UPGRADE, LINUX
|BY BREANNA FITZGERALD
Applies to: All Linux versions of Ephesoft Transact
This page provides instructions for how to install checkinstall on RedHat Enterprise Linux (RHEL). Checkinstall files are included in the installation zip file from Ephesoft, however Transact does not install checkinstall by default.
If you find an error while installing Ephesoft where it was unable to install ImageMagick or Ghostscript. Check the /var/log/install-ephesoft.log. Scroll up above the Ephesoft ASCII graphics and if you see a mention of the install unable to find checkinstall, you will need to follow the instructions below in order to install checkinstall.
Prerequisites
· You must be the root user.
· All required packages must be installed prior to following the instructions listed here. If you need to install the required packages, enter the following command:
sudo yum install unzip rpmdevtools gcc*
Instructions
1. Download the Ephesoft installer zip file.
2. Unzip the Ephesoft installer to its own directory.
unzip <zip file name>.zip -d Ephesoft
3. Change directory to the Ephesoft install directory.
cd Ephesoft
4. In that directory, you will see a tar.gz file which contains all of the files that will be installed. Extract the checkinstall files from that tar.gz.
tar -xvf ./<tar file name>.tar.gz Ephesoft/Dependencies/checkinstall.tar.gz
5. Change directory to the newly created Dependencies directory.
cd ./Ephesoft/Dependencies
6. Decompress the checkinstall.tar.gz file.
tar xzvf ./checkinstall.tar.gz
7. Change the directory to the newly installed checkinstall directory.
cd checkinstall
8. Prepare the source code for installation.
make
9. Compile and install checkinstall.
make install
10. Verify the installation path of checkinstall is at /usr/local/sbin.
which checkinstall
11. Verify that /usr/local/sbin is in the path for the root user.
echo $PATH
12. If the $PATH return does not include /usr/local/sbin, you will need to add it to the path temporarily.
export PATH=$PATH:/usr/local/sbin
13. Now that you have installed checkinstall, you will have to tell Ephesoft that it is already installed. Start the installation, you may receive an error and close the application.
14. Once that happens, open the file /etc/Ephesoft/ephesoft.conf and change the value in it for checkinstall from 0 to 1.
15. Save the file and start the installation over.
Troubleshooting
1. If you receive the following error when running the “make” command in step 8, then you have not installed gcc first:
[root@localhost checkinstall]# make
for file in locale/checkinstall-*.po ; do \
case ${file} in \
locale/checkinstall-template.po) ;; \
*) \
out='echo $file | sed -s 's/po/mo/'' ; \
msgfmt -o ${out} ${file} ; \
if [ $? != 0 ] ; then \
exit 1 ; \
fi ; \
;; \
esac ; \
done
make -C installwatch
make[1]: Entering directory /path/to/folder/checkinstall/installwatch'
./create-localdecls
Checking truncate argument type... off_t
Checking readlinkat result type... ssize_t
Checking libc version... ./create-localdecls: line 47: gcc: command not found
ldd: ./libctest: No such file or directory
rm: cannot remove 'libctest': No such file or directory
gcc -Wall -c -D_GNU_SOURCE -DPIC -fPIC -D_REENTRANT -DVERSION=\"0.7.0beta7\" installwatch.c
make[1]: gcc: Command not found
make[1]: *** [installwatch.0] Error 127
make[1]: Leaving directory '/path/to/folder/checkinstall/installwatch'
make: *** [1ll] Error 2
2. If you receive the following error when running the “make” command, you will have to modify the /checkinstall/installwatch/installwatch.c file at the lines mentioned in the fix below and then start at step 8 again.
installwatch.c:2942: error: conflicting types for 'readlink'
/usr/include/unistd.h:828: note: previous declaration of 'readlink' was here
installwatch.c:3080: error: conflicting types for 'scandir'
/usr/include/dirent.h:252: note: previous declaration of 'scandir' was here
installwatch.c:3692: error: conflicting types for 'scandir64'
/usr/include/dirent.h:275: note: previous declaration of 'scandir64' was here
Note: When you edit the installwatch.c file, there will be an “if-then” statement for a static int on each item listed. You want them to match, which is what we are doing here.
Make the following changes to the ./checkinstall/installwatch/installwatch.c file:
1. 
a. At line 110, change the “static int” to match the previous “static int”:
Original:
static int (*true_scandir)( const char *,struct dirent ***,
int (*)(const struct dirent *),
int (*)(const void *,const void *));
Edited:
static int (*true_scandir)( const char *,struct dirent ***,
int (*)(const struct dirent *),
int (*)(const struct dirent **,const struct dirent **));
1. 
b. At line 138, change the “static int” to match the previous “static int”:
Original:
static int (*true_scandir64)( const char *,struct dirent64 ***,
int (*)(const struct dirent64 *),
int (*)(const void *,const void *));
Edited:
static int (*true_scandir64)( const char *,struct dirent64 ***,
int (*)(const struct dirent64 *),
int (*)(const struct dirent64 **,const struct dirent64 **));
1. 
c. At line 2959, change:
Original:
#if (GLIBC_MINOR <= 4)
Edited:
#if (0)
1. 
d. At line 3103, change the “static int” to match the previous “static int”:
Original:
int scandir( const char *dir,struct dirent ***namelist,
int (*select)(const struct dirent *),
int (*compar)(const void *,const void *) ) {
Edited:
int scandir( const char *dir,struct dirent ***namelist,
int (*select)(const struct dirent *),
int (*compar)(const struct dirent **,const struct dirent **) ) {[/code]
at line 3719, change the static int to match the previous static int:
Original:
int scandir64( const char *dir,struct dirent64 ***namelist,
int (*select)(const struct dirent64 *),
int (*compar)(const void *,const void *) ) {
Edited:
int scandir64( const char *dir,struct dirent64 ***namelist,
int (*select)(const struct dirent64 *),
int (*compar)(const struct dirent64 **,const struct dirent64 **) ) {
How to Modify the Custom Column Names
AUGUST 27, 2020
|IN UI CUSTOMIZATION
|BY BREANNA FITZGERALD
Applies to: Ephesoft Transact 4.0.4.0 and above
This article describes how to modify the Custom1, Custom2, Custom3, & Custom4 names.
Modifying Column Names
You can rename the custom column names by editing the custom column key in the locale.js file.
1. Open the locale.js file, located at [Ephesoft_Directory]\Application\i18n\common\locale.js.
2. Search for “Custom1”.
[image: screenshot1]Figure 1. locale.js File
3. Update the custom column names as desired.
Note: The custom column names appear in this locale.js file for each UI language. Depending on your UI language configurations, you may need to make this change for multiple languages.
4. Clear the browser cache and verify the column names in Transact. The new names should be visible now.
[image: screenshot2]Figure 2. New Column Names

How to Change the Ephesoft Logo
AUGUST 26, 2020
|IN UI CUSTOMIZATION
|BY BREANNA FITZGERALD
This page contains steps for how to replace the Ephesoft logo within Ephesoft Transact with your own company logo. These instructions are intended for partners and customers who are looking to white-label Transact.
Prerequisites
· You will need administrator permissions.
· You will need a basic understanding of HTML and CSS.
The instructions for this procedure vary by version:
· Ephesoft Transact 2019.1 and above
· Ephesoft Transact 4.0.0.0 to 4.5.0.0
[bookmark: _Ephesoft_Transact_2019.1]Ephesoft Transact 2019.1 and Above
To upload your customized logo, perform the following steps:
1. Navigate to the images folder at [Ephesoft_Directory]\Application\custom\images.
[image: A screenshot of a computer

Description automatically generated]Figure 1. Images Folder
2. Add or copy your image file to the images folder. The filename should be unique. Supported file types are:
· SVG
· PNG
Edit the Logo File Paths
After you have uploaded the new logo image, you will need to change the file path in the affected files to direct to the new image.
The following files are affected, which are located in [Ephesoft_Directory]\Application:
· Login.html
· home.html
· common.css
Note: You do not need to restart Transact after making changes to the above files. To view your changes, refresh your browser.
[bookmark: _Edit_the_Login.html]Edit the Login.html File
The Login.html changes the logo on the Login screen.
[image: A screenshot of a login box

Description automatically generated]Figure 2. Login Screen
By default, the file will point to the Ephesoft logo. To point to the new file, edit the img src attribute.
1. Open the Login.html file, at [Ephesoft_Directory]\Application.
[image: A screenshot of a computer

Description automatically generated]Figure 3. Application Folder
2. Search for “company_login_logo.svg”.
[image: ]Figure 4. Login.html File
3. Duplicate the “img src” line.
[image: ]Figure 5. Duplicate img src
4. Comment out the original line.
[image: ]Figure 6. Comment Out Original
5. Edit the new line to point to the new image file by replacing the “company_login_logo.svg” with the name of the new image file.
[image: ]Figure 7. Update Filename
6. Adjust the height and width of the img src attribute as needed.
7. Save and close the file.
[bookmark: _Edit_the_home.html]Edit the home.html File
The home.html changes the logo on the Home screen.
[image: A screenshot of a computer

Description automatically generated]Figure 8. Home Screen
1. Open the home.html file, at [Ephesoft_Directory]\Application.
[image: A screenshot of a computer

Description automatically generated]Figure 9. home.html File
2. Repeat steps 2-7 from the Login.html section above.
Note: The img src attribute in the home.html file does not contain default height or width tags. Depending on the size and dimensions of your new file, you may need to add and customize these tags.
[image: ]Figure 10. Edit Height and Width
[bookmark: _Edit_the_common.css]Edit the common.css File
The common.css changes the logo on each Administrator and Operator page within Transact.
[image: A screenshot of a computer

Description automatically generated]Figure 11. Batch Class Management Screen
1. Open the common.css file, located at [Ephesoft_Directory]\Application.
[image: A screenshot of a computer

Description automatically generated]Figure 12. common.css File
2. Search for “company_login_logo”.
[image: A screen shot of a computer

Description automatically generated]Figure 13. Locate “company_login_logo.svg”
3. Duplicate the .logoPanel .iconImage element and its properties.
[image: A screenshot of a computer code

Description automatically generated]Figure 14. Duplicate the Element
4. Comment out the original element.
[image: A screenshot of a computer code

Description automatically generated]Figure 15. Comment Out Original
5. Edit the new element to point to the new image file by replacing the “company_login_logo.svg” with the name of the new image file.
[image: A screenshot of a computer code

Description automatically generated]Figure 16. Update Filename
6. Adjust the width and height properties as needed.
7. Save and close the file.
[bookmark: _Ephesoft_Transact_4.0.0.0]Ephesoft Transact 4.0.0.0 to 4.5.0.0
To upload your customized logo, add or copy your image file to the following folders.
· [Ephesoft_Directory]\Application\images
· [Ephesoft_Directory]\Application\themes\default_theme\images
Note: The filename should be unique. Supported file types are:
· SVG
· PNG
Edit the Logo File Paths
After you have uploaded the new logo image, you will need to change the file path in the affected files to direct to the new image.
The following files are affected, which are located in [Ephesoft_Directory]\Application:
· home.html
· Login.html
· common.css
Note: You do not need to restart Transact after making changes to the above files. To view your changes, refresh your browser.
[bookmark: _Edit_the_home.html_1]Edit the home.html
1. Open the home.html file, at [Ephesoft_Directory]\Application.
[image: A screenshot of a computer

Description automatically generated]Figure 17. home.html File
2. Search for “logo_login.svg”.
[image: A screenshot of a computer

Description automatically generated]Figure 18. Edit home.html File
3. Replace “logo_login.svg” with the new file name.
4. Adjust the width and height properties as needed.
5. Save and close the file.
[bookmark: _Edit_the_Login.html_1]Edit the Login.html File
1. Open the home.html file, at [Ephesoft_Directory]\Application.
2. Repeat steps 2-5 from home.html above.
[bookmark: _Edit_the_common.css_1]Edit the common.css File
1. Open the common.css file, at [Ephesoft_Directory]\Application.
2. Repeat steps 2-5 from home.html above.

How to Add a New Translation to Transact
AUGUST 19, 2020
|IN UI CUSTOMIZATION
|BY BREANNA FITZGERALD
Applies to: All versions of Ephesoft Transact
If a language you’re looking for is not supported by Ephesoft, you can add your own translations to the Transact UI by editing the locale files.
· What are locale files?
· Where are the locale files?
· How do I add a new translation?
[bookmark: _What_are_locale]What are locale files?
A locale file is a JavaScript (.js) file that contains a set of translations for the text strings used in Transact. In the Ephesoft file structure, there are separate locale files for each UI screen. The locale files contain an entry for each language.
[bookmark: _Where_are_the]Where are the locale files?
The locale files are located at [Ephesoft_Directory]\Application\i18n and [Ephesoft_Directory]\Application\custom\i18n. The i18n folder contains the following folders, each of which contains their respective locale.js file:
· batchClassManagement
· batchInstance
· batchlist
· common
· customWorkflow
· folderManager
· licenseGenerator
· login
· report
· rv
· systemConfig
· theme
· uploadbatch
· webscanner
[bookmark: _How_do_I]How do I add a new translation?
To add a new translation, perform the following steps for each respective locale.js file:
1. Before making any changes, make a copy of the locale.js file as a backup.
2. Copy the var statement from the English (default) messages.
Note: English var statements don’t have any language suffixes. For example, in the screenshots below, figure 1 shows the English variable with no language suffix while figure 2 shows the French translation variable in the same file with the _fr suffix:
[image: A screen shot of a computer program

Description automatically generated]
Figure 1. English Variable (default)
[image: A screenshot of a computer code

Description automatically generated]
Figure 2. French Variable
3. Paste the copied variable at the end of the locale.js file.
4. Add a suffix for the language you’re adding a translation for. We recommend using ISO language codes for consistency.
5. Replace each message in the variable with their respective translations.
6. Repeat steps 1–5 for all *.js files in the [Ephesoft_Directory]\Application\i18n and [Ephesoft_Directory]\Application\custom\i18n folders.
7. Modify [Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\application.properties. Modify the locale_language entry and add additional language codes separated by a semicolon.
8. Restart the Transact service.
9. Change the default language setting on your browser to test the language codes you added.
Note: As this is a JavaScript file, do not make any changes to the formatting or alignment of the script. Any syntax errors will prevent Transact from accessing the translations.

Importing Windows Batch Class to Linux Environment
AUGUST 18, 2020
|IN BATCH CLASS
|BY BREANNA FITZGERALD
The following instructions describe how to migrate batch classes from Windows to Linux. Before proceeding, export your batches from the Windows environment and import them into the Linux one. The following changes should be made after importing the batch class to Linux.
After Importing the Batch Class to Linux
Follow the instructions below for each imported batch class.
Page Process Module
1. Remove the RECOSTAR_HOCR plugin from the module.
2. Add either the NUANCE_HOCR or TESSERACT_HOCR plugin to the Page Process module, along with any dependencies.
3. Click Apply.
[image: A screenshot of a computer program
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Extraction Module
3. Remove the RECOSTAR_EXTRACTION plugin.
4. Add the NUANCE_EXTRACTION_PLUGIN in the Extraction module, along with any dependencies.
5. Click Apply.
[image: A screenshot of a computer program
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5. Edit the batch class to use Nuance ZON files in place of corresponding RSP files. This is configured on the Document Types page for each document type in the batch class. Nuance uses the configured ZON files for extraction.
6. Click Apply.
[image: ]
Folder Import Module
6. In the IMPORT_MULTIPAGE_FILES plugin, edit the GhostScript Image Parameters:
· Remove “-sDEVICE=tiffscaled24”
· Replace it with “-sDEVICE=tiff24nc”
7. Click Apply. 
[image: A screenshot of a computer program
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Export Module
8. In the CREATEMULTIPAGE_FILES plugin, set the PDF Optimization switch to OFF.
9. Change the Multipage File Export Process to use any of the following options (Do not select RECOSTAR):
· 
· IMAGE_MAGICK
· HOCRtoPDF
· GHOSTSCRIPT
· ITEXT
· ITEXT-SEARCHABLE
Note: The default option is IMAGE_MAGICK. 
[image: A screenshot of a computer
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10. In the COPY_BATCH_XML plugin, edit the Final Export Folder with the desired path.
11. In the same file, update the Multipage File Name.
12. Click Apply.
[image: A screenshot of a computer program
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13. Click Deploy to deploy the changes to the workflow.

How to Enable CORS in Ephesoft Transact
AUGUST 8, 2020
|IN OTHER
|BY
In this article, you will learn how to enable Cross-origin Resource Sharing (CORS) in Ephesoft Transact. Enabling CORS will resolve Access Control Allow Origin Exception with your web application.
What is CORS?
CORS is a security feature that uses HTTP Headers that can be sent from the web server and interpreted by the browser to allow the browser to decide if it should proceed with a request or not. Part of the CORS mechanism involves the browser making a ‘preflight’ OPTIONS request to the web server so it can decide if it should send the actual request or not.
Note: CORS checks are only made for requests that are not categorized as “simple requests” and one of the triggers for requests to our APIs is the inclusion of an “Authorization” header.
CORS is controlled by the client so any custom code is written in Java for example or any custom requests made in PostMan will not be affected by CORS, however, any custom code that is executed by a modern web browser such as JavaScript will be affected by CORS.
So in the current Ephesoft Transact configuration, we have two issues:
1. OPTIONS requests are not supported by the current web.xml configuration: OPTIONS requests need to be supported WITHOUT the requirement for the request to be sent with authentication (since CORS preflight requests do not include authentication). Configuration needs to be added to Ephesoft\Application\WEB-INF\web.xml enables this support
2. CORS response headers are not configured to be returned to a client that requests them. We need to add an additional filter configuration which needs to be added to Ephesoft\JavaAppServer\conf\web.xml
Steps to Enable CORS
Add the following lines to web.xml file, located at [Ephesoft_Directory]\JavaAppServer\conf\.
Enter the originating server URL in the field <server URL>. For enabling CORS requests from multiple origins, separate each URL with a comma.
<filter>
	<filter-name>CorsFilter</filter-name>
	<filter-class>org.apache.catalina.filters.CorsFilter</filter-class>
	<init-param>
		<param-name>cors.allowed.origins</param-name>
		<param-value><serverURL></param-value>
	</init-param>
	<init-param>
		<param-name>cors.allowed.methods</param-name>
		<param-value>GET,POST,HEAD,OPTIONS,PUT</param-value>
	</init-param>
	<init-param>
		<param-name>cors.allowed.headers</param-name>
		<param-value>Content-Type,X-Requested-With,accept,Origin,Access-Control-Request-Method,Access-Control-Request-Headers,Content-Disposition, Authorization</param-value>
	</init-param>
	<init-param>
		<param-name>cors.exposed.headers</param-name>
		<param-value>Access-Control-Allow-Origin,Access-Control-Allow-Credentials</param-value>
	</init-param>
	<init-param>
		<param-name>cors.support.credentials</param-name>
		<param-value>true</param-value>
	</init-param>
	<init-param>
		<param-name>cors.preflight.maxage</param-name>
		<param-value>10</param-value>
	</init-param>
</filter>

<filter-mapping>
	<filter-name>CorsFilter</filter-name>
	<url-pattern>/*</url-pattern>
</filter-mapping>
Add the following lines to web.xml file. Do not merge this security restraint with an existing /rest/* security restraint in the web.xml.
<security-constraint>
	<web-resource-collection>
		<web-resource-name>web service</web-resource-name>
		<url-pattern>/rest/*</url-pattern>
		<http-method>OPTIONS</http-method>
	</web-resource-collection>
</security-constraint>

How to Resolve Processing Delays Due to Large Image Sizes
JULY 13, 2020
|IN PERFORMANCE
|BY BREANNA FITZGERALD
Applies to: All versions of Ephesoft Transact on Windows
Issue
You may experience the following issues when processing large JPG, TIF, or PDF files:
· Prolonged processing times
· Backed up batch instances
· Time out errors
Root Cause
Images may have increased in size during conversion because of the difference between the parameters of a vector-based file and those of a high megapixel image-based one.
Solution
If you are using larger files it may be necessary to adjust your imported TIFF files so it will automatically adjust the images you need to process in Ephesoft.
You can do so by changing the resample and/or resize values of your ImageMagick or GraphicsMagick Convert Output Image Parameter in IMPORT_MULTIPAGE_FILES. For example,
-resample 300×300 -resize 4000×4000> -compress LZW
In this example, the specified parameter will only resize the image which has dimensions greater than 4000×4000 pixels, while maintaining the aspect ratio. By doing this, RecoStar should now OCR images successfully.

Changing the DPI of an Output PDF File
JULY 6, 2020
|IN FILE EXPORT
|BY BREANNA FITZGERALD
Applies to: All versions of Ephesoft Transact
This page includes instructions on how to change the dots per image (DPI) of an output PDF file. The instructions here are specific to the CREATEMULTIPAGE_FILES plugin of the Export module.
The DPI of a PDF file can be read by either:
· Saving the PDF as a TIF and inspecting the properties.
· Using FineReader software.
Changing the DPI
There are two methods by which you can change the DPI of your output PDF:
· At the application level
· At the batch class level
[bookmark: _At_the_application]At the application level
To change the DPI at the application level, you can modify the dcma-imagemagick.properties file. This is located at [Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\dcma-imagemagick.
1. In the dcma-imagemagick.properties file, locate the following parameter:
imagemagick.itext_image_convert_parameters
[image: A close-up of a computer code
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2. Set the above parameter to “density 72 -compress LZW”.
imagemagick.itext_image_convert_parameters=-density 72 -compress LZW
[image: A close-up of a computer code

Description automatically generated]
3. Save and close the file.
Note: These changes will be applied to all batch classes.
[bookmark: _At_the_batch]At the batch class level
If you’re unable to make changes at the application level, you can modify the output DPI for an individual batch class.
1. From the Batch Class Management screen, select your batch class and click Open.
2. Go to Modules > Export > CREATEMULTIPAGE_FILE.
3. Set the Multipage File Export Process to GHOSTSCRIPT.
4. Edit the PDF Optimization Parameters according to your workflow requirements.
[image: A screenshot of a computer
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Possible settings include:
· Screen-view quality, 72 DPIi:
-dPDFSETTINGS=/screen
· Low quality, 150 DPI:
-dPDFSETTINGS=/ebook
· High quality, 300 DPI:
-dPDFSETTINGS=/printer
· High quality and color-preserving, 300 DPI:
-dPDFSETTINGS=/prepress
5. Click Apply.

How to Update SharePoint Authentication for Ephesoft Transact
MAY 6, 2020
|IN EXTERNAL APPLICATION
|BY LYDIAXIE
Applies to: All versions of Ephesoft Transact
This article provides steps on how to update your Sharepoint account to configure the SHAREPOINT_355_EXPORT_PLUGIN in Ephesoft Transact. You may need to perform these steps if you are receiving an error for updated authentication when configuring the plugin.
Instructions
Perform the following steps to create a new App password for your Sharepoint account to configure the SHAREPOINT_365_EXPORT_PLUGIN in Ephesoft Transact.
1. Navigate to your Office 365 My account page.
[image: A screenshot of a computer
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Figure 1. Office 365
2. Select Manage security & privacy > Additional security verification.
[image: A screen shot of a computer
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Figure 2. Additional security verification Option
3. Click Create and Manage app passwords
[image: A screenshot of a computer
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Figure 3. Security & privacy Screen
4. Click Create.
[image: A screenshot of a computer
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Figure 4. Application Passwords Screen
5. Enter a name for your app and click next.
[image: A screenshot of a computer
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Figure 5. App Name Example
6. Microsoft will generate your app password. Copy this password.
Important: The password will not display again after closing this window.
[image: A screenshot of a computer screen
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Figure 6. Generated Password Example
7. Navigate to the SharePoint Configuration screen in Ephesoft Transact.
8. Enter the connection details in the SharePoint Configuration screen along with the generated password from step 6.
[image: A screenshot of a computer
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Figure 7. Enter Generated Password from Office 365
You can now view the document libraries on your SharePoint site.
[image: A screenshot of a computer
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Figure 8. Export Settings Fields
Note: You can enter a specific SharePoint URL to filter the Document Library list to view specific document locations.
[image: A screenshot of a computer
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Figure 9. View the Document Library List

How to Update to a Previous Version of RHEL
MARCH 10, 2020
|IN INSTALL AND UPGRADE
|BY BREANNA FITZGERALD
Applies to: Ephesoft Transact 2020.1 on Linux
This article provides information on the two-part process of how to update your version of Red Hat Enterprise Linux to a supported previous release. Refer to Platform Configurations and Third-Party Integrations for more information on supported environments.
Note: Ephesoft Transact 2020.1 only supports RHEL 7.5 and 7.6.
Prerequisites
1. You must have a fresh server of RHEL.
2. You must be a root user.
Note: If you are not the root user, execute the following command:
sudo su root
Upgrade to Current Release
Perform these steps to upgrade to the latest version of RHEL. These instructions refer to RHEL 7.7 as the latest version.
1. Verify your Linux kernel version:
uname -r
Sample output for RHEL 7.3:
3.10.0-514.21.2.el7.x86_64
2. Update all packages with available updates:
yum update
3. Reboot the server to complete the upgrade:
reboot
Note: You will be logged out upon reboot. Log back in to continue.
4. Verify your updated Linux kernel version:
uname -r
Sample output for RHEL 7.7:
3.10.0-1062.9.1.el7x86_64
Downgrade to Supported Release
5. Downgrade to an earlier version of RHEL:
yum downgrade redhat-release
Note: This will downgrade by one release version of RHEL. For example, if your current distribution is RHEL 7.7, it will take you to RHEL 7.6.
6. Reboot the server to complete the downgrade:
reboot
Note: You will be logged out upon reboot. Log back in to continue.
7. Verify the updated Linux kernel version:
uname -r
Sample output for RHEL 7.6:
3.10.0-957.el7.86_64
Note: If your kernel downgrade fails when downgrading to RHEL 7.6, repeat steps 5-7 to downgrade again to RHEL 7.5.
8. Install the kernel version required to run RHEL 7.5 or 7.6:
yum install <kernel version>
Note: Check for the latest stable kernel version from Red Hat before upgrading. The following is an example command for RHEL 7.6:
yum install kernel-3.10.0-957.el7
9. Reboot the server to complete the download:
reboot
10. Verify your Linux version:
cat /etc/redhat-release
11. Verify your Linux kernel version:
uname -r
You have successfully updated your Linux distribution to a supported previous version.

How to Manually Install Microsoft’s TrueType Core Fonts
MARCH 4, 2020
|IN INSTALL AND UPGRADE
|BY BREANNA FITZGERALD
Applies to: Ephesoft Transact 2020.1 or above on Linux
Ghostscript is no longer supported in Ephesoft Transact 2020.1 or above for Linux and has been replaced with Nuance features. Due to this change, Ephesoft Transact requires Microsoft’s TrueType Core (msttcore) fonts to be installed when converting PDF to TIFF files. These fonts were previously included within Ghostscript.
If you are installing Ephesoft Transact 2020.1 or above for the first time, you will need to manually install the msttcore fonts, which must be installed on every processing server of Ephesoft Transact.
Follow the steps below to manually install these fonts:
RHEL
1. Download the epel-release repository, which is required to download dependencies:
wget https://dl.fedoraproject.org/pub/epel/epel-release-latest-7.noarch.rpm
2. Install the downloaded epel-release repository:
rpm -i epel-release-latest-7.noarch.rpm
3. Install required packages that support msttcore font installation:
yum install cabextract wget xorg-x11-font-utils fontconfig
4. Download the msttcore fonts package:
wget https://downloads.sourceforge.net/project/mscorefonts2/rpms/msttcore-fonts-installer-2.6-1.noarch.rpm
5. Install the downloaded msttcore fonts package:
rpm -i msttcore-fonts-installer-2.6-1.noarch.rpm
6. You have successfully installed Microsoft’s TrueType Core fonts

How to Activate the Department of Defense (DoD) Banner Feature
OCTOBER 4, 2019
|IN SECURITY, UI CUSTOMIZATION
|BY LYDIAXIE
Applies to: Ephesoft Transact 4.5.0.0 and above
A dialog box with a master subscription agreement (MSA), end-user license agreement (EULA), and a United States Department of Defense (DoD) banner can be displayed to users before they access the system management interface. The requirement for the banner is for websites with security and access controls.
The following steps describe how to configure Ephesoft Transact to display the required DoD banner when authentication is required for user access. To activate this feature, follow these steps:
1. Open the following file: \Ephesoft\Application\WEB-INF\classes\METAINF\notice.properties.
2. [image: A screenshot of a computer

Description automatically generated]Change the value of notice_display=2. Refer to the following screenshot.

3. Save the file.
4. Restart Ephesoft Transact.
5. [image: A screenshot of a computer

Description automatically generated]Log in to Ephesoft Transact. The DoD message displays as shown in the screenshot below:

Note: The displayed message can be modified. To modify locate the file locale.js at the following: \Ephesoft\Application\i18n\common directory.

How To Process Large Batches
NOVEMBER 1, 2018
|IN BEST PRACTICES
|BY
Applies to: Ephesoft Transact 4.5.x.x and above (previous versions may require slightly different settings)
Larger Batch Instances may require some additional configuration changes to process without timeouts.
Instructions:
1. Change process capacity
· Larger batches should process fewer batches at the same time to avoid resources getting used up.
· In the dcma-workflows.properties, you can change the server.instance.max.process.capacity.
2. Increase timeout times
· Larger batches may take longer than the default Transact timeout time, causing Transact to restart batches prematurely
· In the application.properties, you can adjust the wait times to stop these timeouts occurring.
# Wait time for GhostScript command in minutes
gs.command.wait.time=30
# Wait time for ImageMagik command in minutes
imageMagik.command.wait.time=30
# Wait time for Recostar command in minutes
recostar.command.wait.time=30
# Wait time for Tesseract command in minutes
tesseract.command.wait.time=30
# Wait time for LibTiff command in minutes
lib_tiff.command.wait.time=30

· In the dcma-workflows.properties, you can adjust the activity.restart.time
2. Alter the Advanced Barcode plugins
· The Advanced Barcode plugins can take a longer time than other plugins.
· In both the Reader and Extraction plugins, find the Barcode Methods, and turn off as many as you’re not using.

Steps to generate new details.properties in Linux environment
JUNE 20, 2018
|IN LICENSING
|BY TIM MCMULLIN
To create a new details.properties file and delete the old license file:
1. Stop ephesoft
2. navigate to /opt/Ephesoft/Dependencies/licensing/
3. delete the details.properties file. (sample command: sudo rm -rf ./details.properties)
4. run this command while in the licensing directory after the details.properties file has been deleted: sudo ./license-info ./
Do not forget the ./ at the end as this will tell the script where to place the new details.properties file and sudo is required since it will query system files.
5. delete the ephesoft.lic file in the /opt/Ephesoft/Dependencies/license-util/ephesoft-license-installer (sample command: sudo rm -rf /opt/Ephesoft/Dependencies/license-util/ephesoft-license-installer/ephesoft.lic
6. Delete the directory /etc/.java/.systemPrefs/com/ephesoft (sample command: sudo rm -rf /etc/.java/.systemPrefs/com/ephesoft)
7. install new ephesoft.lic file made with the new details.properties file by placing the ephesoft.lic in the /opt/Ephesoft/Dependencies/license-util/ephesoft-license-installer/
8. then run the command sudo ./install-license.sh locally to /opt/Ephesoft/Dependencies/license-util/ephesoft-license-installer/
9. Start Ephesoft service

How to Regenerate the details.properties for Licensing and MAC Address Changes
MAY 11, 2018
|IN LICENSING
|BY LYDIAXIE
Applies to: All versions
Topic/Category: Licensing
Issue
If you need a new Transact license and your server MAC address has changed, you will need to submit the request along with the new details.properties file for the server (or all nodes in a cluster) to https://knowledge.tungstenautomation.com/. This procedure will create a new details.properties file with the latest mac address information.
Solution
Follow the instructions below to regenerate the details.properties file.
1. Navigate to the details.properties file.
2. Recreate the file by running the full.bat file
[image: A screenshot of a computer
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How to Change the Default DatePicker Value
APRIL 27, 2018
|IN CONFIGURATION
|BY EPHESOFTADMIN
Applies to:
4500
Issue:
The default datePicker.format value in the application.properties file is MM/dd/yyyy but can be configured to display other formats.
Solution: 
1. Disable Transact service.
2. In the application.properties file, change MM/dd/yyyy;EEEE to dd-MM-yyyy:EEEE
3. Restart Transact.
The datePicker.format value should now appear as follows:
datePicker.format=dd-MM-yyyy;EEEE, d MMMM y;d MMMM y;dd/MM/yyyy;d/MM/yy

Submitting Support Tickets: Required Artifact to View Performance Issues
APRIL 26, 2018
|IN BEST PRACTICES
|BY
This article focuses on what artifacts are required to be provided to support team in order to troubleshoot below reporting issues:
·  Observing Performance Issues
·  Observing Slowness on User Interface
·  Observing Low PPM Processing
If you are observing any of the reported issues listed above, then you can report the issue by creating a new ticket at https://knowledge.tungstenautomation.com/. To speed up the process, please provide the information below prior to opening a ticket.
Environment Related information
· Ephesoft version you are currently on
· Environment architecture as below:
· Is this a single server or a cluster environment?
· Does database exist on same server or different server?
· Does shared folder exist on same server or different server?
· Each server specifications in terms of Memory, No. of Cores & O.S.
· Do you have any other application running on the same server?
· Send the screenshots of below when you are observing slowness from Task Manager Details & Performance Tab:
· CPU & Memory Usage in Performance Tab of Task Manager
· Details tab of processes sorted by memory highest
· Details tab of processes sorted by CPU highest
· How much memory is allocated to Tomcat?
· Navigate to Ephesoft/JavaAppServer/Bin
· Open EphesoftEnterprise.exe
· Go to Java Tab and send us what value is assigned to Initial Memory Pool & Maximum Memory Pool.
· How many operators / users are logged in to the UI?
· Verify if you are have enough Hard Disk space available.
· Any Ephesoft provided hot-fixes applied?
Batch Instance Related Information:
· How many batch instances are you processing in a day?
· What is average number of pages per batch instance?
· Check size and dimension of the TIFF files for the batches where you see performance issues?
License Related Information:
· Do you have High Performance License available?
Database Related Information:
· Get a count of records present in ephesoft database for below tables:
select count (1) from ACT_HI_ACTINST;
select count (1) from ACT_HI_PROCINST;
select count (1) from ACT_HI_VARINST ;
select count (1) from batch_instance; also check BI’s in FINISHED & DELETED STATE
· Send a screenshot of the following:
· server_registry table.
· last_execution table.
· service_status table.
· What is the size of the Ephesoft and report database?
· Send a screenshot of below query:
select BUSINESS_KEY_, START_TIME_,END_TIME_,DURATION_ from ephesoft.act_hi_procinst order by DURATION_ DESC
· Send screenshot of act_ru_job table in Ephesoft database.
Logs:
· Enable INFO Level Logging & Gather INFO level dcma-all.log, dcma-report.log (Ephesoft -> Application -> Logs) & stdout.log(Ephesoft -> JavaAppServer -> Logs).
Artifacts Required to Replicate the issue at our end:
Properties file:
· Please ZIP complete WEB-INF folder from server /servers and provide all the properties files.
· Key files required are
· workflow.properties
· application.properties
· folder-monitor.properties
· import-folder.properties
· mail-import.properties
· dcma-reporting.properties
Batch Class:
· If you are seeing issue with specific batch class then please provide an exported Batch Class ZIP file from User Interface to us.
Sample Files:
· If you are seeing performance issues with specific batch instances then provide us the actual PDF in the DROP folder and its associated folder created in ephesoft-system folder.
Once we have above information we can start analyzing the issue and come back to the customer with our analysis, suggestions, and workarounds.

Ephesoft Folders with Customer-Specific Data
MARCH 3, 2018
|IN OTHER
|BY
This page provides a list of folders within the Transact installation directory where Transact will store data and other processed information.
· Database: All information related to Transact and batch instances.
· UNC Folder / Drop Folder: Files or sample documents uploaded by users.
· ephesoft-system folder: Where most files are generated when a batch instance is in the RUNNING state. This includes TIF and batch.xml files, among others.
· final-drop-folder: Where the final PDF and batch.xml are stored. This can also be a user-configured location.
· report-data folder: Where all batch.xml files are stored, with respect to each module execution. This is used for reporting.
· Shared Folder: Where all batch classes are stored. Each batch class folder includes learned files for that batch class.
· temp folder: (JavaAppServer/temp) Stores class files of any custom scripts in place.
Note: There are other temp folders where images will be temporarily saved when using document ingestion methods like Web Scanner and Email Import. These images will be ultimately moved to the UNC folder or Drop folder. When these images are moved, the temporary folders are automatically deleted.

How to Export Batch Level Fields to CMIS Export
FEBRUARY 26, 2018
|IN BATCH CLASS, EXPORT
|BY
Applies to:
CMIS Export
Issue:
How to export Batch Level Fields to CMIS Repository in Ephesoft?
 
Solution: 
Exporting batch Field Values to CMIS is currently not a feature in Ephesoft. This is something which is already put as a feature request for later versions.
The workaround for this is external scripting where you will need to take care of below:
· Create index fields and its upto you if you want to keep these hidden to be displayed on the UI.
· Extract data from batch field values from batch.xml and populate the values in the index fields you have created above.
· Map these index fields in aspect mapping file.

How to Assign a Batch Instance
FEBRUARY 26, 2018
|IN BATCH INSTANCE, SCRIPTING
|BY
Overview
This article describes how to assign batch instances to specific groups or users using custom scripts in Ephesoft Transact to support a particular business workflow. This is different from the Suspend Batch feature. Batch instances cannot be assigned from the Ephesoft Transact UI. This is managed in the ScriptDocumentAssembler.java file.
Prerequisites
To perform the instructions in this article, you will need:
· Familiarity with Java scripting.
· Access to the ScriptDocumentAssembler.java file.
· Located at [Ephesoft_Directory]\SharedFolders\[your batch class]\scripts
· The DOCUMENT_ASSEMBLER_SCRIPTING_PLUGIN added to the workflow.
· Located at [your batch class] > Modules > Document Assembly.
· The rv.move_to_next_batch property set to “OFF” in the application.properties file. This property must be disabled for the script to function.
· Located at [Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\
Designing the Script
The guidelines for this script design are as follows. Code excerpts listed below are pulled from the sample ScriptDocumentAssembler.java file.
1. Write logic to determine the username to whom the batch should be assigned.
2. Write logic to get the batch instance identifier from the batch.xml file.
3. Write logic to get the role name, either from the database or a properties file, using the username determined in step 1.
4. Write logic to insert data in the Ephesoft database in the batch_instance_group table.
Refer to the sample ScriptDocumentAssembler.java file listed in the Appendix for a framework of this script.
Assigning Batches
Once you have designed the script, you can assign the batch instance.
You can either:
· Assign a batch to a group of users
· Assign a batch to a single user
[bookmark: _Assign_a_Batch]Assign a Batch to a Group of Users
You may want to assign a batch to a group of users if you have a group that performs the same kind of task, and anyone in that group can do the work.
To assign a batch to a group, make an entry in the batch_instance_groups table in the Ephesoft database.
· You can assign a group to every batch instance using scripts by making an entry in the batch_instance_groups table in the database.
Note: Only the assigned group will have access to that batch instance.
· If no group is assigned to the batch instance in the batch_instance_groups table, users belonging to the batch class group will have access to that batch instance.
Note: Users belonging to the group mapped in batch_instance_groups will be given preference over the users in the batch class group.
[bookmark: _Assign_a_Batch_1]Assign a Batch to a Single User
You may want to assign a batch to a single user if you want to direct a specific user to process a batch. This might be used if your business process dictates that the person who created a batch must also review or validate that batch.
To assign a specific user to a batch, make an entry in the batch_instance_users table.
You cannot have both a group and specific user assigned to a batch instance at once, as records in the batch_instance_groups table will override entries in the batch_instance_users table.
Note: The batch_instance_users table is only available in Ephesoft Transact 4.5.0.0 and above.
Conclusion
This completes an overview of how to assign batch instances to specific groups or users using custom scripts in Ephesoft Transact.
[bookmark: _Appendix]Appendix
Sample framework of the ScriptDocumentAssembler.java file.
import java.io.File;
import java.io.FileNotFoundException;
import java.io.FileOutputStream;
import java.io.FileWriter;
import java.io.IOException;
import java.io.OutputStream;
import java.util.List;
import java.util.zip.ZipEntry;
import java.util.zip.ZipOutputStream;
import org.hibernate.HibernateException;
import org.hibernate.SQLQuery;
import org.hibernate.StatelessSession;
import org.hibernate.Transaction;
import org.jdom.Document;
import org.jdom.Element;
import org.jdom.input.SAXBuilder;
import org.jdom.output.XMLOutputter;
import com.ephesoft.dcma.core.DCMAException;
import com.ephesoft.dcma.core.component.ICommonConstants;
import com.ephesoft.dcma.core.hibernate.DynamicHibernateDao;
import com.ephesoft.dcma.script.IJDomScript;
import com.ephesoft.dcma.util.ApplicationConfigProperties;
import com.ephesoft.dcma.util.logger.EphesoftLogger;
import com.ephesoft.dcma.util.logger.ScriptLoggerFactory;
/**
* The <code>ScriptDocumentAssembler</code> class represents the script execute structure. Writer of scripts plug-in should implement
* this IScript interface to execute it from the scripting plug-in. Via implementing this interface writer can change its java file at
* run time. Before the actual call of the java Scripting plug-in will compile the java and run the new class file.
*
* @author Ephesoft
* @version 1.0
*/
public class ScriptDocumentAssembler implements IJDomScript {
private static EphesoftLogger LOGGER = ScriptLoggerFactory.getLogger(ScriptDocumentAssembler.class);
private static String BATCH_LOCAL_PATH = "BatchLocalPath";
private static String BATCH_INSTANCE_ID = "BatchInstanceIdentifier";
private static String EXT_BATCH_XML_FILE = "_batch.xml";
private static String ZIP_FILE_EXT = ".zip";
final static String SQL_USER = "ephesoft";
final static String SQL_PASSWORD = "C@pture2O2O";
final static String SQL_DRIVER = "net.sourceforge.jtds.jdbc.Driver";
final static String DATABASE_NAME = "ephesoft";
final static String SQL_CONNECTION_STRING = "jdbc:jtds:sqlserver://localhost:1433/" + DATABASE_NAME;
final static String SQL_TABLE = "batch_instance_groups";
/**
* The <code>execute</code> method will execute the script written by the writer at run time with new compilation of java file. It
* will execute the java file dynamically after new compilation.
*
* @param document {@link Document}
* @throws DCMAException
*
*/
public static void main(String[] args) {
String filePath="C:\\Ephesoft\\SharedFolders\\ephesoft-system-folder\\BI2\\BI2_batch.xml\\BI2_batch.xml";
try{
SAXBuilder sb = new SAXBuilder();
Document document = sb.build(filePath);

// GET USERNAME FROM BATCH.XML
String userName=getUserName(document);

// GET BATCH INSTANCE IDENTIFIER FROM BATCH.XML
String batchInstanceIdentifier=getUserName(document);

// GET ROLE FROM DATABASE OR PROPERTIES FILE
String userRole="role1";

// Insert an entry into batch_instance_group table
assignedBatchInstanceGroup(batchInstanceIdentifier,userRole);
}
catch(Exception e){
e.printStackTrace();
}
}

// method to get username, adjust your logic accordingly
public static String getUserName(Document document) {
String getUserName=document.getRootElement().getChild("BatchName").getText();
return getUserName;
}

//method to get batch instance identifier
public static String getBatchInstanceIdentifier(Document document) {
String batchInstanceIdentifier=document.getRootElement().getChild("BatchInstanceIdentifier").getText();
return batchInstanceIdentifier;
}

//method to get batch instance identifier
public static void assignedBatchInstanceGroup(String batchInstanceIdentifier, String userRole ) throws DCMAException {
DynamicHibernateDao dynamicHibernateDao = null;
try {
dynamicHibernateDao = new DynamicHibernateDao(SQL_USER, SQL_PASSWORD, SQL_DRIVER, SQL_CONNECTION_STRING);
StatelessSession statelessSession = null;
statelessSession = dynamicHibernateDao.getStatelessSession();
Transaction transaction = statelessSession.getTransaction();
StringBuffer dbQueryBuffer = new StringBuffer();
if (SQL_CONNECTION_STRING.contains("mysql")) {
dbQueryBuffer.append("INSERT INTO ");
dbQueryBuffer.append(SQL_TABLE);
dbQueryBuffer.append(" (creation_date, last_modified, batch_instance_id, group_name) VALUES (NOW(), NOW(), '");
dbQueryBuffer.append(batchInstanceIdentifier);
dbQueryBuffer.append("', '");
dbQueryBuffer.append(userRole);
dbQueryBuffer.append("')");
} else if (SQL_CONNECTION_STRING.contains("sqlserver")) {
dbQueryBuffer.append("INSERT INTO ");
dbQueryBuffer.append(SQL_TABLE);
dbQueryBuffer.append(" (creation_date, last_modified, batch_instance_id, group_name) VALUES (GETDATE(), GETDATE(), '");
dbQueryBuffer.append(batchInstanceIdentifier);
dbQueryBuffer.append("', '");
dbQueryBuffer.append(userRole);
dbQueryBuffer.append("')");
}
SQLQuery query = statelessSession.createSQLQuery(dbQueryBuffer.toString());
transaction.begin();
query.executeUpdate();
transaction.commit();
statelessSession.close();
} catch (HibernateException e) {
System.err.println(e.getMessage());
e.printStackTrace();
} finally {
if (dynamicHibernateDao != null) {
dynamicHibernateDao.closeSession();
}
}
}
public Object execute(Document documentFile, String methodName, String documentIdentifier) {
Exception exception = null;
try {
LOGGER.info("************* Inside ScriptDocumentAssembler scripts.");
LOGGER.info("************* Start execution of the ScriptDocumentAssembler scripts.");
boolean write = false;
if (null == documentFile) {
LOGGER.error("Input document is null.");
}

// GET USERNAME FROM BATCH.XML
String userName=getUserName(document);

// GET BATCH INSTANCE IDENTIFIER FROM BATCH.XML
String batchInstanceIdentifier=getUserName(document);

// GET ROLE FROM DATABASE OR PROPERTIES FILE
String userRole="role1";

// Insert an entry into batch_instance_group table
assignedBatchInstanceGroup(batchInstanceIdentifier,userRole);

// Write the document object to the xml file. Currently following IF block is commented for performance improvement.
/*if (write) {
writeToXML(documentFile);
LOGGER.info("************* Successfully write the xml file for the ScriptDocumentAssembler scripts.");
}*/

LOGGER.info("************* End execution of the ScriptDocumentAssembler scripts.");
} catch (Exception e) {
LOGGER.error("************* Error occurred in scripts." + e.getMessage());
exception = e;
}
return exception;
}
/**
* The <code>writeToXML</code> method will write the state document to the XML file.
*
* @param document {@link Document}.
*/
private void writeToXML(Document document) {
String batchLocalPath = null;
List batchLocalPathList = document.getRootElement().getChildren(BATCH_LOCAL_PATH);
if (null != batchLocalPathList) {
batchLocalPath = ((Element) batchLocalPathList.get(0)).getText();
}
if (null == batchLocalPath) {
LOGGER.error("Unable to find the local folder path in batch xml file.");
return;
}
String batchInstanceID = null;
List batchInstanceIDList = document.getRootElement().getChildren(BATCH_INSTANCE_ID);
if (null != batchInstanceIDList) {
batchInstanceID = ((Element) batchInstanceIDList.get(0)).getText();
}
if (null == batchInstanceID) {
LOGGER.error("Unable to find the batch instance ID in batch xml file.");
return;
}
String batchXMLPath = batchLocalPath.trim() + File.separator + batchInstanceID + File.separator + batchInstanceID
+ EXT_BATCH_XML_FILE;
boolean isZipSwitchOn = true;
try {
ApplicationConfigProperties prop = ApplicationConfigProperties.getApplicationConfigProperties();
isZipSwitchOn = Boolean.parseBoolean(prop.getProperty(ICommonConstants.ZIP_SWITCH));
} catch (IOException ioe) {
LOGGER.error("Unable to read the zip switch value. Taking default value as true. Exception thrown is:" + ioe.getMessage(),
ioe);
}
LOGGER.info("isZipSwitchOn************" + isZipSwitchOn);
OutputStream outputStream = null;
FileWriter writer = null;
XMLOutputter out = new com.ephesoft.dcma.batch.encryption.util.BatchInstanceXmlOutputter(batchInstanceID);
try {
if (isZipSwitchOn) {
LOGGER.info("Found the batch xml zip file.");
outputStream = getOutputStreamFromZip(batchXMLPath, batchInstanceID + EXT_BATCH_XML_FILE);
out.output(document, outputStream);
} else {
writer = new java.io.FileWriter(batchXMLPath);
out.output(document, writer);
writer.flush();
writer.close();
}
} catch (Exception e) {
LOGGER.error(e.getMessage());
} finally {
if (outputStream != null) {
try {
outputStream.close();
} catch (IOException e) {
}
}
}
}
public static OutputStream getOutputStreamFromZip(final String zipName, final String fileName) throws FileNotFoundException,
IOException {
ZipOutputStream stream = null;
stream = new ZipOutputStream(new FileOutputStream(new File(zipName + ZIP_FILE_EXT)));
ZipEntry zipEntry = new ZipEntry(fileName);
stream.putNextEntry(zipEntry);
return stream;
}
}
KB0020695: How to extract multiline results in single line in Recostar Design Studio
JANUARY 12, 2018
|IN EXTERNAL APPLICATION, EXTRACTION
|BY
Issue Description:
Extracting multi-line results with respect to ICR field into single line.
 
Component:
Recostar Design Studio
 
Example:
As an example if you have Employer Address extracted in two different lines. This creates an issue in ephesoft as it picks only single line.
 
Solution:
You can add another recostar operator called “Reg Exp Formatter” and provide input as ICR field and default regex expression. This will then merge these two lines into a single line.

How to Migrate the Existing Transact Database to Another Server
JANUARY 8, 2018
|IN INSTALL AND UPGRADE
|BY
Here are the steps you will need to take to successfully migrate your current MYSQL, MSSQL or Oracle database to a new server for Transact Version 4.x. All current data archived in the existing databases will be moved.
 
1. Stop the Transact Service
2. Make a backup of your entire Ephesoft folder directory and your current set of Ephesoft databases
3. Export the whole databases from the DBserver: ephesoft, report, report_archive with a tool by choice (maybe ask the db-admin to do this)
4. Import the exported databases into the new DBserver with a tool by choice (maybe ask the db-admin to do this)
5. Check the database user and his rights as dbo – should be identical after Export/Import
6. Modify the server.xml file found in \Ephesoft\JavaAppServer\conf to use the updated connection details. Look for the portion under the tag <GlobalNamingResources> and edit the Serveradress, dataSource.user, dataSource.password in each tag. You will need to confirm the Database names for the new Ephesoft, Report and Report_Archive databases match what you imported in step 4 above.
7. Edit the dcma-db.properties file found in \Ephesoft\Application\WEB-INF\classes\META-INF\dcma-data-access and update the following entries if they were changed:
dataSource.password=
dataSource.username=
dataSource.databaseName=
8. Save all the changes
9. Stop the old database server or set the old databases offline.
10. Start the Transact service and make sure the new database is beeing used (take a look into the logfile: JavaAppServer/logs/*stout*)
 
Issues:
· The new database is used but I get a license error message.
· Install the license file one more time and restart the service.
 
IIS: Incorrect Error Message being thrown from Web Services
APRIL 24, 2017
|IN ERROR MESSAGES, WEB SERVICE APIS
|BY
Applies to: All versions of Ephesoft Transact
Issue
You may see the following error message with the copyDocumentType web API if a document type already exists: “The custom error module does not recognize this error”.
This is different than the expected error message for this issue: “Name entered for new doctype already exists. Please enter a unique document name”.
Root Cause 
This error appears from the Microsoft IIS side and is not due to any issue in Ephesoft. This is specifically because IIS is not configured to PassThrough the existing error message.
Solution
To resolve this issue, add the following to the web.xml, located at [Ephesoft_Directory]\Application\WEB-INF:
<system.webServer>
<httpErrors errorMode="DetailedLocalOnly" existingResponse="PassThrough">
</httpErrors>
</system.webServer>
How to Check the Service Name and SID in Oracle
APRIL 24, 2017
|IN EXTERNAL APPLICATION
|BY
Issue
The following error may occur in the logs when Ephesoft Transact is configured with Oracle:
Caused by: java.sql.SQLException: Listener refused the connection with the following error:
ORA-12514, TNS:listener does not currently know of service requested in connect descriptor
This error states that the mentioned service name cannot be found in the database. You may be using an incorrect Service Name or SID, and you will need to configure the correct SID/ Service Name in the server.xml connection string.
Query to Find Service Name
select value from v$parameter where name='service_names';
[image: image002]
Figure 1. Query to Find Service Name
The service name will display in the Query Result section. In the example above, the SID and service name are both “testdb”.
Update the server.xml
Update the connection string as below:
jdbc:oracle:thin:@//<<IP>>:<<PORT>>/<<ServiceName / SID>>
Change Ephesoft Transact from root to non-root
MARCH 6, 2017
|IN LINUX
|BY PEDROCHIM
Topic #1: How to change Ephesoft Transact to run as non-root when it was installed to run under the root user.
Applicable Ephesoft versions: 4.1.2.0 or Higher
These instructions will help you configure Ephesoft to run as a non-root user. For the example below, we are using the ephesoft user which we have already created and given sudo rights. Sudo rights are required for the user under which Ephesoft will be running. The epehsoft user will not be able to start ephesoft using the service, but will instead need to be started with the sh file.
More Info: When making these changes, if you have SharedFolders, you will have to make the chown and chmod changes to the SharedFolders also. For this sample, I’m assuming that /SharedFolders is the location of the mount of the SharedFolders mount. This may also have to be done on the shared folders host server/NAS. If the SharedFolders are hosted under the /opt/Ephesoft/SharedFolders, then step 5 is not necessary in the instructions below.
 
Instructions:
1. stop Ephesoft
# sudo service ephesoft stop
2. switch to root user
# su
3. Verify ephesoft user is correct:
# cat /etc/passwd | grep ephesoft
4. Change permissions for Ephesoft folder and /etc/.java which is where we hold the license
# chown -R ephesoft:ephesoft /opt/Ephesoft
# chmod -R u+rX /opt/Ephesoft
# chown -R ephesoft:ephesoft /etc/.java
# chmod -R u+r /etc/.java
5. Change Permissions for the SharedFolders
# chown -R ephesoft:ephesoft /SharedFolders
# chmod -R u+r/SharedFolders
6. Change the user in the /opt/Ephesoft/JavaAppServer/bin/shutdown.sh
# sed -i ‘s/application_user=root/application_user=ephesoft/g’ /opt/Ephesoft/JavaAppServer/bin/shutdown.sh
7. Change the user in the /opt/Ephesoft/JavaAppServer/bin/startup.sh
# sed -i ‘s/application_user=root/application_user=ephesoft/g’ /opt/Ephesoft/JavaAppServer/bin/startup.sh
8. Change user to ephesoft
# su ephesoft
9. Start Ephesoft as user ephesoft
# /opt/Ephesoft/JavaAppServer/bin/startup.sh

How predefined and unknown classification works
FEBRUARY 6, 2017
|IN CLASSIFICATION
|BY
Applies to: All versions of Ephesoft Transact
A main part of the Transact workflow is classification. Transact algorithms learn document types and their content to correctly classify input files in their respective document type based on a user-defined minimum confidence level.
Confidence levels should be updated regularly if you have new documents coming in the input file.
Normal Classification
When the document undergoes classification, the system will try to match the new document with the learned files of all document types, determine the best confidence result, and assign your document to that particular document type.
Predefined Document Type Classification
Predefined document types are configured in your Document Assembler plugin. When a new document is uploaded, first the system will assign the document a document type by comparing it with the learned files of each document type. This is based on which document type returns the highest confidence score.
This confidence score is then matched with the confidence score of your predefined document type. If the confidence threshold of the predefined document type is greater than that of the generated document type threshold, then the document will be assigned to the predefined document type. Otherwise, the document will be assigned to the document type with the highest confidence score.
Unknown Document Type Classification
Unknown document types are those that don’t get matched with any document types’ learned files and return a confidence score of zero (0). 
In Test Classification, these document types will be classified as Unknown.
If needed, you can configure a property in the Document Assembler plugin to automatically assign unknown document types to a specific document type.

KB0013321: Single Sign-On Authorization Error
DECEMBER 1, 2016
|IN SSO
|BY BREANNA FITZGERALD
Applies to: Ephesoft Transact 4.0.0.0
Issue
After configuring SSO using Authentication Type 1 or 2 in the web.xml, you may encounter the following error when logging in to Transact: “You are not authorized to view this page. Forbidden: Access is denied”.
[image: 2016-12-01_1540]Figure 1. Access Denied Error
Root Cause
The issue may be due to incorrect ordering of the SSO Authentication filter in the web.xml file.
Solution
To resolve this issue, you’ll need to re-order the entries in the web.xml file so that the authentication filter comes before the authorization filter.
1. Open the web.xml file located at [Ephesoft_Directory]\Application\WEB-INF\.
2. Locate the following excerpt:
<!-- Authentication Filter for SSO -->
<filter>
<filter-name>authenticationFilter</filter-name>
<filter-class>com.ephesoft.dcma.webapp.AuthenticationFilter</filter-class>

<!-- Name of HTTP header containing User Name. -->
<init-param>
<param-name>requestUsernameHeader</param-name>
<param-value>REMOTE_USER</param-value>
</init-param>

<!-- Name of HTTP header containing Group Name. -->
<init-param>
<param-name>requestGroupnameHeader</param-name>
<param-value>GROUP_USER</param-value>
</init-param>

<!-- Name of HTTP header containing Super Admin. -->
<init-param>
<param-name>requestSuperAdminHeader</param-name>
<param-value>SUPER_ADMIN</param-value>
</init-param>

<!-- Logout URL -->
<init-param>
<param-name>logoutUrl</param-name>
<param-value>https://www.samplecompanyname.com/Logout/logoff.asp</param-value>
</init-param>
</filter>
<filter-mapping>
<filter-name>authenticationFilter</filter-name>
<url-pattern>/*</url-pattern>
</filter-mapping>
<filter>
3. Cut and paste the above section to between the context-param tag and headerFilter. An example is included below:
<context-param>
<param-name>protocol</param-name>
<param-value>http</param-value>
</context-param>

<!-- Authentication Filter for SSO -->
<filter>
<filter-name>authenticationFilter</filter-name>
<filter-class>com.ephesoft.dcma.webapp.AuthenticationFilter</filter-class>

<!-- Name of HTTP header containing User Name. -->
<init-param>
<param-name>requestUsernameHeader</param-name>
<param-value>REMOTE_USER</param-value>
</init-param>

<!-- Name of HTTP header containing Group Name. -->
<init-param>
<param-name>requestGroupnameHeader</param-name>
<param-value>GROUP_USER</param-value>
</init-param>

<!-- Name of HTTP header containing Super Admin. -->
<init-param>
<param-name>requestSuperAdminHeader</param-name>
<param-value>SUPER_ADMIN</param-value>
</init-param>

<!-- Logout URL -->
<init-param>
<param-name>logoutUrl</param-name>
<param-value>https://www.samplecompanyname.com/Logout/logoff.asp</param-value>
</init-param>
</filter>

<filter-mapping>
<filter-name>authenticationFilter</filter-name>
<url-pattern>/*</url-pattern>
</filter-mapping>

<filter>
<filter-name>headerFilter</filter-name>
<filter-class>com.ephesoft.dcma.webapp.HTTPHeaderFilter</filter-class>
</filter>

<filter>
<filter-name>hibernate.dcma</filter-name>
<filter-class>org.springframework.orm.hibernate3.support.OpenSessionInViewFilter</filter-class>
</filter>

<!---->
<filter>
<filter-name>serverAuthorizationFilter</filter-name>
<filter-class>com.ephesoft.dcma.webapp.AuthorizationFilter</filter-class>
</filter>
4. Save and close the file.
5. Restart Ephesoft Transact.

Making an Index Field Optional During Validation
NOVEMBER 3, 2015
|IN INDEX FIELD, REGULAR EXPRESSIONS
|BY LYDIAXIE
Applies to: Ephesoft Transact 4.5.0.0 and above
How do you create a regular expression to allow blank values as an option during validation?
Regular Expression
Combine your regular expression with the regular expression for a blank (empty/null) space using the pipe symbol ( | ).
This regex validates blank spaces:
 ^\s*$
Example:
The following regex will accept “yes”, “no” or empty space as a validation rule.
yes|no|^\s*$
How to Set Tomcat to Create a Heap Dump After an OutOfMemoryError
SEPTEMBER 8, 2015
|IN BEST PRACTICES
|BY LYDIAXIE
Applies to: Ephesoft Transact 3.1.2.0 and above
How do I set Tomcat to automatically create a heap dump after an OutOfMemoryError?
Instructions
1. Navigate to [Ephesoft_Directory]/JavaAppServer/bin.
[image: A screenshot of a computer

Description automatically generated]
Figure 1. JavaAppServer\bin Folder
2. Open EphesoftTransact.exe (in older versions, this may be named EphesoftEnterprise.exe).
3. Click the Java tab and add the following strings to the Java Options:
-XX:+HeapDumpOnOutOfMemoryError
-XX:HeapDumpPath=c:\<path to heap dump folder>
Set the <path to heap dump folder> to the full path location. For example, if you create a HeapDump folder under C:\Ephesoft, use the following:
-XX:+HeapDumpOnOutOfMemoryError
-XX:HeapDumpPath=c:\Ephesoft\HeapDump
[image: A screenshot of a computer
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Figure 2. Ephesoft Transact Properties
4. Restart Ephesoft Transact.

How to Elevate to Admin without Prompting
JUNE 23, 2015
|IN SECURITY
|BY LYDIAXIE
Applies to: All versions of Ephesoft Transact
Due to changes in the default security settings between different versions of Windows (e.g. Windows Server 2012 R2), a user account that is listed as a member of the Administrators group may not perform any activity with the assumed administrative rights. It may be necessary to change the Local Group Policy.
This article includes steps to enable administrator privileges to members of the Local Administrators group by default to allow local administrators to access, install, and modify applications on the local machine in Windows.
This does not grant domain administrator rights to the user as the group policies only apply to the current server that the user is listed as a member of the Administrators group.
Instructions
The following instructions describe how to change the Local Group Policy from User Account Control: Behavior of the elevation prompt for Administrators in Admin Approval Mode to Elevate without Prompting.
Note: If this Local Group Policy is set before Ephesoft Transact is installed, then the installation will complete without issue.
1. In the Windows Command Prompt, run the command:
gpedit.msc
2. Navigate to the following Local Policy Computer Configuration > Windows Settings > Security Settings > Local Policies > Security Options.
3. Under the Security Options, select the following policy User Account Control: Behavior of the elevation prompt for Administrators in Admin Approval Mode.
4. Right-click and select Properties.
5. Click on the drop-down menu and select Elevate without Prompting.
6. Click Ok.
7. Restart your server. 
Note: A restart is required to apply this change.
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Figure 1. Default Local Group Policy Settings for Windows Server 2012 R2

How to Configure Chinese language Support at the Database Level
JUNE 23, 2015
|IN OCR LANGUAGES
|BY LYDIAXIE
Applicable Ephesoft Transact Versions: 4.x or above
This article provides steps on how to configure the key-value pair for KV extraction in the Chinese language at the database level.
· For MySQL/MariaDB:
1. To insert Chinese characters in the key_pattern and value_pattern columns of the kv_extraction table, change the collation of these columns from latin1_swedish_ci to utf8_bin by executing the following MySQL query:
ALTER TABLE `kv_extraction` CHANGE COLUMN `key_pattern` `key_pattern` VARCHAR(700) NULL DEFAULT NULL COLLATE ‘utf8_bin’ AFTER `key_fuzziness`;

ALTER TABLE `kv_extraction` CHANGE COLUMN `value_pattern` `value_pattern` VARCHAR(700) NULL DEFAULT NULL COLLATE ‘utf8_bin’ AFTER `use_existing_key`;
· For MS SQL server:
1. To insert Chinese characters in the key_pattern and value_pattern column of the kv_extraction table, change the data type of these columns from varchar to nvarchar by executing the following  MSSQL queries:
alter table [ephesoft].[dbo].[kv_extraction]

alter column key_pattern nvarchar(700);

alter table [ephesoft].[dbo].[kv_extraction]

alter column value_pattern nvarchar(700);

How to Back Up Ephesoft Transact
JUNE 16, 2015
|IN BEST PRACTICES
|BY PEDROCHIM
This article provides instructions and recommendations on how to back up Ephesoft Transact. 
Important: Since files can change and be locked while Ephesoft Transact is running, it is required to shut down the Ephesoft Transact service before performing any backups.
We recommend updating the following items:
1. Ephesoft Application Folder: holds settings for the application and supporting applications
2. Ephesoft SharedFolders Folder: holds all of the working files for running batches and by default holds the output files from Ephesoft Transact
3. Ephesoft EphesoftReports folder: holds settings used to connect to the reports database (applicable for Ephesoft Transact 4.0.X versions)
4. Ephesoft Transact and report databases
5. Batch classes (export)
Backing up Folders
· If storage space is not an issue, back up the full Ephesoft folder.
· If storage is an issue, we recommend that you back up the applications listed above. You can exclude the Ephesoft\Application\native folder in this backup.
Backing up Databases
· MariaDB (Ephesoft Transact 4.0.X versions)
When backing up your database in MariaDB, use the command line with the following syntax: mysqldump -u username -ppassword –databases db_name1 db_name2 > backup-file.sql
Example: mysqldump -u ephesoft -pephesoft–databases ephesoft report > backup-file.sql
· MSSQL
To back up a database in MSSQL, follow these steps:
1. 
1. Open the SQL Server Management Studio which hosts your ephesoft and report databases
2. Run the following commands for each database to change the output file to your preferred backup location and filename. Include a date in the filename to support multiple backups.
BACKUP DATABASE ephesoft
TO DISK = 'C:\Backups\ephesoft.BAK'

GO

3. Press Enter.
· MySQL (earlier than Ephesoft Transact 4.0.X):
When backing up your database in MySQL, use the command line with the following syntax: mysqldump -u username -ppassword –databases db_name1 db_name2 > backup-file.sql
Example:
mysqldump -u ephesoft -pephesoft–databases ephesoft report > backup-file.sql
Backing Up Batch Classes
Use the export functionality in the Batch Class Management screen to back up the batch classes. It is also recommended that you export the batch classes with sample files. Once exported as .zip files, these files will act as your backups.

How To Use Jvisualvm
JUNE 15, 2015
|IN EXTERNAL APPLICATION
|BY LYDIAXIE
Introduction to Java VisualVM
Java VisualVM is a tool that provides a visual interface for viewing detailed information about Java technology-based applications (Java applications) while they are running on a Java Virtual Machine (JVM). Java VisualVM organizes JVM data that is retrieved by the Java Development Kit (JDK) tools and presents the information in a way that enables you to quickly view data on multiple Java applications. You can view data on local applications and applications that are running on remote hosts. You can also capture data about the JVM software and save the data to your local system, and view the data later or share the data with others.
In order to benefit from all Java VisualVM’s features, you should run the Java Platform, Standard Edition (Java SE) version 6.
Java VisualVM is bundled with JDK version 6 update 7 or greater. Once you have installed an appropriate JDK version, navigate to your JDK software’s bin directory and double-click the Java VisualVM executable. On Windows this directory will be the following:
C:\Program Files\Java\jdk1.6.0_update-number\bin
In the case of Ephesoft Transact you can find the jvisualvm application in the following location:
<Ephesoft_Installation_Directory>\Dependencies\jdk\bin\jvisualvm.exe
Alternatively, navigate to your JDK software’s bin directory and type the following command at the command (shell) prompt:
jvisualvm
The first time that you launch Java VisualVM you are prompted to accept a license agreement.
Java VisualVM Userdir
On Windows, the default location for the Java VisualVM userdir is the following:
C:\Documents and Settings\<USER>\Application Data\.visualvm\JDK_update-number
To find the location of your Java VisualVM userdir, choose Help > About from the main menu and click Details in the About Java VisualVM window.
Java VisualVM Windows
When you start Java VisualVM, the main Java VisualVM window opens. The main Java VisualVM window is divided into two windows.
[image: screenshot of VisualVM window with Start screen]
When you first start Java VisualVM, the Applications window is visible in the left side of the window and the Start Page is visible in the right side in the main window. The Start Page contains links to Java VisualVM documentation web pages and additional resources.
Note: The Start Page opens by default each time you start Java VisualVM. You can open the Start Page at any time by choosing Help > Start Page from the main menu. You can also hide the Start page by unchecking the “Show On Startup” check-box.
Applications Window
The Applications window opens in the left side of the main Java VisualVM window when you launch the application. The Applications window is the main point of entry for exploring the details of running applications. The Applications window uses a tree structure to enable you to quickly view the applications running on the local machine and any connected remote machines. You can also access core dumps (Solaris/Linux) and saved snapshots from the Applications window.
Right-clicking a node in the Applications window opens a popup menu that enables you to perform actions related to that node, including opening application tabs, taking heap and thread dumps and opening snapshots in the main window.
For more details about how to use the Applications window to view and save data, see the following pages:
· Using the Applications Window
· Working with Local Applications
· Working with Remote Applications
· Working with VM Coredumps
· Working with Snapshots
Main Window
Detailed information about applications is displayed in the main window. When you view data about an application, each application is represented by a tab in the main window that enables you to easily view and navigate the data. Saved thread dumps and heap dumps are also opened in the main window.
For information about the application data that can be displayed in the main window, see the following pages:
· Application Overview Tab
· Monitoring an Application in the Monitor Tab
· Monitoring Threads in the Threads Tab
· Browsing a Heap Dump
· Profiling an Application in the Profiler Tab (local applications only)
Java VisualVM Heap Dump Creation
In order to troubleshoot memory related issue with Java or Tomcat, it is sometime necessary to create Heap Dumps. These files will then provide deeper analysis of processes and threads that are consuming memory for specific classes that are being executed in the application code. Below are the instructions on how to create or collect a heap dump.
1. Connect to the Ephesoft JMX port on your local server (remote connections require port 8900 to be Allowed on the firewall)
2. In the jvisualvm UI, right click on the JMX connection you are monitoring.
3. Select Heap Dump
4. Right Click on the Heap Dump that we created
5. Select Save As
6. Save the Heap Dump file (.hprof extension) to a folder location
[image: A screenshot of a computer
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Java VisualVM Plugins
You can add functionality to Java VisualVM by using the Plugins manager to install plugins from the Java VisualVM Plugins Center. You can also extend the functionality of Java VisualVM by developing your own plugins that can then be added to an update center.
For example, installing the Java VisualVM-MBeans plugin adds an MBeans tab to the application tab that enables you to monitor and manage MBeans from within Java VisualVM.
To install a Java VisualVM plugin:
1. Choose Tools > Plugins from the main menu.
2. In the Available Plugins tab, select the Install checkbox for the plugin. Click Install.
3. Step through and complete the plugin installer.
[image: screenshot of Plugins window]
For more information about creating Java VisualVM plugins, please read Getting Started Extending Java VisualVM.

How to Recover MariaDB
JUNE 3, 2015
|IN EXTERNAL APPLICATION
|BY LYDIAXIE
Applicable Ephesoft Transact Versions: 4.0.2.0 or above
This article provides instructions on how to recover MariaDB.
1. Open the my.ini file in the dependencies\mariadb folder
[image: A screenshot of a computer
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Figure 1. My.ini file
2. Add the following line below the port value:
innodb_force_recovery=1
Note: This change should be made under the [mysqld] section of the my.ini file.
[image: A screenshot of a computer

Description automatically generated]Figure 2. Adding innodb_force_recovery=1
3. Save the my.ini file
4. Start the MariaDB service.
5. Once the MariaDB service has started, check the database with a database client, which is included in Ephesoft Transact as HeidiSQL, and ensure that you are able to login.
6. Once you confirm the ability to connect to the database, open the my.ini file and remove the added line in step 2.
7. Start the Ephesoft Transact service.
 
Migrating a Batch Class from Windows to Linux
APRIL 14, 2015
|IN OTHER
|BY PEDROCHIM
Applies to: All versions of Ephesoft Transact
This article provides steps on how to take a batch class created for Transact on a Windows server and import it to a Transact instance installed on a Linux server.
User Steps
There are a few things that must be changed after you import a Batch Class into an Ephesoft Transact instance installed on a Linux server if the Batch Class was exported from a Transact instance that was installed on a Windows Server.
1. Export the batch class from the Windows instance of Transact.
2. Click Import in the Batch Class Manager on the Transact Linux instance
3. Select the ZIP file for the exported Batch Class and fill in the new drop folder for the batch class on the Linux server (if you are using a network share, remember to mount this as a local directory on the Linux server first).
4. Once you import the Batch Class, you will need to make the following changes to the batch class:
1. In the IMPORT_MULTIPAGE_FILES plugin inside of the Folder Import module, change the Ghostscript parameter of “sDEVICE=tiffscaled24” to “sDEVICE=tiff24nc”
2. Click Apply.
3. In the Page Process module, remove the RECOSTAR_HOCR plugin and replace it with the NUANCE_OCR plugin.
4. Click Deploy.
5. In the Extraction module, remove the RECOSTAR_EXTRACTION plugin
6. Click Deploy.
7. For Ephesoft Transact 4.0.0.0 and above: In the COPY_BATCH_XML plugin inside of the Export module, you will need to change the Multipage File Export Folder to match the location of the final drop folder, and replace the backslashes ( \ ) with forward-slashes ( / ) in the following path. For example “$BATCH_CLASS\$BATCH_IDENTIFIER\$DATE(yyyy-MM-dd)” will become “$BATCH_CLASS/$BATCH_IDENTIFIER/$DATE(yyyy-MM-dd)” if you would like to keep the same directory schema (or mounted directory if using a remote share for your SharedFolders).
8. In the COPY_BATCH_XML plugin inside of the Export module, you will need to change the Final Export Folder to match the location of the final drop folder on the Linux Server (or mounted directory if using a remote share for your SharedFolders).

Stopping Batches from Timing Out During Page Processing
MARCH 31, 2015
|IN BEST PRACTICES
|BY LYDIAXIE
Applies to: All versions of Ephesoft Transact
If batches are timing out during page processing, you may need to increase the default timeout. By default, if Recostar, Imagemagick, Ghostscript, or Tesseract take more than 30 minutes to process a batch instance, the batch will timeout and you may receive an error.
Increase Timeout
Perform the following steps to increase the default timeout:
1. Stop Ephesoft Transact.
2. Open the application.properties file, located at [Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\.
3. Locate the following lines (near the bottom of the file):
# Wait time for Ghostscript command in minutes 
gs.command.wait.time=30

# Wait time for ImageMagick command in minutes 
imageMagik.command.wait.time=30

# Wait time for RecoStar command in minutes 
recostar.command.wait.time=30

# Wait time for Tesseract command in minutes 
tesseract.command.wait.time=30
[image: application.properties]
Figure 1. application.properties File
4. Set the command.wait.time for your applicable OCR engine(s) to the amount in minutes Transact should continue page processing prior to timing out.
5. Save the file.
6. Start Ephesoft Transact.

Configuring the Dynamic Logging Functionality
MARCH 19, 2015
|IN OTHER
|BY BREANNA FITZGERALD
Applies to: All versions of Ephesoft Transact
The following steps describe how to use the dynamic logging feature in Ephesoft Transact. These steps vary by version:
· Ephesoft Transact 2019.2 and above
· Ephesoft Transact 4.5.0.0 to 2019.1
· Ephesoft Transact prior to 4.5.0.0
[bookmark: _Ephesoft_Transact_2019.2]Ephesoft Transact 2019.2 and Above
Note: Starting with 2019.2, JMX connections are disabled. Perform the following steps to dynamically change log levels:
1. Open the Task Manager.
2. Locate the process ID (PID) for EphesoftTransact. In the example below, the PID is 1696.
[image: A screenshot of a task manager
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Figure 1. Task Manager
3. Open the command prompt.
4. Go to the following directory:
C:\Ephesoft\Dependencies\jdk\bin
4. Enter the following command to open JConsole:
jconsole processID
[image: A computer screen with white text
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Figure 2. Command Prompt
5. Confirm that the JConsole connection is successful.
[image: A computer screen shot of a computer
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Figure 3. Java Management Console
[bookmark: _Ephesoft_Transact_4.5.0.0]Ephesoft Transact 4.5.0.0 to 2019.1
1. Open the JConsole utility, located at [Ephesoft_Directory]\Dependencies\jdk\bin.
2. Select Remote Process.
[image: A screenshot of a computer
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Figure 4. New Connection
3. In the text field, enter “<ServerIP>:8900”. For example, if your server IP address is 172.19.128.92, enter “172.19.128.92:8900”.
4. Click Connect.
Once you have successfully connected to the Ephesoft JMX port, the following window will appear:
[image: ]
Figure 5. Connection Window
5. Select the MBeans tab.
6. In the left-tree, go to org.apache.logging.log4j2 > /dcma > Loggers.
[image: ]
Figure 6. MBeans Tab
7. To get the current log level for a logger, expand the corresponding logger node, and select Attributes. In the Level field, the current logging level is displayed.
[image: ]
Figure 7. Error Level
8. To set the log level for a logger, click the level Value to edit the entry and hit ENTER to save your changes.
Note: Alternatively, you can expand the Attributes node and set the logging level from the Level section.
[image: ]
Figure 8. Info Level
[image: ]
Figure 9. Expand Attributes
[bookmark: _Ephesoft_Transact_prior]Ephesoft Transact prior to 4.5.0.0
1. Open the JConsole utility, located at [Ephesoft_Directory]\Dependencies\jdk\bin.
2. Select Remote Process.
[image: ]
Figure 10. New Connection
3. In the text field, enter “<ServerIP>:8900”. For example, if your server IP address is 172.19.128.92, enter “172.19.128.92:8900”.
4. Click Connect.
Once you have successfully connected to the Ephesoft JMX port, the following window will appear:
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Figure 11. Connection Window
5. Select the MBeans tab.
6. Expand the Ephesoft tree node.
[image: A screenshot of a computer
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Figure 12. MBeans Tab
7. Go to logging > config > Attributes > loggers. This displays all the loggers available in Ephesoft Transact.
8. To view or set the logging level for a specific logger, go to logging > config > Operations.
[image: ]
Figure 13. MBeans Operations
9. To retrieve the log level:
a. Enter the logger name in the text box.
b. Click getLogLevel.
c. A popup will appear with the log level information..
[image: ]
Figure 14. Info Level
10. To set the log level:
a. Enter the logger name in the p0 field and the log level in the p1 field.
b. Click setLogLevel.
c. A popup will appear with the message “Method successfully invoked”.
[image: ]
Figure 15. Success Message

Integrating IIS with Ephesoft Tomcat Server
FEBRUARY 12, 2015
|IN OTHER
|BY PEDROCHIM
Applies to:
· Ephesoft Transact 3.1 and above
· IIS 7, 7.5, and 8
Overview
The process to integrate Internet Information Services (IIS) with Ephesoft follows these general steps:
1. Create a new site named “Ephesoft” in the IIS manager.
2. Configure the AJP connector so that the Ephesoft Tomcat server works with the IIS web server.
Create Ephesoft Site in IIS Manager
1. Open the Internet Information Services (IIS) Manager on your Windows server by typing “inetmgr” in the search box. A window as shown below will get opened.
[image: image1]
2. Select Sites under the IIS server in which Ephesoft needs to be configured. Right-click Sites and select Add Web Site. A new pop-up will appear.
[image: image2]
3. Enter the Site name, Physical path, and Host name.
[image: image3]
4. Click OK.
[image: image4]
You have successfully configured the new site in the IIS manager. Next, you will need to Configure the Tomcat AJP Connector.
[bookmark: _Configure_the_Tomcat]Configure the Tomcat AJP Connector
1. Download the open-source IIS to Tomcat Connector from GitHub.
Note: If the above link does not work, go to BonCode Connector and download the latest version from the GitHub link provided on this site.
2. Extract the downloaded archive and execute Connector_Setup.exe, available in the extracted package. The installation wizard will launch.
[image: image5]
3. Click Next.
4. Read the confirm the Terms of Agreement.
5. Enter the Apache Tomcat Server hostname and Apache Tomcat AJP Port configured in the server.xml of the Tomcat server. The default AJP port configured in Ephesoft is 8009. The default populated value (i.e localhost and 8009) will work if the configuration is being done on localhost with the default Ephesoft JavaApp server.
[image: image6]
6. Click Next.
7. Check Enable Remote Access to Apache Tomcat and click on next.
[image: image7]
8. Select all options except Force Secure Sessions.
9. Click Next.
[image: image8]
10. Select Let me choose specific sites.
11. Click Next.
[image: image9]
12. Clear Default Web Site and select Ephesoft.
13. Click Next.
[image: image10]
14. For Select Handler Mapping, select all available request types.
15. Click Next.
[image: image11]
16. Select Enable IIS Sub Configuration.
17. Click Next.
[image: image12]
18. Click Install. When the installation is complete, the AJP connector is ready to take requests from the IIS server.
19. Before logging into Transact, restart both the IIS server and Ephesoft Tomcat server.
Note: To verify successful integration of IIS with Ephesoft Tomcat, try accessing http://localhost/dcma on a web browser (if Ephesoft site is bound with port 80, if it is bound to any other port try http://<hostname>:port/dcma).
Troubleshooting
1. Ensure the logged in user who is managing the IIS server has the proper file system level permission in the Application folder.
2. Ensure no two applications are running on the same port. When we create a new site in the IIS server, by default it binds with port 80, and also the default site available in IIS is also configured to run on port 80. In such case either change the port binding of the Ephesoft site or stop the default site that will be running by default.
[image: image13]

[bookmark: _Collecting_the_Ephesoft]Collecting the Ephesoft Transact Application Logs
JANUARY 22, 2015
|IN OTHER
|BY PEDROCHIM
Applies to: All versions of Ephesoft Transact
Ephesoft Transact errors are recorded in the logs by default. Ephesoft can also log non-error procedures with INFO level logging turned on in real-time. With most issues, when opening a support ticket, you will need to submit this information for the quickest analysis.
Log Files
The primary log file types are the following:
· dcma-all.log
· dcma-reporting-all.logs
· Linux: catalina.out
· Windows: ephesoftenterprise-stdout
Depending on your version of Ephesoft, logs are stored in the following directories:
· DCMA logs: [Ephesoft_Directory]/Application/logs/
· JavaAppServer logs: [Ephesoft_Directory]/JavaAppServer/logs/
What to send with your support tickets
The most complete logs that you can send are INFO level logs. If your issue is replicable and recorded each time you are running a specific procedure, turn INFO level logs on first; restart the server and replicate the issue. This will ensure the complete process trace is recorded in the log file. Go to the directories mentioned above, ZIP the files together, and submit with your support issue to. If your environment can not be interrupted to turn INFO level logging on, submit any logs that your system has already collected and we can try to perform an analysis with what you have collected.

Deleting the Ephesoft Database and Recreating it Manually
JANUARY 19, 2015
|IN OTHER
|BY LYDIAXIE
Issue
Some situations may require you to start with a new Ephesoft environment. Rather than performing a complete uninstall and reinstall, you may be able to delete the database contents and start fresh.
Important: This is recommended only for dev environments, as any production environments should be installed as cleanly as possible.
Solution
Perform the following steps to delete and manually recreate the Ephesoft database.
1. Stop Ephesoft Transact.
2. Take note of the database names and db_owner credentials for the following three databases:
· ephesoft
· report
· report_archive
Note: If you lose the login credentials for the above databases, you will need to manually reconfigure the Ephesoft configuration files.
3. Delete the above three databases.
4. Recreate the databases with the following queries.
{path}\Ephesoft\Dependencies\MsSQLSetup\ephesoft-mssql-config.sql
{path}\Ephesoft\Dependencies\MySQLSetup\ephesoft-mysql-config.sql
Note: Ensure the database names match those in step 1. The above queries have a step for creating and associating credentials. Depending on your database policies, you may not want to use these queries. The query will error out on these lines if the user credentials already exist in the system.
5. Verify that the previous credentials noted in step 1 are reassociated or recreated.
6. Rename the serialized (.ser) files so Transact can perform database setup procedures. These files are located in SharedFolders\database-update.
BatchClassUpdate.ser-executed to BatchClassUpdate.ser
DependencyUpdate.ser-executed to DependencyUpdate.ser
PluginConfigUpdate.ser-executed to PluginConfigUpdate.ser
PluginUpdate.ser-executed to PluginUpdate.ser
ScannerConfigUpdate.ser-executed to ScannerConfigUpdate.ser
7. Change the configuration flags.
{path}\Ephesoft\Application\WEB-INF\classes\META-INF\dcma-data-access\dcma-db.properties
upgradePatch.enable=true

{path}\Ephesoft\Application\WEB-INF\classes\META-INF\dcma-workflows\dcma-workflows.properties
workflow.deploy=true
8. Start Ephesoft Transact.
Note: After Transact has restarted, the above .ser files should revert back to .ser-executed.
9. Verify the default batch classes have been created in the batch_class table in the ephesoft database.

Disabling Anonymous Access to the OpenLDAP Directory
JANUARY 15, 2015
|IN OTHER
|BY LYDIAXIE
Applies to: All versions of Ephesoft Transact
The following steps describe how to disable anonymous access to the OpenLDAP directory. This is recommended if you are using LDAP as your authentication method and have security concerns regarding anonymous access.
Configuration
Perform the following steps to disable anonymous access:
1. Stop Ephesoft Transact.
2. Open the slapd.conf file, located at [Ephesoft_Directory]\Dependencies\OpenLDAP\.
3. Add the following line to prevent anonymous access by all users:
access to * by anonymous none
4. Add the following lines to explicitly deny anonymous binds and anonymous access to the directory information:
disallow bind_anon
require authc
5. Save and close the file.
6. Start Ephesoft Transact.

Updating the Ephesoft DB Configuration
JANUARY 15, 2015
|IN CONFIGURATION, SYSTEM
|BY BREANNA FITZGERALD
Applies to: Ephesoft Transact 4.5.0.0 to 2019.1
This article describes how to update your database configuration after migrating your Ephesoft database to another DB server.
Update Property Files
Perform the following steps:
1. Stop Ephesoft Transact.
2. Update the following property files with the new server name and IP address:
· 
· dcma-db.properties
[Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\dcma-data-access\dcma-db.properties
· 
· dcma-report-db.properties
[Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\dcma-performance-reporting\dcma-report-db.properties
· 
· hibernate-dcma.cfg.xml
[Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\dcma-reporting\hibernate-dcma.cfg.xml
· 
· hibernate.cfg.xml
[Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\dcma-reporting\hibernate.cfg.xml
· server.xml
[Ephesoft_Directory]\JavaAppServer\conf\server.xml
3. Start Ephesoft Transact.

How to Enable Java Logging in Windows
DECEMBER 8, 2014
|IN LOGGING
|BY LYDIAXIE
Operating System: Windows
This article provides information on how to enable Java tracing and logging. Logging is a feature that allows any output in the Java Console to redirect to a log file using the Java Logging API. Java logging provides a record that may be needed for troubleshooting.
To enable logging, perform the following steps.
1. Open the Windows Control Panel.
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Figure 1. Windows Control Panel
2. Select Programs > Java.
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Figure 2. Open Java Control Panel
3. The Java Control Panel will open in a separate window. Click the Advanced tab at the top.
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Figure 3. Java Control Panel Advanced
4. Select Enable tracing and Enable logging.
5. You have successfully enabled Java logging. By default, logs are stored in
<User Application Data Folder>\Sun\Java\Deployment\log

[bookmark: _Setting_Logs_to]Setting Logs to INFO Level
NOVEMBER 17, 2014
|IN LOGGING
|BY PEDROCHIM
Applies to: All versions of Ephesoft Transact.
Issue
You may be asked to set your Ephesoft Transact installation to INFO level logging if you have encountered an error that Ephesoft Support needs more information to resolve. By default, only error messages are logged in the Ephesoft logs. INFO level logs help us to better diagnose your issue, as it allows us to see exactly where the error is happening in the application process.
Note: It is recommended that you collect INFO level logs before escalating an issue to support.
Affected Log Files
The table below shows the log files that will need to be configured for INFO level logging.
	Operating System
	Log File

	Windows
	· [Ephesoft_Directory]\Application\logs\dcma-all.log
· [Ephesoft_Directory]\Application\logs\dcma-report-all.log
· [Ephesoft_Directory]\JavaAppServer\logs\stdout.log
· [Ephesoft_Directory]\JavaAppServer\logs\catalina.log

	Linux
	· [Ephesoft_Directory]/Application/logs/dcma-all.log
· [Ephesoft_Directory]/Application/logs/dcma-report-all.log
· [Ephesoft_Directory]/JavaAppServer/logs/catalina.out
· [Ephesoft_Directory]/JavaAppServer/logs/catalina.<date>.log


Enabling INFO Level Logging
Follow the steps below to enable INFO level logging for Ephesoft Transact 2020.1.03 and newer.
1. Stop the Ephesoft Transact service.
2. In the log4j.xml file, located in [Ephesoft_Directory]\Application\log4j.xml, locate the <Logger name="com.ephesoft" additivity="false" level="ERROR" and <AppenderRef ref="CORE" level="ERROR"/> parameters.
3. Change the level="ERROR" parameters to level=”INFO”
4. The com.ephesoft logger should now read as follows:
<Logger>
<Logger name="com.ephesoft" additivity="false" level="INFO">
<AppenderRef ref="CORE" level="INFO"/>
<AppenderRef ref="MONITOR" level="INFO"/>
<!--<AppenderRef ref="LOG_MONITOR"/> -->
</Logger>
5. Save and close the log4j.xml file.
6. Start the Ephesoft Transact service.
Follow the steps below to enable INFO level logging for Ephesoft Transact 2020.1.02 and older.
1. Stop the Ephesoft Transact service.
2. In the log4j.xml file, located in [Ephesoft_Directory]\Application\log4j.xml, locate the <level value=”ERROR” /> parameter.
3. Change the value=”ERROR” to value=”INFO”
4. The com.ephesoft logger should now read as follows:
<logger>
<logger name="com.ephesoft">
<level value="INFO" />
</logger>
5. Save and close the log4j.xml file.
6. Start the Ephesoft Transact service.
Note: INFO level log files can grow very quickly. It is recommended that you change back to ERROR level after you have supplied the INFO level logs to the Support team. Follow the same steps as above, but change the level from INFO to ERROR.
Enabling INFO Level Logging for Reporting
Follow the steps below to enable INFO level logging for reporting.
1. Stop the Ephesoft Transact service.
2. In the log4j.xml file, located in [Ephesoft_Directory]\Application\log4j.xml, locate the <Logger name="com.ephesoft.dcma.report" level="ERROR" additivity="false"> parameter.
3. Change the level="ERROR" parameter to level=”INFO”
4. The com.ephesoft.dcma.report logger should now read as follows:
<Logger>
<Logger name="com.ephesoft.dcma.report" level="INFO" additivity="false">
<AppenderRef ref="REPORT_APPENDER"/>
</Logger>
5. Save and close the log4j.xml file.
6. Start the Ephesoft Transact service.
7. 
1. 
Note: INFO level log files can grow very quickly. It is recommended that you change back to ERROR level after you have supplied the INFO level logs to the Support team. Follow the same steps as above, but change the level from INFO to ERROR.

Control Log File Size
NOVEMBER 4, 2014
|IN LOGGING
|BY LYDIAXIE
Applies to: All versions of Ephesoft Transact
Note: You will need administrator permissions.
1. Open the log4j.properties file, located at [Ephesoft_Directory]\EphesoftReports\WEB-INF\classes\log4j.properties. Write the following sample configuration to limit the size of the catalina.log file and its back up count:
log4j.appender.CATALINA=org.apache.log4j.RollingFileAppender
log4j.appender.CATALINA.File=${catalina.base}/logs/catalina.log.
log4j.appender.CATALINA.Append=true
log4j.appender.CATALINA.MaxFileSize=2MB
log4j.appender.CATALINA.MaxBackupIndex = 30
log4j.appender.CATALINA.Encoding=UTF-8
log4j.appender.CATALINA.layout = org.apache.log4j.PatternLayout
log4j.appender.CATALINA.layout.ConversionPattern = %d [%t] %-5p %c- %m%n
Note: This sample configuration sets the maximum file size to 2MB. You can change this by setting the following property to your preferred maximum log size:
log4j.appender.CATALINA.MaxFileSize=
2. Save and close the log4j.properties file.
3. Open EphesoftTransact.exe located at [Ephesoft_Directory]\JavaAppServer\bin\EphesoftTransact.exe.
Note: In older versions, this file is labeled EphesoftEnterprise.exe.
4. Select the Logging tab.
5. Set Redirect Stdout to redirect to the catalina.log file.
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Description automatically generated]Figure 1. EphesoftTransact Properties Logging Tab
6. Apply the changes.
7. Start the Ephesoft Transact server.
The rollover only works when Ephesoft Transact is running as an application. Stdout logs are only written when Ephesoft is running as a service. As a service, the workaround will overwrite the log file, but no rollover will occur. You will be able to maintain a manageable size file. As an app, recycled and rolled over files will be created.
MaxFileSize will apply to service and app log settings.
In the event that additional logging is needed for a longer duration, repeat steps 1 and 2 above and increase the MaxFileSize.

Migrating your Existing Ephesoft Database from MYSQL to MSSQL
SEPTEMBER 29, 2014
|IN CONFIGURATION, SYSTEM
|BY LYDIAXIE
Migrating your Existing Ephesoft Database from MYSQL to MSSQL
Here are the steps you will need to take to successfully migrate your current MYSQL database to a New MSSQL server for Ephesoft Version 4.x. Please keep in mind this will install a new copy of the Ephesoft and Report databases. All current data archived in the existing databases will not be moved.
Solution:
1. Make a backup of your entire Ephesoft folder directory and your current set of Ephesoft databases
2. Export all the batch classes from Ephesoft running on MySQL if the customer wants to move them to the new MSSQL implementation
3. Create a database in MSSQL using the ephesoft-mssql-config.sql file found in you Ephesoft\Dependencies\MsSQLSetup folder. You can right-click the file and select Edit if you would like to preview and/or modify the contents before running this file in SQL Query Analyzer.
4. Please note the Ephesoft, Report and Report_Archive database names it has selected by default along with the SQL account and password that will be generated and modify as needed before running in SQL Query Analyzer.
5. Copy all content from the following one level up:
Copy the 6 files from \Ephesoft\Application\WEB-INF\classes\META-INF\dcma-data-access\MSSQL to \Ephesoft\Application\WEB-INF\classes\META-INF\dcma-data-access
Copy the 7 files from \Ephesoft\Application\WEB-INF\classes\META-INF\dcma-reporting\MSSQL to \Ephesoft\Application\WEB-INF\classes\META-INF\dcma-reporting
6. Modify the server.xml file found in \Ephesoft\JavaAppServer\conf to use the updated MSSQL driver and connection details. You can refer to the server.xml found in \Ephesoft\JavaAppServer\confMSSQL as reference. Look for the portion under the tag <GlobalNamingResources> and can even use this as a replacement. Please note that this file by default does not contain the SQL server name or the port, and this will need to be added. You will also need to confirm the Database names for the new Ephesoft, Report and Report_Archive databases match what you created in Steps 3-4 above.
7. Navigate to the \Ephesoft\Application\WEB-INF\classes\META-INF\dcma-workflows folder. Edit the dcma-workflows.properties file so that workflow.deploy=true and then save the file.
8. Navigate to the \Ephesoft\Application\WEB-INF\classes\META-INF\dcma-data-access folder. Edit the dcma-db.properties file so that upgradePatch.enable=true and then save the file.
8. Reset all SER files in the [Ephesoft Installation Folder]\SharedFolders\database-update by Removing the “-Executed” portion of the file.
9. Start Ephesoft and make sure all the Ephesoft tables are created with three batch classes.
10. Delete the non standard Batch class folders from SharedFolders such as BC4, BC5, etc.
11. Import the batch classes that you have exported in step #2 above.

How to Test Active Directory Using JXplorer
SEPTEMBER 18, 2014
|IN ACTIVE DIRECTORY, AUTHENTICATION
|BY PEDROCHIM
Applies to: All versions of Ephesoft Transact
If you are configuring Ephesoft Transact to use Active Directory as the authentication for users, you can test the configurations that you’ve set in the user-connectivity.properties file using JXplorer. JXplorer is included in the Ephesoft installation.
Follow the steps below to test your configuration.
1. Navigate to [Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\dcma-user-connectivity
2. Open the user-connectivity.properties file. You will need the configurations listed here for reference.
[image: Untitled picture]
Figure 1. User-connectivity.properties File
3. Navigate to [Ephesoft_Directory]\Dependencies\OpenLDAP2.4\ldap-client\jxplorer-3.2.1
4. Run the jxplorer.bat file.
5. Go to File > Connect.
[image: Untitled picture2]
Figure 2. Connection Details
6. Use the settings listed in the user-connectivity.properties file to provide the required details in the JXxplorer connection page.
· Host: This is the server hosting the Active Directory.
· Port: The port which you intend to connect to.
· Base DN: The DC aspect of the connection string to the AD server. In the example images above, this is “DC=corp,DC=ephesoft,DC=com”.
Important: There cannot be any spaces between the entries.
· 
· User DN: The full user connection string.
7. Once connected, you will see the following list which will let you see what aspects of Active Directory are viewable to the user.
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Figure 3. Active Directory List

Configuring Tomcat Memory Settings
AUGUST 29, 2014
|IN CONFIGURATION, SYSTEM
|BY LYDIAXIE
Applies to: All versions of Ephesoft Transact
Overview
This article provides information on how to update Java memory settings.
The Ephesoft Transact installer will set these values automatically during installation based on the amount of memory in your server. If you add or remove memory from your server after the installation, you may have to manually adjust the Java memory settings. These settings can also be used to fix “out of memory” errors.
Refer to your operating system below for steps.
Important: You will need administrator permissions.
Windows
To adjust Java memory settings on Windows, perform the following steps.
1. Go to [Ephesoft_Directory]\JavaAppServer\bin.
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Figure 1. Navigate to the bin Folder
2. Right-click EphesoftTransact.exe and select Run as administrator.
Note: In previous versions of Ephesoft Transact, this executable is named EphesoftEnterprise.exe
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Figure 2. Run as Administrator
This will open the Ephesoft Transact Properties file.
3. Select the Java tab.
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4. Update the memory pool settings based on your total server memory.
· 
· Initial memory pool: Must be at least 4096MB (4GB).
· Maximum memory pool: Set to half the available memory.
For example, if your server has 32GB of RAM, set the Maximum memory pool to 16,384MB (16GB).
· 
· Thread stack size: Leave this field empty.
5. Click OK.
6. Restart the Ephesoft Transact service.
You have successfully updated your Java memory settings.
Linux
To adjust Java memory settings on Linux, perform the following steps:
1. Open the setenv.sh file located at opt/[Ephesoft_Directory]/JavaAppServer/bin/setenv.sh
2. Update the memory pool settings based on your total server memory.
· 
· Initial memory pool: Must be at least 4096MB (4GB). This is controlled by the following setting:
-XX:PermSize=
· 
· Maximum memory pool: Set to half the available memory.
For example, if your server has 32GB of RAM, set the maximum memory pool to 16,384MB (16GB). This is controlled by the following setting:
-XX:MaxPermSize=
Below is a sample excerpt from the setenv.sh file:
export JAVA_OPTS='-Djava.library.path=$EPHESOFT_NATIVE -Djava.io.tmpdir=$APP_SERVER_TEMP -Ddcma.home=$DCMA_HOME -Xmx4096m -Xms4096m -XX:PermSize=4096m -XX:MaxPermSize=16384m -Duser.language=en -Duser.country=US -Dcom.sun.management.jmxremote -Dcom.sun.management.jmxremote.port=8900 -Dcom.sun.management.jmxremote.authenticate=false -Dcom.sun.management.jmxremote.ssl=false -Dcom.sun.management.jmxremote.local.only=false -XX:-UseSplitVerifier -Djava.net.preferIPv4Stack=true -Djava.awt.headless=true'
3. Save your changes and exit the editor.
4. Restart the Ephesoft Transact service with the following command:
sudo service ephesoft restart
You have successfully updated your Java memory settings.
Conclusion
This completes the overview of how to update Java memory settings on Windows and Linux.

Install and Migrate to MariaDB for Linux
Introduction
This document provides information on important changes related to MariaDB and MySQL on Linux. The following changes affect Ephesoft Transact 2019.2 or above:
· 
· The Ephesoft Transact installer no longer installs any database management systems (DBMS).
· Ephesoft Transact no longer supports MySQL databases.
Refer to Platform Configurations and Third-Party Integrations and reference your version of Ephesoft Transact to find more information on supported database versions.
Prerequisites
To perform the steps listed in this document, you will need super-user (root) permissions. If you are not a super-user, execute the following command to login as the root user:
sudo su root
Installing Ephesoft Transact
Follow these instructions if you are installing Ephesoft Transact 2019.2 or above for the first time.
Check for MariaDB
1. Check your system for an existing instance of MariaDB before installing Ephesoft Transact, as some Linux operating systems include MariaDB.
· 
· If you do not have an existing instance of MariaDB, proceed to Install MariaDB.
· If you have an existing instance of MariaDB that is supported for Ephesoft Transact 2019.2 or above, you can return to the Linux install guide for your version.
· If you have an existing instance of MariaDB that is not supported for Ephesoft Transact 2019.2 or above, you will need to uninstall your instance of MariaDB and install a supported version.
Important: This will remove all data from your database. It is recommended to take a backup of your database by running the following command:
mysqldump --all-databases --single-transaction --quick --lock-tables=false > full-backup.sql -uroot -p<password>
1. 
a. Refer to your operating system below and run the listed command.
Ubuntu:
sudo apt-get remove MariaDB-server
CentOS or RHEL:
sudo yum remove MariaDB-server
b. 
b. Proceed to Install MariaDB.
Upgrading Ephesoft Transact
Follow these instructions if you are upgrading to Ephesoft Transact 2019.2 or above. This section provides instructions on how to upgrade or migrate your database in the following cases:
· 
· Existing MariaDB
· Existing MySQL
Existing MariaDB
If you have an existing instance of MariaDB, ensure that your instance of MariaDB is a supported version before upgrading Ephesoft Transact. Refer to Platform Configurations and Third-Party Integrations and reference your version of Ephesoft Transact for more information.
· 
· If your instance of MariaDB is supported for upgrade to Ephesoft Transact 2019.2 or above, you can return to the Linux upgrade guide for your version.
· If your instance of MariaDB is not supported for upgrade to Ephesoft Transact 2019.2 or above, proceed to Upgrade MariaDB.
[bookmark: _Existing_MySQL]Existing MySQL
Follow these steps if you are currently using MySQL with Ephesoft Transact.
1. Back up the ephesoft, report, and report_archive databases from the pre-existing MySQL database.
1. 
a. Run the following command in the MariaDB installation bin folder, located in <Transact Installation Folder>/Dependencies/mariadb/bin/.
mysqldump -u<root username> -p<root user password> -h<server hostname> -P<database port number> <Database name> --single-transaction --routines --quick --lock-tables=false > <Folder location>.sql
Note: Text listed in angled brackets are placeholders. Replace the placeholders with the relevant information. For <Folder location> include the full folder path where the backup file will be created.
1. 
1. 
b. Run the mysqldump command for the ephesoft, report, and report-archive databases. Below are sample commands for each:
mysqldump -uroot -p ephesoft –-single-transaction –-routines -–quick -–locktables=false > /opt/database_backup/ephesoft.sql
mysqldump -uroot -p report –-single-transaction --routines --quick –-lock-tables=false > /opt/database_backup/report.sql
mysqldump -uroot -p report --single-transaction --routines --quick-lock-tables=false > /opt/database_backup/report_archive.sql
2. Stop and disable the service for the MySQL database to prevent it from running.
3. Install a supported version of MariaDB. You can install MariaDB on the same server where Ephesoft Transact will be installed or choose a dedicated database server. Continue to Install MariaDB to proceed.
[bookmark: _Install_MariaDB]Install MariaDB
This section provides information on how to install MariaDB on different Linux distributions: Ubuntu, CentOS, and Red Hat Enterprise Linux (RHEL). Refer to Platform Configurations and Third-Party Integrations and reference your version of Ephesoft Transact to find more information on supported operating systems.
Follow the instructions for your specific Linux distribution, and proceed with the configuration.
RHEL or CentOS
1. Run the following command to add a MariaDB yum repository to your server:
vi /etc/yum.repos.d/MariaDB.repo
2. Enter the following text in the MariaDB.repo file:
Important: CentOS is not supported for Ephesoft Transact 2020.1 or above.
On RHEL 7
[MariaDB]
name = MariaDB
baseurl = http://yum.mariadb.org/10.3/rhel7-amd64
gpgkey=http://yum.mariadb.org/RPM-GPG-KEY-MariaDB
gpgcheck=1
On CentOS 7
[MariaDB]
name = MariaDB
baseurl = http://yum.mariadb.org/10.3/centos7-amd64
gpgkey=http://yum.mariadb.org/RPM-GPG-KEY-MariaDB
gpgcheck=1
3. Run the following command to manually create the cache so that future yum queries will be quicker:
yum makecache fast
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Figure 1: Make Cache Fast
4. Once the MariaDB YUM repository has been added, you can install MariaDB with the following command:
yum install MariaDB-server MariaDB-client
5. Run the following commands to start the MariaDB service and enable it to start automatically in the future:
systemctl start mariadb
systemctl enable mariadb
[image: ]
Figure 2: Start MariaDB Service
6. Secure MariaDB by running the following command.
mysql_secure_installation
[image: ]
Figure 3: Secure Installation
This will prompt you to set the root password, disable remote root login, remove the test database and anonymous users, and reload privileges.
7. Use the table below to respond to the prompts as they are displayed.




	Prompt
	Description
	Response

	Set root password? [y/n]
	Setting the root password ensures that nobody can log into the MariaDB root user without the proper authorization.
Important: This password will be used to configure your MariaDB connection when installing or upgrading Ephesoft Transact.
	y

	Remove anonymous users? [y/n]
	By default, a MariaDB installation has an anonymous user, allowing anyone to log into MariaDB without needing a user account created for them. This is intended only for testing, and to make the installation smoother.
You should remove them before moving into a production environment.
	y

	Disallow root login remotely? [y/n]
	Normally, root should only be allowed to connect from ‘localhost’. This ensures that someone cannot guess at the root password from the network.
	y

	Remove test database and access to it? [y/n]
	By default, MariaDB comes with a database named ‘test’ that anyone can access. This is also intended only for testing, and should be removed before moving into a production environment.
	y

	Reload privilege tables now? [y/n]
	Reloading the privilege tables will ensure that all changes made so far will take effect immediately.
	y


8. Verify that a supported version of MariaDB was installed with one of the following:
· Run the following command:
mysql -v
This will return the server version as a response.
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Figure 4: Verify Version
· 
· Login to the MariaDB command shell by running following command and entering the root password:
mysql -u root -p
This will login as the root user and return the server version as a response.
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Figure 5: Root Login
9. If you are performing a fresh installation of Ephesoft Transact, you have completed the MariaDB installation. Return to the install guide for your version. Otherwise, proceed to Create a New Database to migrate an existing MariaDB environment.
Ubuntu
Note: Ubuntu is not supported for Ephesoft Transact 2020.1 or above. You must have the software-properties-common library installed prior to installing MariaDB on Ubuntu. If the library is not installed, run the following command:
sudo apt-get install software-properties-common.
1. Run the following command to install GNU Privacy Guard (GPG) to Ubuntu:
sudo apt install gnupg.
2. Run the following command to add the MariaDB GPG key:
sudo apt-key adv --recv-keys --keyserver hkp://keyserver.ubuntu.com:800xF1656F24C74CD1D8
3. Run the following command to add an APT repository to your server:
sudo add-apt-repository ‘deb [arch=amd64,arm64,i386,ppc64el] http://sfo1.mirrors.digitalocean.com/mariadb/repo/10.3/ubuntu/ xenial main’
4. Run the following commands to install a supported version of MariaDB:
sudo apt-get update
sudo apt-get install mariadb-server mariadb-client
5. When prompted, create a MariaDB root password. Keep the password in a safe location for future use.
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Figure 6: Create Password
6. Re-enter the password and select <Ok> to confirm.
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Figure 7: Confirm Password
7. Verify that a supported version of MariaDB was installed with one of the following:
· Run the following command:
select version();
This will return the server version as a response.
· 
· Login to the MariaDB command shell by running following command and entering the root password:
mysql -u root -p.
This will login as the root user and return the server version as a response.
8. If you are performing a fresh installation of Ephesoft Transact, you have completed the MariaDB installation. Return to the install guide for your version. Otherwise, proceed to Create a New Database to migrate an existing MariaDB environment..
Create a New Database
Note: Follow the steps in this section if you are migrating an existing MariaDB or MySQL environment into your new MariaDB environment.
Once you have installed MariaDB, you will need to create the following three databases for Ephesoft Transact: ephesoft, report, and report_archive.
1. Run the following commands on any MariaDB client tool, replacing the <username> with your username:
CREATE DATABASE IF NOT EXISTS ephesoft ;
CREATE DATABASE IF NOT EXISTS report ;
CREATE DATABASE IF NOT EXISTS report_archive ;
GRANT ALL PRIVILEGES ON ephesoft.* TO '<username>'@'%';
GRANT ALL PRIVILEGES ON report.* TO '<username>'@'%';
GRANT ALL PRIVILEGES ON report_archive.* TO '<username>'@'%';
GRANT ALL PRIVILEGES ON ephesoft.* TO '<username>'@'localhost';
GRANT ALL PRIVILEGES ON report.* TO '<username>'@'localhost';
GRANT ALL PRIVILEGES ON report_archive.* TO '<username>'@'localhost';
FLUSH PRIVILEGES;
Note: When the IF NOT EXISTS clause is used, MariaDB will return a warning instead of an error if the specified database already exists.
2. Update the database details in all three resource tags in the <Ephesoft Installation Folder>\JavaAppServer\conf\server.xml file. Refer to the image below for an example:
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Figure 8: Update Resource Tags
3. You have successfully installed MariaDB. Continue to Restore MySQL Backup if you previously performed a backup of your MySQL database. Otherwise, return to the Linux guide for your version of Ephesoft Transact to complete your installation or upgrade.
[bookmark: _Restore_MySQL_Backup]Restore MySQL Backup
Perform these steps if you are migrating your database from MySQL. This section outlines how to restore your ephesoft, report, and report_archive databases that you backed up in the section titled Pre-existing MySQL.
Important: Ensure that the original MySQL database is stopped and disabled, and the new MariaDB database is running.
1. Use the following command to restore each database, replacing the placeholders in the angled brackets (< >) with the relevant details:
mysql -u<root username> -p<root user password> -P<database server port> <Database name> < <Folder location>\database_backup.sql
Below is a sample to restore each database:
mysql -uroot -ppassword -P3306 ephesoft < ephesoft.sql\database_backup.sql
mysql -uroot -ppassword -P3306 report < report.sql\database_backup.sql
mysql -uroot -ppassword -P3306 report_archive < report_archive.sql\database_backup.sql
2. You have successfully restored the ephesoft, report, and report_archive databases in MariaDB. Return to the Linux guide for your version of Ephesoft Transact to complete your upgrade.
[bookmark: _Upgrade_MariaDB]Upgrade MariaDB
This section provides instructions on how to upgrade your current MariaDB instance to a supported version. Refer to Platform Configurations and Third-Party Integrations and reference your version of Ephesoft Transact to find more information on supported database versions.
Note: Ephesoft Transact 2020.1 currently supports MariaDB 10.3.x (10.3.18 tested).
1. Download a supported version of MariaDB from the MariaDB Foundation.
2. Run the following commands to stop the ephesoft and mysql services:
service ephesoft stop
service mysql stop
3. Rename the existing MariaDB folder:
mv /opt/mariadb /opt/mariadb-backup
4. Move the .tar file to the /opt folder:
mv mariadb-xx.x.xx-linux-x86_64.tar.gz /opt/
Note: xx.x.xx has been added as a placeholder. Replace with your current version of MariaDB.
5. Extract the .tar file:
tar -xvzf mariadb-xx.x.xx-linux-x86_64.tar.gz
Note: xx.x.xx has been added as a placeholder. Replace with your current version of MariaDB.
6. Rename the mariadb-xx.x.xx-linux-x86_64 folder to mariadb:
mv mariadb-xx.x.xx-linux-86_64 mariadb
Note: xx.x.xx has been added as a placeholder. Replace with your current version of MariaDB
7. Rename the my.cnf file to my.cnf.backup:
mv /etc/my.cnf /etc/my.cnf.backup
8. Remove the mysql service:
rm -rf /etc/init.d/mysqld
9. Open the mariadb folder:
cd /opt/mariadb
10. Run the mysql_install_db script:
./scripts/mysql_install_db --basedir=/opt/mariadb --datadir=/opt/mariadb/data
11. Restore the my.cnf file:
cp /opt/mariadb-backup/support-files/my.cnf /etc/
12. Restore the service:
cp /opt/mariadb-backup/support-files/mysqld /etc/init.d/
13. Remove the old links:
rm -rf /usr/bin/mysql
rm -rf /usr/bin/mysqldump
rm -rf /usr/bin/mysqladmin
14. Create new links:
ln -s /opt/mariadb/bin/mysql /usr/bin/mysql
ln -s /opt/mariadb/bin/mysqldump /usr/bin/mysqldump
ln -s /opt/mariadb/bin/mysqladmin /usr/bin/mysqladmin
15. Run the following command to add MariaDB to the list of services that will start after system reboot. This command differs based on your Linux distribution:
Ubuntu:
update-rc.d mysqld defaults
CentOS or RHEL:
chkconfig --add mysqld
16. Restore the data backups:
mv /opt/mariadb/data /opt/mariadb/data-backup
cp -r /opt/mariadb-backup/data /opt/mariadb/
rm -rf /var/lock/subsys/mysql
17. Allow permissions within the my.cnf file:
chmod -R 0777 /etc/my.cnf
18. Open the my.cnf file and insert the following comments:
#innodb_large_prefix=on
#innodb_file_format=barracuda
#innodb_file_per_table=true
19. Adjust the permissions within the my.cnf file:
chmod -R 0755 /etc/my.cnf
20. Start the database service:
service mysqld start
21. Run the upgrade:
./bin/mysql_upgrade -uroot –p<password>
The upgrade process is complete. Return to the Linux guide for your version of Ephesoft Transact to complete your installation or upgrade.
Conclusion
You have successfully configured MariaDB for Ephesoft Transact.


PKI Authentication for Windows
Introduction
This page describes how to configure PKI (Public Key Infrastructure) authentication as the authentication type when installing Ephesoft Transact for Windows. You can select the PKI authentication type and import your PIV/CAC certificates during installation. All provided data will be saved, updated, and mapped automatically in the following files:
· server.xml located in<Ephesoft_Directory>\JavaAppServer\conf
· web.xml located in <Ephesoft_Directory>\JavaAppServer\conf
· dcma-user.connectivity.properties located in <Ephesoft_Directory>\Application\WEB-INF\classes\META-INF\dcma-user-connectivity
· dcma-batch.properties located in <Ephesoft_Directory>\Application\WEB-INF\classes\META-INF\dcma-batch
· config.properties (included in Ephesoft Transact installation package)
The imported certificates will be stored in the Certs folder of the Ephesoft Transact installation directory.
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Figure 1. Certs Folder in /opt/Ephesoft
The Ephesoft Transact installer also provides an option to select a PKI-config.properties file to automatically fill the required fields for PIV/CAC configuration. You can provide PIV/CAC details in the properties file and then simply specify the file location during the Ephesoft Transact installation.
Note: The Ephesoft Transact Installer is shipped as a zip file. To install the application, unzip the file and run the installer.
Prerequisites
There are no prerequisites for this document.
Configure PKI Authentication
This section provides information on how to configure PKI authentication with two methods:
1. Using the Windows Install Wizard (Normal installation)
2. Using the config.properties File (Silent installation)
[bookmark: _Using_Windows_Install]Using Windows Install Wizard
Follow the steps below to configure PKI authentication when using the Windows Install Wizard to install Ephesoft Transact.
Note: Follow these instructions when running a normal installation of Ephesoft Transact.
1. Start the installation process by running the Ephesoft Transact Install Wizard.
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Figure 2. Ephesoft Transact Install Wizard
2. Follow the installation process up to the Authentication Mode step.
[image: A close-up of a white background

Description automatically generated]
Figure 3. Authentication Mode
3. Select PKI Authentication to import your PIV/CAC certificates.
[image: ]
Figure 4. Select PKI Authentication
The following PKI authentication options are available:
· Provide the path to the file with PIV/CAC configurations.
· Refer to configuring PKI authentication Using the config.properties File to continue with this option.
· Enter all required PIV/CAC authentication details using the Setup Wizard.
· Click Next without attaching any files.
Certificate Details for PKI
4. Provide the certificate details and click Next to continue. Refer to the table below for more information on configurable properties.
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Figure 5. Certificate Details for PKI
	Configurable Property
	Description

	Server Cert
	The certificate that will be used to recognize your server.

	Password
	Password for Server Certificate.

	CA Cert
	The certificate that will be used to recognize the certification authority.

	Password
	Password for CA Certificate.

	Alias Name
	The name of your server certificate as specified in the Trusted Root Certification Authorities folder of the Windows Certificate Manager.


Realm Settings for PKI
5. In the Realm Settings for PKI section, provide the details about the realm you have configured for using PKI authentication. Hover over the text field to get more information on each parameter.
6. Click Next to continue.
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Figure 6. 2020.1 Realm Settings for PKI
	Configurable Property
	Description

	Connection URL
	A valid URL to connect to LDAP /Active Directory server. The connection URL should be in the following format: ldap://<server_address>:<port_number>.

	Connection Name
	A valid username to connect and access the LDAP/Active Directory server (the username of the user responsible for interacting with the server).

	Connection Password
	A valid password to connect and access the LDAP/Active Directory server (the password of the user responsible for interacting with the server).

	User Base
	The relative path under which all the users’ information will be located. This attribute defines where to look for a user.

	User Search
	A search string for searching users.

	Role Base
	The relative path under which all the roles information will be located. This attribute defines where to look for a role corresponding to a user.

	Role Name
	Role name defines which attribute is used for a role.

	Role Search
	A search string for searching users.

	User Subtree
	This attribute defines the search scope. Set to true to search the entire subtree rooted at the user base entry. Set to false to request a single-level search including only the top level.

	Role Subtree
	This attribute defines the search scope. Set to true to search the entire subtree rooted at the Role base entry. Set to false to request a single-level search including only the top level.

	2019.1 and Above

	X509 Auth Parameter
	One of the username retriever parameters from the certificate. The available options are:
· CN
· PRINCIPALNAME
· REGISTEREDID
· RFC822NAME


Connector Settings for PKI
7. Fill in the Connector Settings for PKI section.
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Figure 7. Connector Settings for PKI
	Configurable Property
	Description

	Port
	The number of the PKI Connector Port.

	SSL protocol
	The protocol that will be used to secure a connection between the client and the server.

	SSL Enable Protocol
	The supported versions of the selected protocol.

	Ciphers text
	The algorithm of encryption that will be used between the client and the server.


8. Click Next to continue.
User Connectivity Settings
LDAP
For LDAP, configure the following details. You can hover over the text field on the UI to view a tooltip for each parameter.
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Figure 8. LDAP User Connectivity Settings
	Configurable Property
	Description

	Connectivity URL
	A valid URL to connect to the LDAP server. The connection URL should be in the following format: ldap://<server_address>:<port_number>.

	Domain Name
	The domain component name for the LDAP configuration.

	Domain Organization
	The domain component organization name for the LDAP configuration

	User Name
	A valid username to connect and access the LDAP server (the username of the user responsible for interacting with the server.

	Password
	A valid password to connect and access the LDAP server (the password of the user responsible for interacting with the server).

	Group Search Filter
	A search string for searching groups.

	User Search Filter
	A search string for searching users.

	LDAP User Base
	The relative path under which all the users’ information will be located. This attribute defines where to look for a user.

	LDAP Group Base
	The relative path under which all the groups/roles information will be located. This path will be relative to the domain components specified by the user.


Microsoft Active Directory (MSAD)
For MSAD, configure the following details. You can hover over the text field on the UI to view a tooltip for each parameter.
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Figure 9. MSAD User Connectivity Settings
	Configurable Property
	Description

	Connectivity URL
	A valid URL to connect to the LDAP server. The connection URL should be in the following format: ldap://<server_address>:<port_number>.

	Domain Name
	The domain component name for the LDAP configuration.

	Domain Organization
	The domain component organization name for the LDAP configuration

	User Name
	A valid username to connect and access the LDAP server (the username of the user responsible for interacting with the server.

	Password
	A valid password to connect and access the LDAP server (the password of the user responsible for interacting with the server).

	Group Search Filter
	A search string for searching groups.

	User Search Filter
	A search string for searching users.

	AD Context Path
	The directory where the intended user resides. This parameter is optional and can be left empty.

	AD Group Search Filter
	This attribute helps to filter search results and can have the following operators: |(OR), &(AND) and !(NOT). For example, ((!(cn=a*))(|cn=a*))(|(cn=ephesoft*)(&(cn=b*)))
This parameter is optional and can be left empty.


You have successfully configured PKI authentication using the Windows Install Wizard.
[bookmark: _Using_the_config.properties]Using the config.properties File
Follow the steps below to configure PKI authentication using the config.properties file.
Note: Follow these instructions when running a silent installation of Ephesoft Transact.
1. Open the config.properties file included in the Ephesoft Transact installer.
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Figure 10. config.properties File
Note: You can either provide the details in the config.properties file or copy the PIV/CAC configuration section and save it in a separate configurations file. For example, create a PKI-config.properties file.
2. Refer to the tables below to configure the details required to import PIV/CAC certificates during installation.
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Figure 11. PIV/CAC Details
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Figure 12. PIV/CAC Details cont.
Note: Connectivity details are only needed for LDAP or MSAD. Apache Tomcat does not require connection configuration.
Authentication Mode Configuration
	Configurable Property
	Description

	pivcac_selected_mode
	The type of authentication mode you want to use.
· 0 for Form Authentication
· 1 for PKI Authentication


PIV/CAC Certificates Details
	Configurable Property
	Description

	pivcac_server_cert_path
	The certificate that will be used to recognize your server.

	pivcac_server_cert_password
	Password for the server certificate.

	pivcac_ca_cert_path
	The certificate that will be used to recognize the certification authority.

	pivcac_ca_cert_password
	Password for the CA certificate.


PIV/CAC Realm Configuration
	Configurable Property
	Description

	pivcac_realm_connection_url
	A valid URL to connect to LDAP/Active Directory server. The connection URL should be in the following format: ldap://<server_address>:<port_number>.

	pivcac_realm_connection_name
	A valid username to connect and access the LDAP/Active Directory server (the username of the user responsible for interacting with the server).

	pivcac_realm_connection_password
	A valid password to connect and access the LDAP/Active Directory server (the password of the user responsible for interacting with the server).

	pivcac_realm_user_base
	The relative path under which all the users’ information will be located. This attribute defines where to look for a user.

	pivcac_realm_user_search
	A search string for searching users.

	pivcac_realm_role_base
	The relative path under which all the roles information will be located. This attribute defines where to look for a role corresponding to a user.

	pivcac_realm_role_name
	Role name defines which attribute is used for a role.

	pivcac_realm_role_search
	A search string for searching roles.

	pivcac_realm_userSubtree
	This attribute defines the search scope. Set to true to search the entire subtree rooted at the user base entry. Set to false to request a single-level search including only the top level.

	pivcac_realm_roleSubtree
	This attribute defines the search scope. Set to true to search the entire subtree rooted at the Role base entry. Set to false to request a single-level search including only the top level.

	2020.1 and Above

	X509UsernameRetrieverParameter
	One of the username retriever parameters from the certificate. The available options are:
· CN
· PRINCIPALNAME
· REGISTEREDID
· RFC822NAME


Connector Settings for PIV/CAC Configuration
	Configurable Property
	Description

	pivcac_Connector_port
	The number of the PKI Connector port.

	pivcac_Connector_client_auth
	True if the client certificate is used for authentication, otherwise false. If a server is enabled with client certificate authentication, only users who attempt to connect from clients loaded with the right client certificates will succeed. Even if a legitimate user attempts to connect with the right username and password but is not using a client application loaded with the right client certificate, that user will not be granted access.

	pivcac_Connector_compression
	True if the compression algorithm is used to compress the data, otherwise false.

	pivcac_Connector_ssl_enabled
	True if the SSL protocol is used to encrypt the connection between the client and the server. False if the connection is not encrypted.

	pivcac_Connector_secure
	True if communication between the client and the server is secure, otherwise false.

	pivcac_Connector_ssl_protocol
	The protocol that will be used to secure a connection between the client and the server.

	pivcac_Connector_trust_store_file_path
	Location of the truststore file (cacert.jks).

	pivcac_Connector_trust_store_password
	Password for the truststore file (cacert.jks).

	pivcac_Connector_key_store_file_path
	Location of the keystore file (servercert.jks).

	pivcac_Connector_key_store_password
	Password for the keystore file (servercert.jks).

	pivcac_Connector_ssl_enabled_protocol
	The supported versions of the selected protocol.

	pivcac_Connector_ciphers_text
	The algorithm of encryption that will be used between the client and the server.


Connectivity User Configuration
	Configurable Property
	Description

	connectivity_user_connection
	The type of connection you want to use for the application.
· 0 for LDAP
· 1 for MSAD
· 2 for Tomcat

	connectivity_url
	A valid URL to connect to LDAP /Active Directory server. The connection URL should be in the following format: ldap://<server_address>:<port_number>

	connectivity_domain_name
	The domain component name for the LDAP/AD configuration.

	connectivity_domain_org
	The domain component organization name for the LDAP/AD configuration.

	connectivity_user_name
	A valid username to connect and access the LDAP/Active Directory server (the username of the user responsible for interacting with the server).

	connectivity_user_password
	A valid password to connect and access the LDAP/Active Directory server (the password of the user responsible for interacting with the server).

	connectivity_group_search_attribute_filter
	A search string for searching groups.

	connectivity_user_search_attribute_filter
	A search string for searching users.

	connectivity_ldap_user_base
	The relative path under which all the users’ information will be located. This attribute defines where to look for a user.

	connectivity_ldap_group_base
	The relative path under which all the groups/roles information will be located. This path will be relative to the domain components specified by the user.

	Microsoft Active Directory only

	connectivity_msad_context_path
	The directory path where the intended user resides. This parameter is optional and can be left empty.

	connectivity_msad_group_search_filter
	This attribute helps to filter search results and can have the following operators: |(OR), &(AND) and !(NOT).
For example, ((!(cn=a*))(|(cn=ephesoft*)(&(cn=b*)))
This parameter is optional and can be left empty.


3. Start the Ephesoft Transact installer. In the Authentication Mode screen, select PKI Authentication. Click Browse and select the file where you configured the PIV/CAC settings.
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Figure 13. Select the PKI Property File
4. Click Next. The installer will pick up information from the file and all fields relating to PIV/CAC configuration will be automatically populated.
Conclusion
You have successfully configured PKI authentication for Windows. Return to the install guide for your version and proceed with the installation process.

Form Authentication and HTTPS Support
What’s New In Transact 4.5?

Ephesoft Transact v.4.5.0.0 installer has been enhanced to support Form Authentication both for HTTP and HTTPS protocols. Now, the application can be set up to authenticate users on the basis of data provided during the installation itself. If you are installing Ephesoft Transact on a secure server, you can also specify SSL Certificate details. All provided data will be saved/updated/mapped automatically in the following files:
· server.xml (<Ephesoft Installation Directory>JavaAppServerconf)
· web.xml (<Ephesoft Installation Directory>JavaAppServerconf)
· dcma-user.connectivity.properties (<Ephesoft Installation Directory>ApplicationWEB-INFclassesMETA-INFdcma-user-connectivity)
· dcma-batch.properties (<Ephesoft Installation Directory>ApplicationWEB-INFclassesMETA-INFdcma-batch)
· config.properties (included in Ephesoft Transact installation package)
If you are installing Ephesoft Transact with HTTPS protocol, the keystore file with SSL certificate details will be copied to the Certs folder of Ephesoft Installation Directory.
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Windows Installer:
1. Form Authentication with HTTP
2. Form Authentication with HTTPS
3. Form Authentication for silent Installation
Linux Installer:
1. Form Authentication with HTTP
2. Form Authentication with HTTPS
3. Form Authentication for silent Installation
 
[bookmark: _To_use_Form]To use Form Authentication with HTTP during installation of Ephesoft Transact on Windows:
1. Start the installation process by running the Ephesoft 4.5.0.0 Windows Installer.
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2. Follow the installation process till you reach the Authentication Mode step.
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3. Select Standard Form Authentication and HTTP communication protocol, and click Next.
4. Select the Connection Type and configure connectivity details. There are three available connection types: LDAP, MS Active Directory and Tomcat.
· Tomcat is selected by default and does not require any configurations.
[image: ]
 
· For LDAP, configure the following details. You can hover over the text field to get more information on each parameter.
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	Configurable property
	Description

	Connectivity URL
	A valid URL to connect to LDAP server. The connection URL should be in the following format: ldap://<server_address>:<port_number>.

	Domain Name
	The domain component name for the LDAP configuration.

	Domain Organization
	The domain component organization name for the LDAP configuration.

	User Name
	A valid username to connect and access LDAP server (the username of the user responsible for interacting with the server).

	Password
	A valid password to connect and access LDAP server (the password of the user responsible for interacting with the server).

	Group Search Filter
	A search string for searching groups.

	User Search Filter
	A search string for searching users.

	Ldap User Base
	The relative path under which all the users’ information will be located. This attribute defines where to look for a user.

	Ldap Group Base
	The relative path under which all the groups/roles information will be located. This path will be relative to the domain components specified by the user.


 
· For Active Directory, configure the following details. You can hover over the text field to get more information on each parameter.
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	Configurable property
	Description

	Connectivity URL
	A valid URL to connect to LDAP server. The connection URL should be in the following format: ldap://<server_address>:<port_number>.

	Domain Name
	The domain component name for the LDAP configuration.

	Domain Organization
	The domain component organization name for the LDAP configuration.

	User Name
	A valid username to connect and access LDAP server (the username of the user responsible for interacting with the server).

	Password
	A valid password to connect and access LDAP server (the password of the user responsible for interacting with the server).

	Group Search Filter
	A search string for searching groups.

	User Search Filter
	A search string for searching users.

	AD Context Path
	The directory path where the intended user resides. This parameter is optional and can be left empty.

	AD Group Search Filter
	This attribute helps to filter search results and can have the following operators: |(OR), &(AND) and !(NOT). For example, ((!(cn=a*))(|(cn=ephesoft*)(&(cn=b*)))
This parameter is optional and can be left empty.


 
Click Next to continue.
5. Configure Realm Settings for HTTP, and click Next to continue.
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	Configurable property
	Description

	Connection URL
	A valid URL to connect to LDAP /Active Directory server. The connection URL should be in the following format: ldap://<server_address>:<port_number>.

	Connection Name
	A valid username to connect and access LDAP /Active Directory server (the username of the user responsible for interacting with the server).

	Connection Password
	A valid password to connect and access LDAP/ Active Directory server (the password of the user responsible for interacting with the server).

	User Base
	The relative path under which all the users’ information will be located. This attribute defines where to look for a user.

	User Search
	A search string for searching users.

	Role Base
	The relative path under which all the roles information will be located. This attribute defines where to look for a role corresponding to a user.

	Role Name
	Role name defines which attribute is used for a role.

	Role Search
	A search string for searching roles.


 
This completes the process of configuring Form Authentication with HTTP server.
6. Proceed with the installation process.
 
[bookmark: _To_use_Form_1]To use Form Authentication with HTTPS during installation of Ephesoft Transact on Windows:
1. Start the installation process by running the Ephesoft 4.5.0.0 Windows Installer.
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2. Follow the installation process till you reach the Authentication Mode step.
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3. Select Standard Form Authentication and HTTPS communication protocol, and click Next.
4. Now, provide the path and the password for the keystore file containing SSL certificate details, and specify the port on which you will run the application. Click Next to continue.
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5. Select the Connection Type and configure connectivity details. There are three available connection types: LDAP, MS Active Directory and Tomcat.
· Tomcat is selected by default and does not require any configurations.
[image: ]
 
· For LDAP, configure the following details. You can hover over the text field to get more information on each parameter.
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	Configurable property
	Description

	Connectivity URL
	A valid URL to connect to LDAP server. The connection URL should be in the following format: ldap://<server_address>:<port_number>.

	Domain Name
	The domain component name for the LDAP configuration.

	Domain Organization
	The domain component organization name for the LDAP configuration.

	User Name
	A valid username to connect and access LDAP server (the username of the user responsible for interacting with the server).

	Password
	A valid password to connect and access LDAP server (the password of the user responsible for interacting with the server).

	Group Search Filter
	A search string for searching groups.

	User Search Filter
	A search string for searching users.

	Ldap User Base
	The relative path under which all the users’ information will be located. This attribute defines where to look for a user.

	Ldap Group Base
	The relative path under which all the groups/roles information will be located. This path will be relative to the domain components specified by the user.


 
· For Active Directory, configure the following details. You can hover over the text field to get more information on each parameter.
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	Configurable property
	Description

	Connectivity URL
	A valid URL to connect to LDAP server. The connection URL should be in the following format: ldap://<server_address>:<port_number>.

	Domain Name
	The domain component name for the LDAP configuration.

	Domain Organization
	The domain component organization name for the LDAP configuration.

	User Name
	A valid username to connect and access LDAP server (the username of the user responsible for interacting with the server).

	Password
	A valid password to connect and access LDAP server (the password of the user responsible for interacting with the server).

	Group Search Filter
	A search string for searching groups.

	User Search Filter
	A search string for searching users.

	AD Context Path
	The directory path where the intended user resides. This parameter is optional and can be left empty.

	AD Group Search Filter
	This attribute helps to filter search results and can have the following operators: |(OR), &(AND) and !(NOT). For example, ((!(cn=a*))(|(cn=ephesoft*)(&(cn=b*)))
This parameter is optional and can be left empty.


 
This completes the process of configuring Form Authentication with HTTPS server.
6. Proceed with the installation process.
 
[bookmark: _To_configure_Form]To configure Form Authentication for the silent installation of Ephesoft Transact on Windows:
1. Open the config.properties file shipped along with the installer.
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2. Configure the below-mentioned parameters.
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Note: Connectivity details must be provided only for LDAP or MS Active Directory. Tomcat does not require connection configuration.
	Configurable property
	Description

	pivcac_selected_mode
	The type of authentication mode you want to use.
· 0 for Form Authentication
· 1 for PKI Authentication

	form_authentication_http_or_https
	The communication protocol, which will be used for Form Authentication.
· 0 for HTTP
· 1 for HTTPS

	form_authentication_keystore_file_path
	The path to the keystore certificate with SSL information.
Required only if HTTPS is selected.

	form_authentication_keystore_password
	The password for the keystore certificate with SSL information.
Required only if HTTPS is selected.

	pivcac_realm_connection_url
	A valid URL to connect to LDAP /Active Directory server. The connection URL should be in the following format: ldap://<server_address>:<port_number>.

	pivcac_realm_connection_name
	A valid username to connect and access LDAP /Active Directory server (the username of the user responsible for interacting with the server).

	pivcac_realm_connection_password
	A valid password to connect and access LDAP/ Active Directory server (the password of the user responsible for interacting with the server).

	pivcac_realm_user_base
	The relative path under which all the users’ information will be located. This attribute defines where to look for a user.

	pivcac_realm_user_search
	A search string for searching users.

	pivcac_realm_role_base
	The relative path under which all the roles information will be located. This attribute defines where to look for a role corresponding to a user.

	pivcac_realm_role_name
	Role name defines which attribute is used for a role.

	pivcac_realm_role_search
	A search string for searching roles.

	pivcac_realm_userSubtree
	This attribute defines the search scope. Set to true to search the entire subtree rooted at the User base entry. Set to false to request a single-level search including only the top level.

	pivcac_realm_roleSubtree
	This attribute defines the search scope. Set to true to search the entire subtree rooted at the Role base entry. Set to false to request a single-level search including only the top level.

	connectivity_user_connection
	The type of connection you want to use for the application.
· 0 for LDAP
· 1 for MS Active Directory
· 2 for Tomcat

	connectivity_url
	A valid URL to connect to LDAP server. The connection URL should be in the following format: ldap://<server_address>:<port_number>.

	connectivity_domain_name
	The domain component name for the LDAP configuration.

	connectivity_domain_org
	The domain component organization name for the LDAP configuration.

	connectivity_user_name
	A valid username to connect and access LDAP server (the username of the user responsible for interacting with the server).

	connectivity_user_password
	A valid password to connect and access LDAP server (the password of the user responsible for interacting with the server).

	connectivity_group_search_attribute_filter
	A search string for searching groups.

	connectivity_user_search_attribute_filter
	A search string for searching users.

	connectivity_ldap_user_base
	The relative path under which all the users’ information will be located. This attribute defines where to look for a user.

	connectivity_ldap_group_base
	The relative path under which all the groups/roles information will be located. This path will be relative to the domain components specified by the user.

	connectivity_msad_context_path
	The directory path where the intended user resides. This parameter is optional and can be left empty.

	connectivity_msad_group_search_filter
	This attribute helps to filter search results and can have the following operators: |(OR), &(AND) and !(NOT). For example, ((!(cn=a*))(|(cn=ephesoft*)(&(cn=b*)))
This parameter is optional and can be left empty.


 
3. Save the changes.
 
[bookmark: _To_use_Form_2]To use Form Authentication with HTTP during installation of Ephesoft Transact on Linux:
1. Start the installation process by executing the installer. When offered to install the system using silent installer, select n.
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2. Follow the installation process till you reach Authentication Configuration section.
[image: ]
3. Enter 1 to select the Standard Form Authentication Mode.
Note:
· When Form Authentication is selected, the users will be required to provide a username and password to log on to the application. This Authentication Mode is used by default.
· PKI Authentication (Public Key Identification) option is provided if you want to use PIV cards and related certificates.
4. Select the Application Protocol you want to use. Available options:
· HTTP
· HTTPS
Let’s go ahead and select the first option.
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5. Specify the port on which you will be using your application.
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6. Fill the User Connectivity Settings section. In this case, we select 2 – MS Active Directory.
Note: Connection details must be provided only for LDAP or MS Active Directory. Tomcat does not require connection configuration.
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· Connection configuration
	Configurable property
	Description

	User Connection Type
	The type of connection you want to use for the application.
· 1 for LDAP
· 2 for MS Active Directory
· 3 for Tomcat


 
· Configurable properties common for both LDAP & MS Active Directory
	Configurable property
	Description

	Connection URL
	A valid URL to connect to LDAP /Active Directory server. The connection URL should be in the following format: ldap://<server_address>:<port_number>.

	Connection Name
	A valid username to connect and access LDAP /Active Directory server (the username of the user responsible for interacting with the server).

	Connection Password
	A valid password to connect and access LDAP/ Active Directory server (the password of the user responsible for interacting with the server).

	User base
	The relative path under which all the users’ information will be located. This attribute defines where to look for a user.

	User search
	A search string for searching users.

	User subtree
	This attribute defines the search scope. Set to true to search the entire subtree rooted at the User base entry. Set to false to request a single-level search including only the top level.

	Role base
	The relative path under which all the roles information will be located. This attribute defines where to look for a role corresponding to a user.

	Role name
	Role name defines which attribute is used for a role.

	Role search
	A search string for searching roles.

	Role subtree
	This attribute defines the search scope. Set to true to search the entire subtree rooted at the Role base entry. Set to false to request a single-level search including only the top level.


 
· Properties specific to MS-Active Directory configuration
	Configurable property
	Description

	MS AD Group Search Filter
	This attribute helps to filter search results and can have the following operators: |(OR), &(AND) and !(NOT). For example, ((!(cn=a*))(|(cn=ephesoft*)(&(cn=b*)))
This parameter is optional and can be left empty.


 
7. Confirm that provided details are correct by entering n. If you want to update the details, press y and change the information as needed.
Once the connectivity information is confirmed, realm settings will be updated automatically and authentication configuration will be successfully completed.
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8. Proceed with the installation process.
 
[bookmark: _To_use_Form_3]To use Form Authentication with HTTPS during installation of Ephesoft Transact on Linux:
1. Start the installation process by executing the installer. When offered to install the system using silent installer, select n.
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2. Follow the installation process till you reach Authentication Configuration section.
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3. Enter 1 to select the Standard Form Authentication Mode.
Note:
· When Form Authentication is selected, the users will be required to provide a username and password to log on to the application. This Authentication Mode is used by default.
· PKI Authentication (Public Key Identification) option is provided if you want to use PIV cards and related certificates.
4. Select the Application Protocol you want to use. Available options:
· HTTP
· HTTPS
Let’s go ahead and select the second option.
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5. Provide details for SSL certificate.
· Specify the location of the keystore file.
· Provide and confirm the password for the keystore file.
[image: A black screen with white text
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6. Confirm that provided details are correct by entering n. If you want to update the details, press y and change the information as needed.
[image: ]
7. Specify the port on which you will be using your application.
[image: ]
8. Fill the User Connectivity Settings section. In this case, we select 2 – MS Active Directory.
Note: Connection details must be provided only for LDAP or MS Active Directory. Tomcat does not require connection configuration.
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· Connection configuration
	Configurable property
	Description

	User Connection Type
	The type of connection you want to use for the application.
· 1 for LDAP
· 2 for MS Active Directory
· 3 for Tomcat


 
· Configurable properties common for both LDAP & MS Active Directory
	Configurable property
	Description

	Connection URL
	A valid URL to connect to LDAP /Active Directory server. The connection URL should be in the following format: ldap://<server_address>:<port_number>.

	Connection Name
	A valid username to connect and access LDAP /Active Directory server (the username of the user responsible for interacting with the server).

	Connection Password
	A valid password to connect and access LDAP/ Active Directory server (the password of the user responsible for interacting with the server).

	User base
	The relative path under which all the users’ information will be located. This attribute defines where to look for a user.

	User search
	A search string for searching users.

	User subtree
	This attribute defines the search scope. Set to true to search the entire subtree rooted at the User base entry. Set to false to request a single-level search including only the top level.

	Role base
	The relative path under which all the roles information will be located. This attribute defines where to look for a role corresponding to a user.

	Role name
	Role name defines which attribute is used for a role.

	Role search
	A search string for searching roles.

	Role subtree
	This attribute defines the search scope. Set to true to search the entire subtree rooted at the Role base entry. Set to false to request a single-level search including only the top level.


 
· Properties specific to MS-Active Directory configuration
	Configurable property
	Description

	MS AD Group Search Filter
	This attribute helps to filter search results and can have the following operators: |(OR), &(AND) and !(NOT). For example, ((!(cn=a*))(|(cn=ephesoft*)(&(cn=b*)))
This parameter is optional and can be left empty.


 
9. Confirm that provided details are correct by entering n. If you want to update the details, press y and change the information as needed.
Once the connectivity information is confirmed, realm settings will be updated automatically and authentication configuration will be successfully completed.
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10. Proceed with the installation process.
 
[bookmark: _To_configure_Form_1]To configure Form Authentication for the silent installation of Ephesoft Transact on Linux:
1. Open the config.properties file shipped along with the installer.
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2. Configure the below-mentioned parameters.
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Note: Connection details must be provided only for LDAP or MS Active Directory. Tomcat does not require connection configuration.
	Configurable property
	Description

	Input_authentication_mode
	The type of authentication mode you want to use.
· 1 for Form Authentication
· 2 for PKI Authentication

	Input_application_communication_protocol
	The communication protocol, which will be used for Form Authentication.
· 1 for HTTP
· 2 for HTTPS

	input_form_https_keystore_cert_path
	The path to the keystore certificate with SSL information.
Required only if HTTPS is selected.

	input_form_https_keystore_cert_password
	The password for the keystore certificate with SSL information.
Required only if HTTPS is selected.

	input_connectivity_user_connection
	The type of connection you want to use for the application.
· 1 for LDAP
· 2 for MS Active Directory
· 3 for Tomcat

	input_realm_connection_url
	A valid URL to connect to LDAP /Active Directory server. The connection URL should be in the following format: ldap://<server_address>:<port_number>.

	input_realm_connection_name
	A valid username to connect and access LDAP /Active Directory server (the username of the user responsible for interacting with the server).

	input_realm_user_password
	A valid password to connect and access LDAP/ Active Directory server (the password of the user responsible for interacting with the server).

	input_realm_user_base
	The relative path under which all the users’ information will be located. This attribute defines where to look for a user.

	input_realm_user_search
	A search string for searching users.

	input_realm_user_sub_tree
	This attribute defines the search scope. Set to true to search the entire subtree rooted at the User base entry. Set to false to request a single-level search including only the top level.

	input_realm_role_base
	The relative path under which all the roles information will be located. This attribute defines where to look for a role corresponding to a user.

	input_realm_role_name
	Role name defines which attribute is used for a role.

	input_realm_role_search
	A search string for searching roles.

	input_realm_role_sub_tree
	This attribute defines the search scope. Set to true to search the entire subtree rooted at the Role base entry. Set to false to request a single-level search including only the top level.


 
3. Save the changes.

Scripting Guide
Scripting functionality in Ephesoft is supported where a custom requirement can be handled. Ephesoft includes power to perform custom functionality during different stages of batch processing. This functionality is supported through the scripts present inside the batch class folder in Scripts folder. These scripts are Java scripts which access batch.xml through two techniques: DOM Parser and JDOM Parser. All the scripts present should be developed using one of the earlier mentioned parser only.
Batch Instance Group Feature
This feature is used to provide the roles on the batch instance. If user role have an access to batch instance using batch instance group feature than that batch will display on the BatchList screen. User will able to review/validate the same batch instance.
For this feature we are introducing the new database table “batch_instance_groups” for storing the batch instance identifier and user roles. This table stores all the mapped user roles with the batch instances.
Database Structure:
Method for assigning roles in batch instance group table:
public void assignedBatchInstanceGroup(String batchInstanceIdentifier, String userRole) throws DCMAException
Configurable parameters:
Example file: ScriptDocumentAssembler_BatchInstanceGroupFeature.java
Force Review Feature
The following is the implementation of the ForceReview feature:
1. A new tag is added to the batch.xml for any document level field by the name ForceReview. Assumption: This “ForceReview“ tag will come into play only if the document containing it is invalid.
2. This tag is not mandatory. If it does not exist(or the value of it is not “true”) for a document level field, the functionality will work as earlier.
3. When this batch opens on the RV Screen, and this tag is found with a value “true” (for an invalid document):
1. Before the user saves the document once(by pressing CTRL+s/S or CTRL+q/Q) this field will appear RED(irrespective of REGEX validation).
2. Once the user presses CTRL+s/S or CTRL+q/Q on a certain field, we will make the value of the tag forceReview “False” for that field and the field will now get validated according to the earlier functionality (REGEX validation).
It is expected that it will be the responsibility of the script to handle the setting of the ForceReview tag in sync with the document validity setting.
The ForceReview tag of a field will not make a document invalid. It will only prevent a document level field from getting validated(in a document in an invalid state) if set to true.
This ForceReview tag won’t exist by default(before validation).
Provided is a sample script for the generation of this ForceReview tag(or modifying it if it is already present) with a value “true” for every alternate(note the i+=2 in the script) document level field encountered in a batch.xml.
Example file: Force_Review_Feature_SampleScript.java
ScriptAddNewTable.java
The Add New Table script is useful for being able to generate a predefined table on the fly in the Validation view.
Example Scenario:
If you are processing invoice documents and have defined table extraction during the normal means, it is still possible that if the document is of poor image quality the table you have defined for extraction may not be detected, or may be incomplete. In this case, you can use the Add New Table script to automatically generate a table for your invoice document type with the click of a button. You could create a new empty table of your required structure, or even a populated one… using other extracted values from the documents fields to populate the table values from a database table.
Example file: ScriptAddNewTable.java
ScriptAutomaticValidation.java
The Automatic Validation script is executed in the Ephesoft Batch Class workflow prior to reaching the Validation stage. This is the opportune time to implement any custom logic you may require by running verification against the values that have been extracted for the fields defined.
Example Scenario:
You may wish to retrieve the extracted value from one field, perhaps a Social Security Number, and use it to perform a look-up operation to an external database, retrieving an associated name. You could then in turn us the results of these SQL query to populate the values of other document level fields defined in Ephesoft.
Example location: {Ephesoft_install_directory}SharedFoldersBC1scripts
Example file: ScriptAutomaticValidation.java
ScriptDocumentAssembler.java
The Document Assembler script is executed in the Ephesoft Batch Class work flow following the Page Processing Module, and Prior to reaching the Document Review stage. At this point the batch .xml has undergone Ephesoft’s classification routines and the batch’s contents are structured into documents, with confidence scores assigned. However, perhaps you have a unique situation where the default Ephesoft classification behavior alone will not organize your batch’s documents as your require. This script is the ideal location to implement any logic to customize the classification organization of your batch. Although Document Level Fields are not yet present in the batch .xml at this point, page level fields are making Script
Example Scenario:
You may be using cover sheets to aid in the classification accuracy for your documents. However by the time the work flow reaches the ScriptDocumentAssembler Ephesoft’s classification routines have already worked their magic and you may no longer have any use for the cover sheets. You can use this script to define some logic to remove the first page of every document, which in this case would be the cover sheets.
We’ve provided as an example resource, a script that does exactly this: ScriptDocumentAssembler_remove-1st-page.java
ScriptExport.java
The Export script is executed in the Ephesoft Batch Class work flow during the processing of the Export Module. At this point all of Ephesoft’s separation, classification, extraction, and validation have been performed and the batch is in the process of leaving the Ephesoft system. Consequently, ScriptExport.java is the ideal place to implement logic facilitating custom export requirements.
Example Scenario #1: As a batch is leaving the Ephesoft system, you may intend to import its .xml and image files into a document repository system. Your targeted system may have its own internal XML schema for describing its contents, and to make the transition a seamless one you want to consider applying an XSLT translation to the Ephesoft batch .xml so that it can be automatically imported and recognized by its destination system without manual effort.
Example Scenario #2: Perhaps you have a specific document management system such as FileBound in mind. FileBound uses Divider and Separator values to index its contents. Ephesoft provides a FileBound Plugin in the Export Module. However, in addition to this you can implement logic in the ScriptExport.java file to populate the batch documents’ divider and separator fields based on a captured extraction value, barcode, or other means. Through Ephesoft scripting you could use an extracted barcode value as a look up key in a SQL query to an external database table to retrieve the appropriate divider and separator values for a given document type.
Example location: {Ephesoft_install_directory}SharedFoldersBC1scripts
Example file: ScriptExport.java
ScriptExtraction.java
The Extraction script, although similar in sequence position to the ScriptAutomaticValidation.java, is useful for the purpose of separating extraction from validation.
Example Scenario:
Assume you have some OMR field extraction defined to extract check boxes denoting credit card type. For example there could three boxes total, signifying a choice of visa, american express, or mastercard. If filled out correctly the form should only have a check mark in one of the boxes. RecoStar OMR extraction will represent these three check boxes as a three character string of binary values, with the box containing a mark being represented by a “1” value (the others, “0”). Your Extraction script function could analyze the binary values to determine which of the three credit card vendors is being represented and set a document level field value to a string value of “visa”, “amex”, or “mastercard”.
Example location: {Ephesoft_install_directory}SharedFoldersBC1scripts
ScriptFieldValueChange.java
The Field Value Change script can be toggled through the Ephesoft Validation Module, and when enabled will fire when the value of a field is changed in the user Validation View. This can be extremely useful if you want to have the changes you make to one field automatically produce a change in value of one or more other fields.
Example Scenario #1:
Consider the case where you have a field that is of the drop down list type. This field contains a list of various departments within an organization (eg: HR, IT, etc). In addition to this field you have another drop down field that serves as a list of users. You can use the Field Change script to implement logic such that change the department value for field #1 will automatically update the drop down list of field #2 with users that correspond to that newly selected department.
Example Scenario #2:
Perhaps you have had a document arrive in Validation View with a loan number field that has been extracted, and some corresponding fields that contain information related to the loan number. However, consider if the loan number is incorrect, and your user manually needs to change it. Instead of having to also manually look up and change all of the corresponding fields, the Field Change Value script could make it so that changing the Loan Number field value automatically performs a look up operation to a database and populates the additional fields with the information on file for that loan number.
Example location: {Ephesoft_install_directory}SharedFoldersBC1scripts
Example file: ScriptFieldValueChange.java
FunctionKey.java
The Function Key script allows for multiple methods to be defined within the FunctionKey.java and have these individual methods bound to keys on the users keyboard to act as keyboard shortcuts for executing pieces of custom functionality.
Example Scenario:
Consider that you may have a default set of values for a given document type that you want the option to populate its fields with in Validation View at the push of a button. In FunctionKey.java you would implement a method to set the fields of that document type to a set of default values. In the Ephesoft Validation Module you can define the Function Key that you want to associate with this method. You must specify both the name of the function as well as the key that you wish you bind it to. Having done so you should now see the Function Key that you specified as an icon in the Validation View. The custom function key method can now be invoked by clicking this button or striking the specified key itself.
Example location: {Ephesoft_install_directory}SharedFoldersBC1scripts
Example file: ScriptFunctionKey.java
ScriptPageProcessing.java
The Page Processing script is useful for conducting operations on the XML representation of a batch’s pages before they have undergone classification and encapsulation into documents.
Example Scenario:
To reduce batch processing time it is possible to use ScriptPageProcessing to remove pages that are ‘garbarge’ and don’t contain valid OCR data. You could implement a function that would iterate through the collection of pages, and from each page element retrieve the corresponding OCR file (.html) and image file name. If the OCR data for the page is nonexistent, and the original image size is below a certain threshold you can deem the page to be junk and remove it from the batch .xml. By removing these useless pages your batch will be able to traverse the rest of the batch class workflow more efficiently and with an improved processing time.
Example location: {Ephesoft_install_directory}SharedFoldersBC1scripts
ScriptValidation.java
The Validation script differs from the Automatic Validation script in that it is run during the user Validation User Interface experience, where as Automatic Validation executes and performs custom validation steps immediately before the batch is presented to the user in the Validation UI. The benefit is this is that as the user is making changes to the document field values in the Valdiation UI, the Validation Script can be triggered to run after each change to ensure that the changes are put through custom validation processing requirements.
Example Scenario:
You may have some a document level field, AccountNum, where the value being extracted should correspond to an existing account number in an external database. Perhaps due to poor image quality, the OCR’d value for the account number is either incomplete or incorrect and so the document appears in Validation with its field highlighted in red. The user is able to see the corresponding image and keys in what they believe to the the account number appearing on the image, but you want to ensure that they haven’t made a mistake and what they are inputting is indeed a valid account number. In this case it is possible to implement a function that takes the value of the AccountNum field and performs a database look up to verify that the value does in fact exist. This check can run each time after the user has modified the AccountNum document field value and attempts to save their changes.
Example location: {Ephesoft_install_directory}SharedFoldersBC1scripts
External Applications
This page provides information on how to integrate external applications with the Transact Review and Validation modules.
Configuring an External Application
External applications are technology-independent and can be written in any language, such as HTML, JavaScript, GWT, JSP, Servlet, or a combination thereof.
Transact interacts with external applications by appending the application’s URL with the following two parameters:
1. The path of the batch.xml for the current batch using the parameter “batch_xml_path”.
2. The document identifier, using the parameter “document_id”.
The batch.xml path is encoded using java.net.URLEncoder and UTF-8 encoding. The following is a sample URL for an external application, as fired by Transact:
{Ext. App URL}&document_id={Document Identifier}&batch_xml_path={Path of batch.xml}&ticket={Security Token}
External applications need to include the following method in their code. They need to invoke this method on the respective button (ok or close) calls which they have implemented. External applications will signal Transact to perform a specified operation by passing the appropriate operation string in the method argument.
GWT-based applications:
private native void fireEvent(String operation) /*-{
window.top.postMessage(operation,”*”);
}-*/;
JavaScript-based applications:
function fireEvent(var operation) {window.top.postmessage(operation, "*");}
The following table describes the actions performed in Transact based on the arguments passed to this method in the external application’s code:
	Argument Passed by External Application
	Result in Ephesoft Transact

	Save
	The dialog box containing the external application on the Review and Validate screen closes and the changes made in batch.xml are reflected on the screen.

	Cancel
	The dialog box containing the external application on the Review and Validate screen closes, without refreshing the screen.

	Any other string
	No change.


Application Security
A dynamic token is generated each time an external application is called. This token is sent to the external application by appending the “ticket” parameter to the URL. Once this token is received, the external application checks the provided URL to determine the authenticity of the token.
Example URL:
http://{EphesoftServerIP}:{port}/dcma/authenticate?ticket={ticket}
Note: If the token is not valid, you will receive a 401 error message. A valid token becomes invalid in the following scenarios:
· Once the token has already been sent to the Ephesoft server for authentication.
· After an hour has passed since the token was issued.
Adding an External Application
Note: These steps describe how to add the application to the Validate module, but the same can be applied to the Review module if needed.
Perform the following steps to integrate your external application:
1. From the Batch Class Management screen, select your batch class and click Open.
2. Go to Modules > Validate Document > VALIDATE_DOCUMENT.
3. Set the External Application Switch to ON.
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Figure 1. External Application Switch
4. Assign the URL of the application to one of the shortcuts, and add a title. This will be the shortcut used to access the application during validation. The available shortcuts are:
· Ctrl + 4
· Ctrl + 7
· Ctrl + 8
· Ctrl + 9
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Figure 2. Shortcut and Title
Accessing the Application
From the Review or Validate screens, use your configured shortcut to call the external application. You can also call the application manually by clicking More > External Application and selecting your application from the list.
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Figure 3. Open the Application
Your application will open in a dialog window.
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Figure 4. External Application
Suspend Batch
Overview
This page provides details on the Suspend Batch option in Ephesoft Transact. Users can suspend a batch in Review/Validation and assign it to another operator. The user who originally suspended the batch can later resume the batch.
Configuration
The Review Suspend Batch Switch can be enabled (set to ON) from the Plugin Configuration screen for the REVIEW_DOCUMENT and VALIDATE_DOCUMENT plugins.
1. From the Batch Class Management screen, select the batch class you want to suspend. Double-click to open the batch class or click once and select Open.
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Figure 1. Open Selected Batch Class
2. Navigate to Modules > Review Document > REVIEW_DOCUMENT. The following screen will display.
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Figure 2. Plugin Configuration
3. Set the Review Suspend Batch Switch to ON.
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Figure 3. Review Suspend Batch Switch
4. Follow the steps 1-3 again for the VALIDATE_DOCUMENT plugin, instead navigating to Modules > Validate Document > VALIDATE_DOCUMENT.
Email Notification
To send an email notification when a batch is suspended, set the following property to “false” in the mail.properties file under <Ephesoft Directory>/WEB-INF/classes/META-INF/dcma-mail/:
Example:
mail.suppress = true
The message suppress switch is set to true by default. Replace “true” with “false” to enable email notifications.
Example:
mail.suppress = false
Email Address Attribute
The mail attribute specifies the name of the attribute that is used for storing user email addresses. This attribute can be used to identify users by their email address in certificate authentication.
When the client identity is checked against the mail attribute specified for the server, the value of the mail field must match the attribute that contains the user’s email attribute. To configure the mail attribute, navigate to <Application Folder>/WEB-INF/classes/META-INF/dcma-user-connectivity/user-connectivity.properties.
user.connectivity_userEmailSearchAttributeFilter=mail
Example: In the screenshot below, the mail attribute is shown for the user “ephesoft”.
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Figure 4. Ephesoft Mail Attribute
If you are using Apache Tomcat for your user connection type, this attribute must be set in the tomcat-users.xml file.
Refer to the screenshot below for an example:
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Figure 5. tomcat-users.xml
Suspend Batch
You can suspend a batch during Review/Validation. The shortcut to suspend a batch is CTRL + SHIFT + S on the Review/Validation screen.
The following popup will display:
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Figure 6. Suspend Batch Confirmation
The following table describes the available fields:
	Field
	Description

	Assign To
	Select either User or Group. The default option is User.

	Select User/Group
	This dropdown contains a list of your users or groups depending on which category you selected for Assign To. Select a user or group to be assigned the suspended batch.

	Note
	This note will display on the Batch List and Batch Instance Management screens. If you select Send Email, it will be included in the email notification.

	Send Email
	Select this option to give Ephesoft Transact permission to send an email notification to the user or group to whom the batch is being assigned.

	To
	This auto-populates the configured email of the assigned user or group users. This can be changed if necessary.


When a batch is suspended, the following options are available:
· Assign the suspended batch to another user or group for further validation
· Send an email notification to the user or group that the batch was assigned to
· Add a note to the suspended batch as part of the email sent
· This note will be visible on the Batch List and Batch Instance Management screens
View Suspended Batch
You can view the batch that has been assigned to you on Batch List > Assigned To Me.
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Figure 7. Assigned To Me Tab
On the Batch Instance Management screen, the following columns display relevant information about the suspended batch:
· Is Suspended
· Assigned To
· Batch Note
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Figure 8. Batch Instance Management Screen
Resume Batch
Only the user who suspended the batch can resume the batch again. This is done in the same manner as suspending the batch.
1. Open the Batch Instance Management screen or Batch List screen.
2. Open the suspended batch. The following popup will display.
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Figure 9. Confirmation Message
· Select Resume to release the batch from the suspended state. The user who was assigned the suspended batch will no longer see the batch in the Assigned To Me tab on the Batch List screen.
· Select View Only to open the Review/Validate screen and view the suspended batch. To resume the batch from this screen, press CTRL + SHIFT + S.
Conclusion
This completes the overview and configuration of the Suspend Batch option in Ephesoft Transact.
Supported Languages
This article outlines languages supported when using Ephesoft Transact and optical character recognition (OCR) engines.
UI Supported Languages
The Ephesoft Transact user interface can be displayed in the following languages:
· Dutch
· English
· French
· German
· Italian
· Spanish
Document Processing
Ephesoft Transact supports classification and extraction for documents containing text in the following languages:
· Dutch
· English
· French
· German
· Italian
· Spanish
· Swedish
· Polish
Note: In Ephesoft Transact 2020.1, Chinese and Thai are available languages for document processing as a beta release. For more information, contact https://knowledge.tungstenautomation.com/.
OCR Engines
Ephesoft Transact leverages the following OCR engines. These OCR engines support additional languages that may work with Ephesoft Transact. Refer to Platform Configuration and Third-Party Integrations for supported versions.
· Nuance OmniPage
· Tesseract
· OpenText Capture Recognition Engine
Document Type Additional Configurations
Summary
To prevent the ImageScan document types (Batch header, Payment, and Remittance) from being changed in validation (by default), two new properties “Can be Changed” & “Can be Assigned” were introduced for Document Type created under a Batch class. By default, both the properties are selected for the newly added or imported documents.
Screen Print:
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Can be changed: Default Value is Set to True:
This Property controls if a document classified into a given document type can be changed into other available document type or not, at Validation screen.
If Property is set to True that is the default behavior, user can change the document type to other available document type, and if Property is set to False, Document cannot be changed to any other document type, Document Type drop down at Validation will not be clickable i.e no event will work on Drop Down.
Can be Assigned: Default Value is Set to True:
This Property controls, if a document with property set to True, given document will be shown under Document Type drop-down on Validation Screen as an option which can be assigned to Document Types of other types.
If document property is set to False, given document will not display under Document Types drop-down on Validation Screen for selection for all other Document types.
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Steps to Run the Function:
1. Go to the Batch Class Management screen.
2. Add a new batch class with different document types having “Can be Changed” and “Can be Assigned” properties is selected as given in the following image:
Screen Print :
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3. Once document types are created under the batch class with different properties, learn the document types and add the index fields to be extracted from the given document types.
4. Run the Batch from Upload Batch or from any other ingestion point with the given document types.
5. Go to the Validation screen.
US Invoice: As configured, cannot be changed into other Document Type
[image: Image3]
AUS Invoice: As configured, AUS Invoice can be changed into other document types.
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AUS Invoice is not an option under Document Type Drop Down for Other Document Types.
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NZ Invoice: As configured NZ invoice, can be changed and can be assigned to other document types.
 
Licensing Requirements
Applies to: All versions of Ephesoft Transact
Overview
The licensing model for Ephesoft Transact is based on either a core or consumption-based sales model. Additional Transact features can be purchased as add-ons to a core-based license, or are available for consumption-based licenses depending on the bundle you have purchased.
The following table provides additional details on add-ons and their availability for each license type.
	Feature
	Core Sales Model
	Consumption Sales Model

	
	
	Standard
	Professional
	Enterprise

	Advanced Reporting
	$
	✔
	✔
	✔

	Cloud HyperExtender Plugin
	✔*
	✔*
	✔
	✔

	Web Services APIs
	$
	
	✔
	✔

	ID Extraction Plugin
	$
	$
	$
	$


* 1,000 images free when you self-register
$ Premium add-on
Note: If you purchase the Professional or Enterprise bundle, please self-register for Cloud HyperExtender and submit a license request to expand the 1,000 images to the amount that was purchased.
To obtain additional licenses for these features, log in to the Customer Support Portal and go to Licenses.
Licensing Prerequisites
The following list outlines prerequisites required to obtain an Ephesoft Transact license:
· An installed instance of Ephesoft Transact version 4.5.0.0 or above — if you have not yet completed this step, refer to Install and Upgrade for your version of Ephesoft Transact.
· An Ephesoft Transact license server — the number of cores in the Transact environment will be used to configure the license. Refer to How to Set Up an Ephesoft License Server for more information.
· For multi-server environments, a server failover mechanism is required. For more information about configuration, refer to the License Server Failover Mechanism guide.
Obtaining an Ephesoft Transact License
To obtain a license for your version of Ephesoft Transact whether it’s a core or consumption-based license, you will need to determine your server core count. Reference the Appendix in this document for instructions to access this information.
Retrieving the details.properties File
To complete your license request, you will need to submit your details.properties file to Ephesoft Support from the Customer Support Portal. To prepare the details.properties file, follow the below steps:
1. Retrieve a copy of the details.properties file from the Ephesoft Transact installation folder. Based on your operating system, this folder is found in the following path:
· Windows: navigate to {Installation Folder}\Dependencies\licensing
· Linux: navigate to /opt/Ephesoft/Dependencies/licensing
2. Ensure each MAC address for your system is included in the file. The MAC address for your properties file should resemble the format illustrated on the right side of the following figure:
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Figure 1: MAC address format
Note: If the Device Address is missing or incorrect, it must be manually populated. Refer to the Appendix for instructions on locating the MAC address for your system.
3. Navigate to the Customer Support Portal and login. In the Licenses request form, complete the required fields and upload the details.properties file to submit a license request.
This concludes the steps necessary to obtain your Ephesoft Transact license file. Once you have received your license file, refer to the below installation guide specific to your operating system.
Installing the Ephesoft Transact License on Windows
Perform the following steps to install the license file for either a new installation or an upgraded version of Ephesoft Transact.
1. If the Windows system has ever had a prior installation of Ephesoft Transact, open the Windows Registry and delete the following key:
HKEY_LOCAL_MACHINE\SOFTWARE\JavaSoft\Prefs\com\ephesoft
Note: Verify that all users are set to have full control over the Registry key path HKEY_LOCAL_MACHINE\SOFTWARE\JavaSoft\Prefs\com\.
2. Copy the new ephesoft.lic file to the \Ephesoft\Dependencies\license-util folder.
· If a previous license file exists, you must delete the original license file, then rename the new license file to the original filename — ephesoft.lic.
3. Open the Windows command prompt as an Administrator and navigate to the \Ephesoft\Dependencies\license-util folder.
4. From this folder in the command prompt, type install-license.bat and then press Enter. Ephesoft recommends running install-license.bat twice to ensure the license applies correctly.
5. Refresh and ensure the following registry path exists:
HKEY_LOCAL_MACHINE\SOFTWARE\JavaSoft\Prefs\com\ephesoft\
If you observe issues with Ephesoft Transact after completing the above steps, please refer to the following articles on common issues that may occur during license installation.
· General Startup and Licensing Issues
· File Permission Issue
· IPv6 Issue
· Windows Firewall
If these articles do not resolve your issue, please contact Ephesoft Support at https://knowledge.tungstenautomation.com/ and include your log files. For information about how to obtain log files, refer to How to Collect the Ephesoft Application Logs.
To access your license information once installed, reference the Appendix in this document.
This concludes the steps required to license Ephesoft Transact on Windows.
Installing the Ephesoft Transact License on Linux
Perform the following steps to install the license file for either a new installation or an upgraded version of Ephesoft Transact.
Note: These steps must be performed from a Linux root user account.
1. The Ephesoft licensing team will send you a file named ephesoft.lic. Place this file in the /opt/Ephesoft/Dependencies/license-util/ephesoft-license-installer folder.
[image: Step2a]
Figure 2: Folder /opt/Ephesoft/Dependencies/license-util/ephesoft-license-installer
2. Run the following command in the folder mentioned above:
./install-license.sh
[image: Step3a]
Figure 3: Running the ./install-license.sh command
3. Run the ./install-license.sh command a second time to ensure the license was installed correctly.
[image: Step4a]
Figure 4: Running the ./install-license.sh command a second time
To access your license information once installed, reference the Appendix in this document.
This concludes the steps required to license Ephesoft Transact on Linux. 
[bookmark: _Appendix_1]Appendix
Verifying Server Core Count
To determine the number of server cores that will require licensing, identify your operating system and follow the steps below:
Windows: Logical Processors (Cores)
1. Right-click in the Windows Task Bar or Start menu.
2. Click Task Manager > More Details.
3. Click Performance > CPU. The quantity of logical processors is provided on this screen, as shown in the screenshot below.
[image: A screenshot of a cell phone Description automatically generated]
Figure 5: Viewing Logical Processors in Task Manager
Linux: Cores per Socket
There are two methods to obtain the number of cores in your Linux server:
1. Option 1: Enter lscpu at the command prompt of the Linux terminal.
The system returns the following information. The Core(s) per socket value indicates the number of cores in this deployment.
[image: A screenshot of a social media post Description automatically generated]
Figure 6: Viewing Core(s) in Linux
2. Option 2: Enter nproc in the terminal. This command returns the number of cores as an output.
[image: Step1a]
Figure 7: Viewing Core(s) in Linux with the nproc command
Obtaining MAC Address
When retrieving the details.properties file, the MAC address(s) should resemble the format illustrated on the right side of the following figure:
[image: license pipe]
Figure 1: MAC address format
If the Device Address is missing or appears incorrect, the file must be manually populated. To obtain the MAC address(es) for your system, follow the below instructions:
· Windows — Open a command prompt from the system, then run the ipconfig /all command.
· Linux — As the root user:
1. Type ifconfig -a.
2. From the displayed information, find eth0 — this is the default first Ethernet adapter.
3. Locate the number next to HWaddr. This is the MAC address.
4. Paste the MAC address(es) into the details.properties file.
5. Save the changes in the properties file.
Viewing License Details in Ephesoft Transact
For both informational and troubleshooting purposes, perform the following steps to access the License Details screen in Ephesoft Transact.
Note: The following example uses an Ephesoft Transact 2019.2 release version with a 4.5.0.0 license file installed. Your version may appear differently, depending on your version of Transact.
1. Log in to Ephesoft Transact with Super Administrator privileges. Expand the navigation pane on the left and click System Configuration.
[image: A screenshot of a cell phone Description automatically generated]
Figure 8: Selecting System Configuration
2. Click License Details to view the contents and settings of the current license.
[image: A screenshot of a computer
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Figure 9: Viewing License Details
The following table describes how each of the licensing items is used within the product:
	Field or Switch
	Description

	Account Name
	The name of the company on the license. 

	Server Type
	Production or nonproduction.

	Sales Model
	Core or consumption-based license. For consumption-based licenses refer to the License Consumption Report for more information.

	Application Version
	Displays the Transact version that is installed on the environment. This field might contain a software version that is more recent than the original software version when the license was purchased.

	License Version
	Displays the version of the license generator schema. License version schemas are compatible with multiple versions of Transact, and may not exactly match your version of Transact.

	License ID
	The unique identifier assigned to each Transact license.

	License Expiry Date
	Displays the date on which this Ephesoft Transact license expires.

	License Expiration Display Message
	Displays the number of days before license expiration. This is when the system will begin to prompt users about upcoming license expiration.

	Reporting License Type
	Identifies the type of reporting functions that are supported in this license. The three options for this field are as follows:
· Standard — only Dashboard and Throughput reports are displayed in the user interface. 
· Advanced — this setting includes Throughput reports and Correction reports. 
· Advanced with Custom Reporting — this setting includes everything from Advanced, with the additional ability to create a completely different user interface, using the Logi library. This is a development license. 

	Web Service License Type
	Identifies the use of Web Services by (1) Image Count or (2) service hits per day.

	Web Service Hits Per Day
	If the above field is set to “Web Service hits per day”, the number of daily Transact Web Service requests displays here.

	Additional OCR Language Pack
	Lists the language packs that are supported by OCR engines in this installation.

	Image Count
	Displays the image count for this license, which may be one of the following:  
· an annual total
· a subscription total for the life of the subscription, if different than an annual total
· unlimited

	Overage Image Count
	The number of images that a user can process after they’ve exceeded the image count specified in their contract.

	Remaining Number of Images
	Specifies the remaining number of images that can be processed before Transact stops if the license is image count based.

	Handwriting Recognition+ Switch
	Currently not in use.

	Handwriting Recognition+ Expiry Date
	Currently not in use.

	Handwriting Recognition+ Image Count
	Currently not in use.

	Handwriting Recognition+ Remaining Number of Images
	Currently not in use.

	Identification Extraction Switch
	Indicates the status of the Identification Extraction plugin as either ON or OFF.

	Identification Extraction Expiry Date
	Displays the date when this Identification Extraction license expires.

	Identification Extraction Image Count
	Displays the image count for the Identification Extraction license, which may be one of the following:
· an annual total
· a subscription total for the life of the subscription, if different than an annual total
· unlimited

	Identification Extraction Remaining Number of Images
	Specifies the remaining number of images that can be processed with the Identification Extraction plugin if the license is image count-based.

	Remaining Hits Per Day
	Specifies the number of remaining Web Service hits allowed in the day if the license is Web Service by hits per day.

	Web Service Switch
	Indicates whether web service API calls are enabled for service. 
· This value is set to ON if this installation supports using API service calls.
· This value is set to OFF if this installation does not use API service calls.

	Verify Platinum Switch
	Indicates whether this installation includes multi-server connectivity (YES) or single-server deployment (NO). 

	High Performance Switch
	Any installation of 8 cores or more allows this switch to be enabled (ON). 
Enabling high performance allocates half of the available cores for OCR functions:
· 8-Core Transact license — 4 OCR Cores
· 16-Core Transact license — 8 OCR Cores
· 32-Core Transact license — 16 OCR Cores

	MAC Address
	Lists the MAC address(es) associated with this installation. If there are multiple cores, each MAC address is separated by the pipe ( | ) symbol. 

	Number of Cores
	Cites the number of cores for this licensed installation.

	Operating System
	Identifies the operating system for this installation and license.


[bookmark: _License_Server_Failover]License Server Failover
This page provides an overview of the license failover mechanism, and basic guidelines to configure a failover license server.
Overview
The Ephesoft failover mechanism provides high availability if the active license server crashes. This means the application will always have an available environment. If one license server fails, then a backup license server will take its place.
This transition is automatic, which means a user will never know that a license server has failed. There is no downtime when swapping license servers. This will prevent batches from going into error, and avoid task failures such as web service and login requests.
The following chart illustrates the flow of license servers in a multi-server environment.
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Figure 1. License Failover Mechanism
Configuration
To configure the failover mechanism in a multi-server environment, follow these general steps.
1. Install a fresh license on at least two servers. These servers should have equal processing potential.
2. Restart all servers one-by-one.
Important: Heartbeat monitoring must be running on all servers.
Troubleshooting
The following table lists possible error messages you may see in the log files and their root cause.
	Error Message
	Possible Root Cause
	Possible Solution

	CPU limit exhausted. Can’t allocate more CPUs.
	The total count of CPU cores available in all machines in the environment is greater than the count specified on the license.
	Get a new license with the correct CPU core amount.

	Invalid license for multi-server environment setup.
	Either the server MAC ID was not included, or it was entered incorrectly when generating the license.
	Get a new license with the correct MAC ID.



[bookmark: _License_Consumption_Report]License Consumption Report
This document provides information on the License Consumption Report page, available in Ephesoft Transact 2020.1.04 and above. This information is intended for Transact administrators.
Overview
The License Consumption Report page (located under System Configuration) will be populated if you have purchased Transact on the consumption-based model.
This page details information on your image consumption to date for Transact, as well as any paid add-ons. It also shows whether you have opted in to automatic consumption reporting.
How Ephesoft Uses This Information
Ephesoft uses the information collected in your consumption report to audit your image consumption. Data submitted to Ephesoft headquarters contains no personally identifiable information and is limited to:
· License ID
· Date and Time of Snapshot
· Image Consumption Count
· Overage Image Count
· Identification Image Consumption Count
All collected data is used in accordance with our Privacy Policy.
Consumption Reporting Methods
As part of the terms of your consumption-based license, you are required to submit a report of your consumption data to Ephesoft on a regular basis. There are two methods of reporting your consumption data:
· Automatic Reporting
· Manual Reporting
Note: You can switch between automatic and manual reporting at any time. For steps, refer to dcma-telemetry.properties.
Automatic Reporting
Automatic reporting is enabled by default with a consumption-based license. This means that Transact will automatically report your consumption data to Ephesoft each day. By default, this report will be sent at 9:00 PM (according to your system time), however this schedule can be configured in the dcma-telemetry.properties file.
To confirm if automatic reporting is enabled:
1. Go to [Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\dcma-telemetry.
2. Open the dcma-telemetry.properties file in a text editor.
3. Confirm that the dcma.telemetry.auto.upload property is set to ON.
To disable automatic reporting, set the dcma.telemetry.auto.upload property to OFF and restart Transact. For more information, refer to dcma-telemetry.properties.
[bookmark: _Manual_Reporting]Manual Reporting
If automatic reporting is disabled, you will need to manually submit your consumption report each month. Refer to the section below for steps.
How to Manually Submit Your Consumption Report
The following steps describe how to manually submit your consumption report to Ephesoft each month. This is required if you have opted out of automatic reporting. You will also need to perform these steps each time you are requesting a new consumption-based license.
1. Go to System Configuration > License Consumption Report.
2. Select the appropriate month from the Monthly consumption report dropdown.
3. Click Download.
4. Click Email. This will create a prepopulated email draft in your default email application.
5. Attach the downloaded report and send it.
Note: If you need to send this report from another computer for any reason, send the downloaded report to https://knowledge.tungstenautomation.com/ with your account name in the subject line.
Deadlines
If you have opted for manually reporting, please submit your consumption report no later than 5 business days after the end of the calendar month.
Viewing the License Consumption Report
For both informational and troubleshooting purposes, you can access your consumption details at any time.
1. Log in to Ephesoft Transact as an administrator.
2. Go to System Configuration > License Consumption Report.
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Figure 1. License Consumption Report
The following table describes how each of the licensing items is used within Transact.
	Field
	Description

	Account Name
	Displays the name of the account, typically your company name.

	Server Type
	Displays the server environment type. Possible server types are:
· Production
· Non-Production.

	Sales Model
	Displays the type of license sales model. Possible sales models are:
· Core
· Consumption

	License Version
	Displays the license version based on the license generation tool. Version 2020.1.04 is the latest licensing version for installed Ephesoft Transact releases.

	License ID
	The unique identifier assigned to each Transact license.

	License Expiry Date
	Displays the date on which this Ephesoft Transact license expires.

	License MAC-Address
	Lists the MAC address associated with this license.

	Last Successful Automatic Consumption Submission
	Displays the date and time of the last successful automatic upload of your consumption report.

	Current Consumption
	Dated
	Displays the date and time of when your consumption report was created.

	Transact Application
	Image Allowance
	Displays the total number of images specified on your contract.

	
	Images Consumed
	Displays the number of images that have already been processed for your license.

	Identification Extraction
	Image Allowance
	Displays the total number of images that can be processed using the Identification Extraction plugin.

	
	Images Consumed
	Displays the total number of images that have already been processed using the Identification Extraction plugin.


Conclusion
This completes an overview of the License Consumption Report in Ephesoft Transact.


[bookmark: _dcma-telemetry.properties]dcma-telemetry.properties
Applies to: Ephesoft Transact 2020.1.04 and above
This document describes the properties in the dcma-telemetry.properties file in Ephesoft Transact. This information is intended for Transact administrators running Transact with a consumption-based license.
Note: You should not make any changes to this property file unless directed by Ephesoft Support, or to enable or disable automatic reporting.
Overview
The dcma-telemetry.properties file configures settings for the automatic reporting of consumption data to Ephesoft. For more information on your consumption data, refer to the License Consumption Report.
Configurable Properties
This section describes the configurable properties available in the dcma-telemetry.properties file, located at [Ephesoft_Directory]\Application\WEB-INF\classes\META-INF\dcma-telemetry.
	Property
	Description

	dcma.telemetry.auto.upload
	This property enables or disables the automatic reporting of consumption data to Ephesoft.
Note: If this is set to OFF, you will need to manually submit your consumption data each month. For steps, refer to Manual Reporting.

	dcma.telemetry.consumption.upload.url
	This property specifies the URL where the license consumption snapshots are automatically uploaded.
Important: Do not change this URL unless requested by Ephesoft.

	license.consumption.cronjob.expression
	This cron job controls when the license consumption data is captured, also referred to as a snapshot. In a multi-server environment, this cron job should be staggered for each server.
By default, this is set to 9:00 PM daily.

	license.consumption.upload.cronjob.expression
	This cron job controls when the license consumption snapshot is automatically sent to Ephesoft. In a multi-server environment, this cron job should be staggered for each server.
By default, this is set to 5:00 AM daily.

	number.of.past.months.to.show.for.download
	This property controls how many previous months of consumption data will be visible from the Monthly consumption report dropdown in the License Consumption Report.
By default, this is set to 11 months.

	dcma.telemetry.reporting.email.to.address
	This property specifies the email address your consumption report will be sent to when the Email button is clicked on the License Consumption Report page.

	license.consumption.snapshot.throttle1
	This property specifies the minimum interval in minutes between two cycles to capture consumption snapshots.
By default, this is set to 360 minutes (6 hours).

	license.consumption.upload.throttle1
	This property specifies the minimum interval in minutes between two attempts to automatically upload consumption snapshots.
By default, this is set to 5 minutes.

	license.consumption.upload.api.connect.timeout
	This property specifies how long Transact will wait (in minutes) for a server connection to be established when uploading the consumption report before timing out.
By default, this is set to 1 minute.

	license.consumption.upload.api.read.timeout
	This property specifies how long Transact will wait (in minutes) for the servers to complete the request and provide a response before timing out.
By default, this is set to 3 minutes.


1. Throttling is a countermeasure in the event the CRON job schedules for snapshot creation and upload are accidentally configured to run too frequently.
Conclusion
This completes an overview of the dcma-telemetry.properties file.

Prerequisites for Configuring Transact with Microsoft SQL Server
See Platform Configurations and Third-Party Integrations to determine which operating system, database, and third-party integrations are supported for your version of Ephesoft Transact.
If using an existing database, make sure you have SQL Server client installed. For that, download and install the following software on the Ephesoft server in the following order before installing Ephesoft Transact.
Transact 2022.1.00 and Above
1. Microsoft® SQL Server® 2012 Native Client – QFE (Version 11.4.7001.0)
2. Microsoft® ODBC Driver 17 for SQL Server® (Version 17.8.1)
3. Microsoft® Command Line Utilities 15 for SQL Server® (Version 15.0.2)

OpenLDAP: Separate Installation
Applies to: Fresh installation of Ephesoft Transact 2020.1.02 or above using LDAP.
Introduction
This document is a guide for installing OpenLDAP separately from Ephesoft Transact.
Background
Several Microsoft Visual C++ Redistributables were removed from the installer, as they were either at end of life (EOL) or posed security risks. This includes:
· Microsoft Visual C++ 2008
· Microsoft Visual C++ 2010
· Microsoft Visual C++ 2013
The OpenLDAP setup previously supplied with Ephesoft Transact had a dependency on Microsoft Visual C++ Runtime 2010 (VCRT). Separate installation is required for this scenario if you are not able to install VCRT 2010.
Note: VCRT 2012 may still be required to run LDAP, however, we have observed no issues with a fresh installation on Windows 2016 with only VCRT 2015 installed.
Prerequisites
· Ephesoft Transact is installed with LDAP selected as the connection type.
· The existing LDAP service deployed with Ephesoft Transact is stopped and set to not auto-start.
Installation
Perform the following steps to install the OpenLDAP service.
1. Download the OpenLDAPforWindows_x64.zip file from MaxCRC.
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Figure 1. Download OpenLDAP File
2. Extract the contents from the OpenLDAPforWindows_x64.zip file to a temporary folder.
3. Execute the OpenLDAPforWindows_x64.exe file from the temporary folder.
4. If you are presented with the following security warning, click Run.
[image: A screenshot of a computer error

Description automatically generated]
Figure 2. Security Warning
5. The OpenLDAP Installation screen will display. Click Yes.
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Figure 3. OpenLDAP Installation Screen
6. The Installation Wizard will launch, and the following screen will display. Click Next (》).
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Figure 4. Welcome Screen
7. Read through the End User License Agreement (EULA). Select the checkbox labeled “I accept terms of the License Agreement”.
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Figure 5. EULA Screen
8. Click Next (》).
9. Select the destination folder where OpenLDAP will be installed.
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Figure 6. Destination Folder Screen
10. Click Next (》).
The Customize Setup screen will display:
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Figure 7. Customize Setup Screen
Note: By default, all options will be selected. We recommend using this default setup.
11. Click Next (》).
12. On the Additional Settings screen, provide the Server name / IP Address.
Note: If you are installing OpenLDAP on a single-server test environment, set this to localhost. Otherwise, provide your server name or IP address.
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Figure 8. Additional Settings Screen
13. Leave the remaining settings with the default options (recommended) and click Next (》).
14. On the Database backend screen, select BDB.
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Figure 9. Database Backend Screen
15. Click Next (》).
16. On the BDB backend settings screen, leave the default options as is (recommended).
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Figure 10. BDB Backend Settings Screen
17. Click Next (》).
18. Click Install (▶) to begin the installation.
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Figure 11. Start Installation
The following screen will display while the installation is in progress:
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Figure 11. Installation Progress
Once the installation is complete, the following screen will appear:
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Figure 12. Installation Complete
19. Click Close (X) to close the installation wizard.
Post-Installation
After successfully completing the installation, the following steps must be performed before OpenLDAP can be used with Ephesoft Transact. This will set up default Ephesoft users and groups.
Prepare for Import
1. From the Windows Start menu, open Services.
2. Locate the OpenLDAP service.
3. If the service displays as Running in the Status column, right-click OpenLDAP and select Stop.
Wait while the Service Control stops the service.
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Figure 13. Stopping Service
Note: Leave the Services window open, we will return to it to restart the service.
4. Open the installation folder specified in step 9 above.
5. Create a new folder within the installation folder named “BACKUP”.
6. Move the following from the installation folder to the BACKUP folder.
a. secure folder
b. slapd.conf file
7. Copy the following from the OpenLDAP2.4 folder (located at [Ephesoft_Directory]\Dependencies) to the new installation folder:
a. secure folder
b. slapd.conf file
8. Return to the Services window.
9. Locate the OpenLDAP service.
10. Right-click OpenLDAP and select Start.
Wait while the Service Control starts the service.
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Figure 14. Starting Service
11. Close the Services window.
Import Ephesoft Configuration
1. Download the Ephesoft-OpenLDAP.ldif file and place it in a temporary folder.
2. Open the jxplorer-3.2.1 folder, located at [Ephesoft_Directory]\Dependencies\OpenLDAP2.4\ldap-client.
3. Execute the jxplorer.bat file.
The JXplorer application will start:
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Figure 15. JXplorer
4. Go to File > Connect.
The Open LDAP/DSML Connection menu will open:
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Figure 16. OpenLDAP/DSML Connection Menu
5. In the bottom section labeled Use a Template, select ephesoft from the dropdown menu.
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Figure 17. Use a Template
This will populate all fields required to connect except the Password.
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Figure 18. Template Applied
6. Provide the password from step 13 of the installation and click OK.
Note: The default password is “secret”.
7. You may encounter the following error messages (in no particular order):
· “unable to list dc=ephesoft,dc=com”
· “unable to list dc=com”
· “unable to perform Read entry operation”
This is because the client tool did not expect the top-level domains to be empty placeholders. It’s fine to ignore these, click OK to dismiss any errors.
8. The directory tree in the left panel will now show the empty ephesoft domain name:
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Figure 19. Ephesoft Domain
9. From the menu, select LDIF > Import File.
You will be prompted to select your import file.
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Figure 20. Select Import File
10. Locate the Ephesoft-OpenLDAP.ldif file and click Open.
Note: You may see a few error messages similar to those listed in step 7. Click OK to dismiss any errors.
11. From the menu, select File > Disconnect. This will disconnect the client application from the server.
12. Go to File > Connect. The Open LDAP/DSML Connection window will display, however now the fields should be automatically populated.
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Figure 21. Reconnect to Server
13. Click OK. This will establish a connection with the LDAP server and update the directory tree.
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Figure 22. Connection Established
Conclusion
This completes the overview of installing OpenLDAP separately from Ephesoft Transact 2020.1.02 or above.
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## Country URL configurations
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## Country URL configurations
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Welcome to the BonCode AJP 1.3
| Connector Setup Wizard

This willnstal 1.0 on your computer.

Itis recommended that you dose al other appications before:
| contining.

| Clidk Next to continue, or Cancel to exit Setup.
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Please provide the server name and port that you have nstalled the tomcat instance
o be reached by the connector. Itis recommended that you accept the defauts i you
have not made any changes. To continue, cick Next.

Apache Tomeat Server:
focahhost

Apache Tomcat AJP Port:
fooos
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Remote Access to Admin
Options for Access Protecton Through IIS

The BonCode AJP connector can refuse remote connectons to Apache Tomcat and
Ralo acmistrative pages from remote IPs through I1S, Defautis to enable remote:
access. You can disable by dlearing checkmark. To continue, dick Next.

Enable Remote Access to Apache Tomcat
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Option to fadiitatelater configuration of IS

Setup can change IIS defauits to allow you to configure individual I website
directories differently from the main website. For example, this may be needed if you
se widcard handlers in 3 subdirectory of your site whie using JSP handers n the
main site. Enabing this wi provide greater confiuration flexibiity n the future. To
continue, clck Next.

Enable IS Sub Configuration
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5] user-connectiviy properties E3

# Tnis property is defined common for all Types comnectivity
# LDAP/MS Active Directory

.connectivity_ur

1dap://WIN-R2TELSKNENV: 3268

.connectivity_config=com.sun.jndi.ldap.LdapCtxFactory
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.connectivity_password=Pssword
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# Cloud Notification Properties
cloud.notification.identifier-from—/uID
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[root@localhost ~]# yum makecache fast
Loaded plugins: langpacks, product-id, search-disabled-repos, subscription-

: manager

MariaDB | 2.9 ki 00:00
rhel-7-server-rpns 3.5 kB 00:00
MariaDB/primary db | 3 00:00

Metadata Cache Created
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[root@localhost ~]# systemctl start mariadb

[root@localhost ~]# systenctl enable mariadb

Created synlink from /etc/systemd/system/mysql.service to /usr/lib/systend/systen/mariadb.service.

Created synlink from /etc/systemd/system/mysqld.service to /usr/lib/systemd/system/mariadb.service.

Created symlink from /etc/systemd/system/multi-user.target.wants/mariadb.service to /usr/lib/systemd/system/mariadb.service.




image112.png
[root@localhost ~]# mysql_secure_installation

NOTE: RUNNING ALL PARTS OF THIS SCRIPT IS RECOMMENDED FOR ALL MariaDB
SERVERS IN PRODUCTION USE! PLEASE READ EACH STEP CAREFULLY!
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# mysql -V

mysgl Ver 15.1 Distrib 10.3.7-MariaDB, for Linux (x86_64) using
readline 5.1
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4 mysgl -u root -p

Enter password:

Welcome to the MariaDB monitor. Commands end with ; or \g.
Your MariaDB connection id is 16

Server version: 10.3.7-MariaDB MariaDB Server

Copyright (c) 2000, 2018, Oracle, MariaDB Corporation Ab and others.

Type 'help;' or "\h' for help. Type '\c' to clear the current input
statement.
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—— Configuring mariadb-server-10.3 b———————

while not mandatory, it is highly recommended that you set a password for
the MariaDB administrative "root" user.

If this field is left blank, the password will not be changed.
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package configuration
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<Resource name="jdbc/ephesoft" auth="Container"
factory="com.zaxxer.hikari.HikariJNDIFactory"
type="javax.sql.DataSource"

minimumIdle="5"

maximumPoolSize="100"
connectionTimeout="300000"

datasSource.user="<username>"
dataSource.password="<password>"

CONNECTIONTES T OueTY S
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Please select database type you want to use ?
1. MariaDB (above v 10.2.1)

2. oracle

1]
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Enter system IP/Name on which MariaDB is installed:
localhost

Enter the database username:

root .

Please enter Admin password.

Please re-enter the password:

Enter the application database name:
ephesoft

Enter the report database name:

report

Enter the report archive database name:
report_archive

Enter the database port number:

3306
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Please select the Authentication Mode to use:
1. standard Form Authentication (default)

2. PKI Authentication





image124.png
Please select Application Protocol you want to use ?
1. HTTP
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8080
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2. Ms Active Directory
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s
Selected tomcat user connectivity...

Press y if you want to change the details, press n to continue.
n

Updating realm settings...

========== Authentication Configuration completed successfully





image128.png
E you want to install Tesseract? Please enter a valid option(y/n).





image129.png
: Name of Individual
ny : Company Name
rtment : Department Name
Street : Street Name

you want to change the entered user registration information?(y/n)





image130.png
Fe======== Upgrading Ghostscript ==========
bxcracting the tar fiis fo Ghostecript. Fiease vait...
biiding the aka file fos Ghostecript. Pieass wait
ke £ii0 Built successiully for Ghosticript.
buLeing the Library and shuced Libeary for Ghostaceipt. Flease vait..
Eibrarias huilt suctessfully for Ghosthcript.

racking instaliation of lotal softuare and Creating a binary package mamagesent softare for GRostacript. Flease i,
ackage’ successtully created for GROsEactipt
Crosting R fiia for Shastscript. Piease Lalt..
i €114 crentad suceosseulty for hostacript
Fonciquring run time bindings for Ghostacript. Flease vait.
pindiogs configured successfully for Shostscript.

horeacript sparaded successtulty

Tnstaiiing Taagesagick
Lxcracting the tax file for Taagemsgice. Flasse vait...

i the sare £ite for Tasmsennon Prasse watt





image131.png
Home  Share  View

[G) - 1 [J» ThisPC » Local Disk (C) » Ephesoft v O] [ search Ephesoft

Name Date modified Type

% Favorites

] Desktop ). Apache22 27-09-2017 14111 File folder
‘4 Downloads ). Application 27-09-2017 16:31 File folder

5 Recent places ) Certs <:| 27-09-2017 14:11 File folder
| Dependencies 27-09-2017 1412 File folder
W This PC '} Documents 27-09-2017 1410 File folder

Ju Desktop ). EphesoftReports 27-09-2017 14:10  File folder
'} Documents il

16 items.





image8.png
‘ Cloud Connection Details

fed via email a l

Australia

Germany

USA

Singapore ed during registration ]

Email Address is required

& Application Key provided via email -] ]

Application Key is required
o ] o





image132.png
® - 1 \D » ThisPC » Downloads » Ephesoft 45.0.0
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I Desktop
{8 Downloads
%l Recent places

% This PC
[ Desktop
[F) Documents
8 Downloads
b Music
(B Pictures
{H Videos
s Local Disk (C:)

€ Network

Name -

L] config.properties
[ contents

Fiiizn ] <

[ SharedFolder

Date modified

06-09-2017 16:38
06-09-2017 16:38
06-09-2017 16:37
06-09-2017 16:38

Type
PROPERTIES File
Cabinet File

Windows Installer ...

Cabinet File

Welcome to the Install Wizard for
Ephesoft Transact 4.5.0.0

Size
7KB
17,29333KB
287,418KB
1,59,279K8

Installer wil instal Ephesoft Transact 4.5.0.0 on machine.
Ciick Next to continue or Cancel to exit the Setup Wizard.
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Please select authentication mode.
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User connectivity Settings = Ephesoft

ComectionType: () Ldap O Active Directory (®) Tomeat

No configuraition is required. After instalation gets completed, if you
want to add new users or new roles, update the following file:
Installed Folder/JavaAppServer fconf/tomcat-users. xml.
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Password:

Group Search Filter: S
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Please select authentication mode.
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#Authentication mode 0 for Form Authentication and 1 for PIVCAC (PKI) authentication mode

vcac_selected_mode=0

#Form Authentication Configuration 0 for HTTP 1 for HTTPS
[Form_authentication http_or_https=0 |

#if HITPS selected then please provide keystore file and its password
form_authentication keystore file path=C:\\PIV\\sample-certificates\\servercert.jks
form_authentication_keystore password=enter_servercert_password

#In case of PIV CAC(PKI authentication) please provide server certificate and ca
certificate file path and its password
pivcac_server_cert_path=C:\\PIV\\sample-certificates\\servercert.jks
pivcac_server cert_password=enter_servercert_password
pivcac_ca_cert_path=C:\\PIV\\sample-certificates\\cacerts.jks
pivcac_ca_cert_password=enter_cacerts_password

#Realm settings for PIV CAC or HTTPS(Form authentication)
Ivcac_realm _connection url=1dap://localhost:389
ivcac_realm connection name=cn=Manager,dc=ephesoft,dc=com
ivcac_realm connection password=secret
ivcac_realm user_base=ou=people,dc=ephesoft,dc=com
ivcac_realm user_search=cn={0}
ivcac_realm role_base=ou=groups,dc=ephesoft,dc=com
ivcac_realm role name=:
ivcac_realm role_search=uniqueMember={0}
ivcac_realm userSubtree=true
ivcac_realm roleSubtree=true
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& ca\Ephesoft\Application\WEB-INF\classes\META-INF\dcma-mail-importymail-import properties - Notepads + [Administrator]
Vindow 7

EENE® O ED BB

File Edit Search View Encoding Langusge Settings Tools Macro Run Pl

sHHERGA|I4mb|oe|hyax|BEI=T
B comon s 4| [ maimport properties £3

doma. importMail.cronExpression=0 0/1 * 2 * *
#multiple velues separated by semi-colon(;)

dema. supported. attachnent . extension=doc: xls: zip

4Value indicating the threadpool size to be used by the mail import service.
dema.mail. inpore. core. size=1

4 Extension type for mail import body.

20 - EDAL, default value

#1 - TEXT

5 dema.mail.import.mail body_extension type=0

10 $dema.mail.import.max_mail_retry_count tells how many number of times try to process mail
11 # again in case of failure

12 dema.mail.import.max_mail_retry_count=3

13 # mail recry interval

14 dema.mail.import.mail_retry_interval=2000

15 #mail body download flag

16 #1= don't download body, download only attachments

17 $0= download body with attachments (default value)

18 dema.mail.import.mail body_download flag=0

15 #mail processing cron expressio

20 dema.importMail.mailProcessCronExpressio
21 #max cumilative mail processing count.
22 dema.mail.import.max_mail processing_capacity=s

23 #To check the procedure to be followed for picking up e-mails.
24 faucomated, for simple pickup of e-mail = 0

25 $timed, for clubbing of e-mails = 1

26 dema.mail.import.mail pickup_procedure=0

27 #flag to specify if mag file needs to be downloaded or processed
28 fonly download msg attachment=0

23 #download and process mag attachment:
30 doma.mail.msg_download and process_flag=0

31 #number of mails to be downloaded per cron cycle

o5 % 2 %

Properties file length:2,541 lines: 52

Windows (CRLF)  UTF-8
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159
160
161
162
163
164
165

#connectivity user Configuration 0 for ldap mode 1, for

2D and 2 for tomcat

Connectivity user_connection=2
connectivity url=ldap://localhost:389
connectivity_domain_name=ephesoft

connectivity domain_org=com

connectivity user_name=cn=Manager, dc=ephesoft, dc=com
connectivity user_password=secret
connectivity_group_search_attribute_filter=cn
connectivity user_search_attribute filter=cn
connectivity ldap_user_base=ou=people
connectivity_ldap_group_base=ou=groups

connectivity msad_context_path=

connectivity msad_group_search filter=
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Starting Ephesoft installation
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MariaDB installed successfully
Updating paths in properties file. Please wait...
= S
Please select Authentication Mode you want to use

2
1. Standard Form Authentication (default)
2. PKI Authentication
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Please select Application Protocol you want to use ?

1. HITP
2. HITPS
1

Please enter the port number on which you want to run the tomcat server

8080
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User connectivity settings

Please select User Connection Type you want to use

1. Loap
2. MS Active Directory
3. Tomcat

2
> Connection URL:
1dap://52.172.36.111:3268
> Connection Name:
CN=test, CN=Users, DC=ephesoft, DC=com
> Connection Passwor

Please re-enter the password:

> User Base:

DC=ephesoft, Dc=com
User Search:
cn=(0)
User Subtree:
true
Role Base:
ou=groups, de=ephesoft, de=com
Role Name:
en
Role Search:
uniqueMenber={(0)
Role Subtree:
true
[,> MS AD Group Search Filter:




image148.png
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n
|:> Updating realm settings...
==========|Authentication Configuration completed successfully |===
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1. Form Authentication
2. PKI Authentication

1
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Please provide the certificate
Keystore file:
/root/certs_san/servercert.jks
password

Please re-enter the password:

file(.keystore file) and password.
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E> Press y if you want to change the details, press n to continue.
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[Please enter the port number on which you want to run the tomcat server. |
8080
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[H config.properties E3

89 #This takes the input of whether to use FORM(default) authentication mode or PKI
authentication mode. For FORM authentication mode, this value should be 1 and for PKI
authentication mode this value should be 2.

50

91

92 #For FORM authentication mode

93 #This takes the input whether to use HTTP or HTTPS communication protocol for FORM
authentication mode. For HTTP this value should be 1 and for HTTPS this value should be
2.

94 [input_application_communication_protocol=l

95

96 #For HTTPS FORM authentication mode

97 [input_form https_keystore cert_path=/opt/certs/cert.keystore

98 |input form https keystore cert password=changeit
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config properties £

112 #This takes input whether to use LDAP user connectivity, Active Directory or
tomcat. For LDAP, this value should be 1, for Active Directory this value
should be 2 and for Tomcat this value should be 3. In case of PKL
authentication mode, tomcat option invalid.

113 |input_connectivity user_ connectio:

114

115 #Common for LDAP and AD.

116 [nput_realm connection uri=ldap://localhost:389

117 |input_realm connection name=cn=Manager,dc=ephesoft,dc=com

118 |input_realm user_password=secret

119 |input_realm user base=ou=people,dc=ephesoft, dc=com

120 |input_realm user_search=cn={0}

121 |input_realm user_sub_tree=true

122 |input_realm role base=ou=groups,dc=ephesoft, dc=com

123 |input_realm role name=cn

124 |input_realm role_search=uniqueMember={0}

125 |input_realm role sub_tree=true

126
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<role rolename="admin"/>

<role rolename="rolel"/>

<role rolename="role2"/>

<role rolename="role3"/>

KUSEE username-"ephesoft! password="demo" roles="admin" iail="ephesoft@abe.con'|/s
<user username="userl" password="userl" roles="rolel"/>

<user username="user2" password="user2" roles="role2"/>

<user username="user3" password="user3" roles="role3"/>

</tomcat-users>
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